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Alconox is a registered trademark of the Alconox Company.
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Microsoft and Windows are registered trademarks of Microsoft Corporation.
Python is a registered trademark of Python Software Foundation.
Teflon is a registered trademark of E. I. DuPont de Nemours Company.
TriStar is a registered trademark of Micromeritics Instrument Corporation.

This application may contain a binary form of the Info-ZIP tool to create .zip files. That source code is provided under
the following license:
This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the
use of or inability to use this software.
Permission is granted to anyone to use this software for any purpose, including commercial applications, and to
alter it and redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of
conditions.

2. Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer, and this list
of conditions in documentation and/or other materials provided with the distribution.

3. Altered versions — including, but not limited to, ports to new operating systems, existing ports with new
graphical interfaces, and dynamic, shared, or static library versions — must be plainly marked as such and
must not be misrepresented as being the original source. Such altered versions also must not be mis-
represented as being Info-ZIP releases — including, but not limited to, labeling of the altered versions with
the names "Info-ZIP" (or any variation thereof, including, but not limited to, different capitalizations), "Pocket
UnZip," "WiZ" or "MacZip" without the explicit permission of Info-ZIP. Such altered versions are further pro-
hibited from misrepresentative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip," "Pocket Zip," and
"MacZip" for its own source and binary releases.

Copyright

The software described in thismanual is furnished under a license agreement andmay be used or
copied only in accordance with the terms of the agreement.

______________________________________________________________________________

Copyright © 2013 - 2020. Micromeritics Instrument Corporation. All rights reserved.



WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and service
conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any instrument or
defective parts when returned prepaid to us and which our examination discloses to have been defective. The purchaser is
responsible for all transportation charges involving the shipment of materials for warranty repairs. Failure of any instrument
or product due to operator error, improper installation, unauthorized repair or alteration, failure of utilities, or environmental
contamination will not constitute a warranty claim. The materials of construction used in MICROMERITICS instruments and
other products were chosen after extensive testing and experience for their reliability and durability. However, these
materials cannot be totally guaranteed against wear and/or decomposition by chemical action (corrosion) as a result of
normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization to
return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are made by
persons other than its own authorized service personnel unless such work is authorized in writing by MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their respective
brand names or trade names. We, therefore, make no express or implied warranty as to such products. We shall use
our best efforts to obtain from the manufacturer, in accordance with his customary practice, the repair or replacement
of such of his products that may prove defective in workmanship or materials. Service charges made by such man-
ufacturer are the responsibility of the ultimate purchaser. This states our entire liability in respect to such products,
except as an authorized person of MICROMERITICS may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the discretion of
MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and stems,
seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such items which
perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of manufacturing
defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its products
other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including but not
limited to, the implied warranties of merchantability or fitness for use.

Warranty
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Corporate Profile

CORPORATE PROFILE
Micromeritics Instrument Corporation is a leading global provider of solutions for material characterization with best-
in-class instrumentation and application expertise in five core areas: density; surface area and porosity; particle size
and shape; powder characterization; and catalyst characterization and process development.

Founded in 1962, the company is headquartered in Norcross, Georgia, USA and has more than 400 employees
worldwide. With a fully integrated operation that extends from a world class scientific knowledge base through to in-
house manufacture, Micromeritics delivers an extensive range of high-performance products for academic research
and industrial problem-solving.

Under its premium brand Particulate Systems, Micromeritics discovers and commercializes unique and innovative
material characterization technologies that are complementary to core product lines.

The company’s holistic, customer-centric approach also extends to a cost-efficient contract testing laboratory – the
Particle Testing Authority (PTA). The strategic acquisitions of Freeman Technology Ltd and Process Integral
Development S.L. (PID Eng & Tech) reflect an ongoing commitment to optimized, integrated solutions in the
industrially vital areas of powders and catalysis.

Freeman Technology (Tewkesbury, UK) brings market-leading powder characterization technology to
Micromeritics’ existing portfolio of particle characterization techniques. The result is a suite of products that directly
supports efforts to understand and engineer particle properties to meet powder performance targets. With over 15
years of experience in powder testing, Freeman Technology specializes in systems for measuring the flow
properties of powders. In combination with detailed application know-how these systems deliver unrivalled insight
into powder behavior supporting development, formulation, scale-up, processing and manufacture across a wide
range of industrial sectors.

PID Eng & Tech (Madrid, Spain) complements Micromeritics’ renowned offering for catalyst characterization with
technology for the measurement and optimization of catalytic activity, with a product range that extends to both
standard and bespoke pilot scale equipment. Launched in 2003, PID Eng & Tech is a leading provider of
automated, modular microreactor systems for the detailed investigation of reaction kinetics and yield. These
products are supported by a highly skilled multidisciplinary team of engineers with in-depth expertise in the design,
construction and operation of laboratory units and process scale-up.

The Particle Testing Authority (PTA) provides material characterization services for fine powders and solid materials
using Micromeritics’ instrumentation alongside complementary solutions from other vendors. With the certification
and expertise to operate across a wide range of industries the PTA offering runs from single sample analysis to
complex method development, method validation, new product assessment, and the analytical support required for
large scale manufacturing projects. An experienced, highly trained team of scientists, engineers, and lab
technicians works closely with every client to ensure that all analytical requirements are rapidly and responsively
addressed.

Micromeritics has a strong global network with offices across the Americas, Asia, and Europe complemented by a
dedicated team of distributors in additional locations. This ensures that local, knowledgeable support is available
for every customer, in academia or industry. Micromeritics works across a truly diverse range of industries from oil
processing, petrochemicals and catalysts, to food and pharmaceuticals, and at the forefront of characterization
technology for next generation materials such as graphene, metal-organic-frameworks, nanocatalysts, and zeolites.
Engineering solutions that work optimally for every user is a defining characteristic of the company.
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CONTACT US
Micromeritics Instrument Corporation

4356 CommunicationsDrive
Norcross, GA / USA / 30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696
www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3666
International— contact your local distributor or call 1-770-662-3666
Service.Helpdesk@Micromeritics.com

Micromeritics Learning Center
Phone: 1-770-662-3607
www.Micro.edu

Contact Us
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About thisManual

ABOUT THIS MANUAL

Log in to your customer portal to access the following:

n Calculations
n Error Messages
n Smart VacPrepOperator Manual in PDF format

Parts and accessories can be found online at www.Micromeritics.com.

Thismanual contains instructions for installations in standard and 21CFR11
environments. For instructions on installing the software in a 21CFR11 environment,
see the Confirm Administrator Guide [part number 004-42821-01].

The following symbols indicate safety precautions and/or supplemental information andmay appear
in thismanual:

NOTE — Notes contain important information applicable to the topic.

CAUTION—Cautions contain information to help prevent actions that may damage the
analyzer or components.

WARNING—Warnings contain information to help prevent actions that may cause
personal injury.

NOTE — Notes that apply to 21CFR11 environments only (Confirm applications).
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GENERAL SAFETY

Do not modify this instrument without the authorization of aMicromeritics service per-
sonnel.

Any piece of laboratory equipment can become dangerous to personnel when improperly operated
or poorlymaintained. All employees operating andmaintainingMicromeritics instruments should be
familiar with its operation and should be thoroughly trained and instructed on safety.

n Read themanual for any special operational instructions for the instrument.
n Know how the instrument functions and understand the operating processes.

n Wear the appropriate personal protective equipment when operating this instrument
— such as eye protection, lab coat, protective gloves, etc.

n When lifting or relocating the instrument, use proper lifting and transporting devices
for heavy instruments. Ensure that sufficient personnel are available to assist in mov-
ing the instrument. The TriStar weighs approximately 82 lbs (37 kg).

n Always pay attention to the safety instructions provided on each label affixed to the
instrument and do not alter or remove the labels. When inspecting the instrument,
ensure that the safety labels have not becomeworn or damaged.

n The TriStar II Plus has a safety shield. Ensure it is in place when operating the instru-
ment.

n The TriStar II Plus sound level is below 80 dBA. Hearing protection is optional.
n Proper maintenance is critical to personnel safety and smooth instrument operation

and performance. Instruments require regular maintenance to help promote safety,
provide an optimum end test result and to prevent costly down time. Failure to prac-
tice proper maintenance procedures can lead to unsafe conditions and shorten the
life of the instrument.

n If using CO2 for analyses, ensure an exhaust line is connected to the vacuum pump
and the exhaust is run to a ventilation system or out of the building.

Improper handling, disposing of, or transporting potentially hazardousmaterials can
cause serious bodily harm or damage the instrument. Always refer to theMSDS when
handling hazardousmaterials.

The TriStar II Plus is a stand alone instrument. Safe operation and handling of the instru-
ment, supplies, and accessories is the responsibility of the operator.

General Safety
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General Safety

INTENDED USE
TheMicromeritics TriStar II Plus is a an automated, three-station, surface area and porosity analyzer
that delivers excellent performance and speed of analysis. With three available analysis ports, the
TriStar II Plus provides high sample throughput and advanced data analysis features to the user.
The unique stainless steel analysismanifold is designed for highly accurate gasmanagement for
confident and repeatable results. TheMicroActive for TriStar II Plus software gives the user the
ability to interactively evaluate isotherm data and reduce the time required to obtain surface area and
porosity results.

TRAINING
It is the responsibility of the customer to ensure that all personnel operating or maintaining the
equipment participate in training and instruction sessions. All personnel operating, inspecting,
servicing, or cleaning this instrument must be properly trained in operation andmachine safety
before operating this instrument.

This instrument may only be used according to the instructions as described in the operator manual.
All use, other than that described in thismanual, is seen as unintended use.
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ENVIRONMENTALLY FRIENDLY USE PERIOD

Part Name
Hazardous Substances

Lead
(Pb)

Mercury
(Hg)

Cadmium
(Cd)

Hexavalent
Chromium
(Cr (VI))

Polybrominated
biphenyls
(PBB)

Polybrominated
diphenyl ethers

(PBDE)
Metal Parts x o o o o o

Power
Supplies

x o o o o o

Printed
Circuit
Boards

x o o o o o

Hazardous Substances Table

o Hazardous substance is below the specified limits as described in SJ/T11363-2006.
x Hazardous substance is above the specified limits as described in SJ/T11363-2006.

The Environmentally Friendly Use Period (EFUP) for all enclosed products and
their parts are per the symbol shown here, unless otherwisemarked. Certain
partsmay have a different EFUP (for example, batterymodules) and so are
marked to reflect such. The Environmentally Friendly Use Period is valid only
when the product is operated under the conditions defined in the product manual.

General Safety
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1 ANALYZER COMPONENTS FOR TRISTAR II PLUS
Parts and accessories can be found online at www.Micromeritics.com.

FRONT COMPONENTS

Component Description
A P0 tube For measuring the saturation pressure.

B Power indicator light Blinks when power is applied to the analyzer; illuminateswhen the
analysis program is initiated and ready for operation.

C Sample ports For installing up to three sample tubes.

D Elevator Allows placement of the Dewar around the sample and P0 tubes.
The elevator is raised automatically when the analysis is started
and lowers automatically upon completion. During analysis, the
elevator optionally lowers after the free spacemeasurement to
allow evacuation, then is raised and continues the analysis.

Front Components

1 Analyzer Components for TriStar II Plus
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1 Analyzer Components for TriStar II Plus

SIDE PANEL COMPONENTS

Component Description
A Ethernet Port Port for an Ethernet cable allowing communication between the analyzer

and the computer.
B RS232 port Used to connect the SmartPrep.

1 - 2 MicroActive TriStar II PlusOperator Manual
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BACK PANEL COMPONENTS

Component Description
A Maximum inlet

pressure
Indicates themaximum inlet pressure that can be used.

B Vacuum pump
connector

For attaching the vacuum pump hose.

C Helium inlet valve Inlet valve for helium.

D Gas inlet valves Inlet valves for analysis gases.

E Power cord
connector
and power
switch

For connecting the analyzer to the power supply and for powering the
analyzer on and off.

Back Panel Components

1 Analyzer Components for TriStar II Plus
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1 Analyzer Components for TriStar II Plus

DEGASSER OPTIONS

Parts and accessories can be found online at www.Micromeritics.com.

Degasser Option Description
FlowPrep The FlowPrep applies both heat and a stream of inert gas to the

sample to remove adsorbed contaminants from the surface and pores
in preparation for analysis for up to six samples. Choose the tem-
perature, gas, and flow rate best suited for your samplematerial. The
FlowPrep is an independent unit and not controlled by the analyzer.

Smart VacPrep The Smart VacPrep prepares samples by heating and evacuation. It
contains six sample ports in which up to five temperatures, ramp rates,
and soak times per sample are individually controlled by the analyzer
program so that all degas information is integrated into the sample
data file for future reference. Samples can also be prepared, started,
and completed independently. There is no need to wait for samples on
other ports to finish. Front panel buttons allow aQuickStart operation
with preprogrammed conditions.

Up to three additional Smart VacPrep degassers can be connected to
one computer permitting 24 preparation ports to be used. The Smart
VacPrep is the recommended degassing unit.

SmartPrep The SmartPrep passes flowing-gas over the sample at elevated
temperatures. It contains six sample ports in which temperature, ramp
rates, and soak times are individually controlled by the analyzer
program so that all degas information is integrated into the sample
data file for future reference. It contains two serial ports— one for
connecting to the computer and the other for connection of up to three
additional SmartPrep degassers permitting 24 preparation ports to be
used.

VacPrep The VacPrep offers twomethods for removing contaminants. In addi-
tion to flowing gas, it provides vacuum to prepare samples by heating
and evacuation of up to six samples. This combination provides pre-
parationmethod options best suited to your material or application.
Needle valves are also provided for introducing the vacuum slowly to
prevent fluidization of samples. The VacPrep is an independent unit
and not controlled by the analyzer.
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EQUIPMENT OPTIONS AND UPGRADES
Parts and accessories can be found online at www.Micromeritics.com.

Equipment Option Description
Chiller Dewar A closed loop recirculating system that utilizes a high surface area

copper coil to provide excellent heat transfer between the Dewar and
the recirculating liquids. Log in to your customer portal to access the
Chiller Dewar Quick Start Guide [part number 025-42801-00].

Krypton Option Extends themeasurable surface area to as low as 0.001 m2/g using
krypton as the adsorptive. The analyzer must be equipped with a
10 mmHg transducer and a high-vacuum pump to provide this
capability.

Vacuum Pump The analyzer requires a vacuum pump for sample analysis. Vacuum
pumps usedmust meet the following criteria:

n achieve vacuum levels of 20 μmHg at the analyzer inlet
n contain an anti-suckback valve to prevent vacuum pump oil from

back streaming into the analyzer in the event of a vacuum pump fail-
ure

n contain an NW16 inlet port for connection to the analyzer

A device to reduce oil vapor backstreaming is recom-
mended.

The vacuum pumpmust have an anti-suckback valve to
prevent oil from being admitted into the analyzer should
the power fail while the system is under vacuum. Pumps
available fromMicromeritics are equipped with an anti-
suckback valve.

An oil-based or oil-free vacuum pump can be used with the analyzer
(an oil-free pump is required if the krypton option is installed).
Appropriate vacuum pumps are available fromMicromeritics.

Equipment Options and Upgrades
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1 Analyzer Components for TriStar II Plus

GAS REQUIREMENTS
Compressed gases are required for analyses. Gas cylinders or an outlet from a central source
should be located near the analyzer.

Appropriate two-stage regulators which have been leak-checked and specially cleaned are required.
Pressure relief valves should be set to nomore than 30 psig (200 kPag). All gases should be of a
purity listed below. Gas regulators can be ordered fromMicromeritics. Parts and accessories can be
found online at www.Micromeritics.com.

(CGA 580) N2
(CGA 580) He
(CGA 580) Kr

99.999%
99.999%
99.995% (Required for krypton units only)

CRYOGEN REQUIREMENTS
Liquid nitrogen is commonly used as the cryogen to cool the sample during analysis. A liquid nitrogen
transfer system eliminates the need to pressurize storage Dewars. TheModel 021 liquid nitrogen
transfer system is available fromMicromeritics. Log in to your customer portal to access parts and
accessories.

Improper handling, disposing of, or transporting potentially hazardousmaterials can
cause serious bodily harm or damage the instrument. Always refer to theMSDS when
handling hazardousmaterials.
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SPECIFICATIONS FOR THE TRISTAR II PLUS

Absolute

Range: 0 to 950mmHg
Resolution: Within 0.05mmHg
Accuracy:Within 0.1% of full scale
Linearity: < ± 0.1% of span

Relative P/Po range: 0 to 1.0 P/Po
Resolution: < 10-4

Pressure Measurement

Specific Surface Area From 0.01m2/g, nitrogen unit
From 0.001m2/g, krypton unit

Total Surface Area From 0.1m2, nitrogen unit
From 0.01m2, krypton unit

Pore Volume From 4 ×10-6 cm3/g

Dewar Duration Up to 40 hours

GasConsumption Up to 300 cm3 STP per port

Analysis

Nitrogen Unit
Nitrogen; argon, carbon dioxide, or other non-corrosive gases;
butane, methane, or other light hydrocarbon vapors. Oxygen can
also be used only with an appropriate vacuum pump.

Krypton Unit Same as nitrogen unit, plus the capability to perform krypton surface
area analyses at lower pressures

The TriStar II Plus should be operated in a properly vented environment when using flammable or
toxic gases.

Adsorptive Gases

Specifications for the TriStar II Plus
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1 Analyzer Components for TriStar II Plus

Accuracy ±0.25 °C

Resolution Within 0.1 °C

Manifold Temperature

Nitrogen Unit Must accommodate 20 × 10-3mmHg or better; uses oil-based or oil-
free vacuum pump

Krypton Unit Must accommodate 1 × 10-3mmHg; oil-free vacuum pump required

Vacuum System

Temperature 10 to 35 °C (50 to 95 °F), operating
0 to 50 °C (32 to 122 °F), non-operating

Humidity 20 to 80% relative, non-condensing

Indoor or outdoor use
Indoor only
Altitude: 2000mmax
Pollution degree of the intended environment: 2

Environment

Height 74 cm (29 in.)

Width 40 cm (16 in.)

Depth 51 cm (20 in.)

Weight 37 kg (82 lbs)

Physical
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Voltage 100-240V~

Power 150VA, maximum

Frequency 50/60Hz

Overvoltage category II

Electrical

Operating System

Windows 7 Professional or higher operating system is recom-
mended for the best user experience. For 21 CFR Part 11 envir-
onments, Windows 10 Professional or Windows 10 Enterprise or
higher is required.

Desktop Installation
Required

The application should not be installed on a network drive with
shared access. Multiple users cannot operate the application at the
same time.

10 Base T or 100 Base T
Ethernet Port

If the computer is to be connected to a network, two Ethernet ports
are required. If more than one Ethernet based unit is connected to
the same computer (or if a Smart VacPrep is purchased), an Eth-
ernet switch will also be required.

Read/Write Permissions

All users of the application will need Read/Write permission to all dir-
ectories and subdirectories where the application is installed. For 21
CFR Part 11 environments, permissionmay be limited to the install-
ation directory.

Drives USB port

Computer Requirements

Due to continuous improvements, specifications are subject to change without notice.

Specifications for the TriStar II Plus
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2 ABOUT THE SOFTWARE

See also:

Software in 21CFR11 Environments on page 2 - 25 for CFR11 environments.

The analyzer allows other computer programs to run while an automatic operation is in progress.
TheHelpmenu provides access to the online operator manual.

Report options can be specified when creating the sample file. When running an analysis, data
gathered during the analysis process are compiled into the predefined reports. Reports can also be
defined and generated after an analysis has been run. Each selected report is displayed on its own
tab and reflects data collected during the analysis.

TheMicroActive feature offers aWindows interface with an easyway to collect, organize, archive,
reduce raw data, and store sample files for later use. Scalable and editable graphs, and copy and
paste graphics, are easily generated. Customized reports can be viewed on a computer monitor,
printed, or exported for use in other programs.

In addition to customizable standard reports, user defined calculations and reports can be created
through the Advanced reports feature (using Python).

Data can bemanipulated and displayed interactively usingMicroActive reports.

2 About the Software
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2 About the Software

MENU STRUCTURE
All program functions use standardWindowsmenu functionality. The title bar contains aUnit [n]. If
multiple analyzers are installed, ensure the appropriate unit is selected before continuing.

Option Description
File Use tomanage files used by the application— such as sample files, ana-

lysis conditions files, report options files, etc.
Unit [n] Use to perform analyses, calibrations, and other analyzer operations.Unit 

[n] displays on themenu bar for each analyzer attached to the computer.
Smart VacPrep (If installed.) Use to access themenu for each installed Smart VacPrep.

SmartPrep (If installed.) Use to access themenu for each installed SmartPrep.

Reports Use to run reports and view the results.

Options Use to edit the default method, specify system configuration, specify units,
and change presentation options.

Window Use tomanage open windows and display a list of open windows. A check-
mark appears to the left of the active window.

Help Provides access to the online operator manual, theMicromeritics web
page, the analyzer web page, and information about the application.

Main Menu Bar Options
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COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located inmultiple windows throughout the analyzer
application and have the same description or function. Fields and button descriptions not listed in this
table are found in tables in their respective sections.

Field or Button Description
Add Add an item to the list.

Add Log Entry Use to enter information to appear in the sample log report that cannot
be recorded automatically through the application. Click the button
again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-
axes to be scaled automatically.Autoscalemeans that the x- and y-
rangeswill be set so that all the data is shown. If Autoscale is not selec-
ted, the entered range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code (default field
label name)

Enter bar code reader information if a bar code reader is connected to
the computer’s USB port. If a bar code reader is not used, this alpha-
numeric field can be used to enter additional information about the
sample, such as a sample lot number, sample ID, etc. This field label
may have been renamed or may not display if modified inOptions >
Default Methods.

Browse Searches for a file.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.

Close Closes the active window.

Close All Closes all active windows. If changesweremade and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Comments Enter comments about the sample or analysis. Comments display in
the report header.

Copies Select the number of copies to print. This field is only enabled when
Print is selected.

Delete Whenworking with pressure tables and pressures,Delete removes
the selected information.

Common Fields and Buttons

Common Fields and Buttons
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2 About the Software

Field or Button Description
Destination Select the report destination.

Edit Whenworking with report parameters, highlight the item in theSelec-
ted Reports list box and clickEdit to modify the report details.

Exit Exits the application. If a file is open with unsaved changes, a prompt
displays providing the option to save the changes and exit or to exit the
application without saving the changes.

Export Exports data in a sample file as a .REP, .TXT, or .XLS file. When
saved to a file, the data can be imported into other applications.

File Select the destination directory. Enter a new file name in the File name
field, or accept the default. Select to save the file as a report system
(.REP), a spreadsheet (.XLS), a portable document format (.PDF), or
an ASCII text (.TXT) file format.

File name Select a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file from the list.

From / To Whenworking with report parameters windows, enter the From and
To range for x- and/or y-axes.

Insert Use to insert one row above the selected row in the table.

List Creates a list of sample or other type files. The list will contain file
name, date / time the file was created or last edited, file identification,
and file status.

Name TheName column is a list of files in the selected directory or library.

Next Click tomove to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double click the file name in the
Name column to open the file.

Prev Click tomove to the previouswindow.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer, or file).

Remove Remove the selected file or files from the list.

Replace Click to select another file where the valueswill replace the current
file’s values.

Replace All Click to select another .SMP file where the valueswill replace all val-
ues for the active sample file. The original file will remain unchanged.

Report Click to display a window to specify report output options.

Common Fields and Buttons (continued)
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Field or Button Description
Save Saves changes.

Save As Saves a file in the active window under a different file name.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Use to display the data from the current analysis.

Instrument Log. Use to display recent analyses, calibrations, errors,
or messages.

Instrument Schematic. Use to display a schematic of the analyzer
system.

Common Fields and Buttons (continued)

Common Fields and Buttons
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2 About the Software

FILE STATUS, DESCRIPTION, EXTENSION, AND LOCATION
In the File Selectorwindow, theMicDescription column and theMic Status column display file
description and file status. The File Selector incorporates standardWindows features for resizing
windows, reordering and repositioning columns, and right clicking an entry to display amenu of
standardWindows functions.

File Status Description
Analyzing Sample files that are currently being used for analysis.

Complete Sample files used in an analysis that has been completed.

Entered Sample files containingmanually entered data.

No Analysis Sample files which have not been used to perform an analysis.

Prepared Sample files that have been used in an automatic degas operation
but have not been analyzed. This status is applicable only if using
the Smart VacPrep or SmartPrep degasser.

Preparing Sample files that are currently being used in an automatic degas
operation. This status is applicable only if using the Smart VacPrep
or SmartPrep degasser.

File Status

File Type File Name
Extension

Default Location

Alpha-s Curve1 ) .ALS Param directory

Adsorptive Properties .ADP Param directory

Analysis Conditions .ANC Param directory

Degas Conditions .DEG Param directory

Heat of Adsorption Report .HOA Param directory

Methods .MTH Param directory

Report Options .RPO Param directory

Sample Information .SMP Data directory

Sample Tube Properties .STB Param directory

File Type, Extension, and Location

1 ) Saves the relative pressures and resulting quantities adsorbed as an ASCII text file. These data
are derived by dividing the isotherm by the quantity adsorbed at 0.4 relative pressure.
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File Type File Name
Extension

Default Location

Thickness Curve1 ) .THK Param directory

File Type, Extension, and Location (continued)

File Type File Name Extension
Portable document format .PDF

Report .REP

Spreadsheet .XLS

Unicode .TXT

Extensible markup language .XML

File Types for Printing or Exporting

1 ) Saves the relative pressures and corresponding thicknesses as an ASCII text file. These data
are derived by dividing the condensed volume of adsorptive by the selected surface area. The dens-
ity conversion factor in the adsorptive properties file is used to convert quantity adsorbed to volume
of condensed adsorptive.

File Status, Description, Extension, and Location
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2 About the Software

KEYBOARD SHORTCUTS
Shortcut keys can be used to activate somemenu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of themenu item.

Certain menus or functions can also be accessed using theAlt key plus the underlined letter in the
menu command. For example:

n to access the Filemenu, pressAlt + F, then press the underlined letter on the submenu
n Alt + F opens the Filemenu, then pressO to access the File Selector

If the underscore does not display beneath the letter on themenu or window, press the
Alt key on the keyboard.

Field or Button Description
Alt +[Unit n] Opens theUnit [n]menu.

Alt + F Opens the Filemenu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to save
changes displays.

Alt + H Opens theHelpmenu.

Alt + I Opens theOptionsmenu.

Alt + R Opens theReportsmenu.

Alt + V Opens theSmart VacPrepmenu.

Alt + W Opens theWindowmenu.

Ctrl + N Opens a new sample file.

Ctrl + O Opens the File Selectorwindow.

Ctrl + P Opens the File Selector to start a report from a selected .SMP file.

Ctrl + S Saves the open file.

F1 Opens the online help operator manual.

F2 Opens the File Selectorwindow.

F3 When in the File Selectorwindow, opens the file search box.

F4 When in the File Selectorwindow, opens the address bar.

F6 Cascades open windows.

Keyboard Shortcuts
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Field or Button Description
F7 Tiles all open application windows.

F8 Opens the File Selector to start a report from a selected .SMP file.

F9 Closes all open reports.

F10 Opens theHeat of Adsorptionwindow.

Shift + F2 Opens the File Selectorwindow listing sample information files.

Shift + F9 Opens the shortcut menu of either the selected component on the analyzer
schematic whenmanual control is enabled or onscreen reports.

Keyboard Shortcuts (continued)

Keyboard Shortcuts
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2 About the Software

OPTION PRESENTATION
Options > Option Presentation
Use to change the way sample files and parameter files display:Advanced, Basic, orRestricted.
Each display option shows sample information and options differently.

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option is

used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Restricted Displays the sample file in a single window similar to theBasic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same passwordmust be entered to
change to theBasic or Advanced display option. This display type is
typically used in laboratories where analysis conditionsmust remain
constant— such as the pharmaceutical industry. TheAdvanced option
is not available in the view selector at the bottom of the window when
using theRestricted display option.

Show Degas
Conditions

When enabled, displays theDegasConditions tab when using
Advanced option presentation and the DegasConditions drop-down
list when usingBasic orRestricted option presentation. This option
may be deselected to hide theDegasConditions tab if not using a
SmartPrep or Smart VacPrep.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display

To change the view for the selected window, use the drop-down list at the bottom of the
sample file editor.

The following examples show the same sample file inAdvanced andBasic display.Basic and
Restricted displayswill look the same. A password is required if usingRestricted format.
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A sample file must be created for each analysis. The file can be created prior to or at the
time of analysis. The sample file identifies the sample, guides the analysis, and specifies
report options.

Option Presentation
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2 About the Software

LIBRARIES
Options > Manage Libraries

This feature is available only toWindows 7 and higher operating systems. This feature is
not available when usingRestricted option presentation.

The library provides an easyway to locate and open specific analyzer files. Libraries are located
within the File Selectorwindow and can be viewed only within the application.

The library gathers sample and parameter files that are stored inmultiple locations— such as folders
on a C: drive, a network location, a connected external hard drive, or a connected USB flash drive—
providing access to all files. Even though libraries do not store actual sample and parameter files,
folders can be added or removed within each library.

One library can include up to 50 folders. Other items— such as saved searches and search
connectors— cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original file
storage location. However, when deleting files or folders fromwithin a library, they are deleted from
their original file storage location.
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METHODS

Options > Default Method

File > Open > [.MTH File]

For 21CFR11 environments, this section is applicable only to members of the
Developer group, however, members of the Analyst groupmay find information in this
section helpful. Sample file information that is available to Analysts is created by amem-
ber in the Developer group using information in this section.

AMethod determines the default sample identification format and sequence number. AMethod is a
template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed, so that only a single
selection is required for each new sample file created.

TheMethod drop-down list displays only thosemethods applicable to the open sample file type.

Methods
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2 About the Software

Field or Button Description
Sequence Number
[text box]

Specify a default numeric string to be used as a prefix in theSample
field when a new sample file is created. This number increments with
each sample file created.

Sample file name
[text box]

Enter a format for the sample identification. The entry in this field
becomes a part of the saved sample file name. Include the $ symbol to
have the sample file number included as part of the identification.

Sample
Operator
Submitter
Bar Code [text box]

These field labelsmay be renamed and the new label becomes a part
of all new sample files.

Default Methods
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CONFIGURE THE ANALYZER

SPECIFY GAS PORTS AND UNIT CONFIGURATION

Unit [n] > Unit Configuration

In 21CFR11 environments, this feature is applicable tomembers of the Developer
group only.

The analyzer has gas inlets for up to three analysis gases and a dedicated inlet for helium. The gases
connected to the inletsmust be specified in the analysis program. If the gases are changed on one of
the inlets, make the same change on theUnit Configurationwindow. The analysis programmust be
kept informed of any changes in gases.

Field or Button Description
Configuration
[group box]

Displays the IP address used by the analysis program, serial number,
and type of analyzer.

IP address.Displays the IP address of the analyzer.

Change IP. [button] Click to display theUnit IP Setupwindow. Use to
change the IP address and subnet mask assigned during installation.
Do not edit these fields unless instructed by aMicromeritics Service

Unit Configuration

Configure the Analyzer
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2 About the Software

Field or Button Description
Representative.

Board ID. [button] Click to display information from the electronic
circuit boards in the analyzer. These parameters cannot be edited.

Gas Selections
[group box]

Enter the gas connected to the specified port.

Options [group box] Displays options installed on the analyzer.

Servo Valve [group box] Displays the last calibration date for the servo valve.

Software Versions
[group box]

Displays the software versions of theMIC BIOS, controller, and ana-
lysis program.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Unit Configuration (continued)

UNIT SELECTIONS

Options > Units
Use to specify how data should appear on the application windows and reports. Thismenu option is
not available if usingRestricted option presentation in a standard installation environment.
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INSTRUMENT STATUS

SHOW DASHBOARD

Unit [n] > Show Dashboard
Data for the dashboard comes from the logged diagnostic data. The dashboard is automatically kept
current as the relevant diagnostic data items are updated. The gaugeswill be updated even if the
dashboard window is not open.

Red numbers on the dashboard require attention. To reset the dashboard numbers,
right click on the dashboard setting, then clickReset.

Field or Button Description
Analyses
completed / started

DisplaysN/MwhereN is the number of analyses that have finished
data collection andM is the number of analyses that have been star-
ted. Analyses canceled or terminated by errors before the termination
stage starts are not counted as completed.

Days until roughing-
pump service is due

Annual maintenance is recommended. The number of days until the
anniversary of the last pumpmaintenance is shown. The displayed
value is updated at least once per day and when themaintenance time
is reset. When the displayed value is 30 or less, the value is displayed
in red. Red negative numbers display if maintenance is past due.

Dashboard Gauges

Instrument Status
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2 About the Software

Field or Button Description
Manifold outgas rate Provides the qualitative indication of the outgas rate in the dosing

manifold. LED images constitute a bidirectional bar graph of the
outgas rate.

The gauge is updated when theAnalysisManifold Test is run. See
Start Diagnostic Test on page 9 - 1.

n Three green LEDs are lit if outgas rate is below 30% of outgas rate
limit.

n At 30%, the left LED turns off.
n At 60%, the center LED turns off.
n At 90%, three green LED lights turn off and the center yellow

LED turns on.
n At 110% and above, only the red LED turns on and attention is

required.

Nitrogen P0 Displays statistics of the saturation pressuresmeasured with nitrogen
gas at liquid nitrogen temperatures. Themean, two-sigma, minimum,
andmaximum values display. The gauge is updated when a P0 is
logged with nitrogen as the adsorptive and a bath temperature of
77±2 K.

Dashboard Gauges (continued)
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SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log

In 21CFR11 environments, seeSystem Audit Trail on page 2 - 29.

Use to display a log of recent analyses, calibrations, errors, or messages. The information is logged
for a 7-day period for analyses and a 30-day period for messages and calibrations.

Field Description
Add Log Entry [button] Use to enter information to appear in the sample log report that cannot

be recorded automatically through the application. Click the button
again to enter multiple log entries.

Analysis/
Calibration/
Message [check box]

Select the logs to display.

Report [button] Click to select print destination and report start date.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Instrument Log

Show Instrument Log
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2 About the Software

SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic
Use to display an analyzer schematic. To operate the valves and elevator from this window, manual
control must be enabled (Unit [n] > Enable Manual Control).

A. 10 Torr Transducer (displays
only for krypton units)

B. 1000 Torr Manifold Trans-
ducer

C. Port 3 Transducer
D.   Elevator
E.  Port 2 Transducer
F. Port 1 Transducer 
G.  P0 Transducer
H. Servo valve

Icon or
Symbol

Description

Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. Whenmanual control is
disabled, closed valves appear white.

Servo Valve. Closed.

Servo Valve. Open.

Elevator.

Sample Tube.Cannot bemanually controlled.

Analyzer Schematic Icons
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Schematic
Components Description

1-3 Sample ports

4 P0 port

5 Servo valve

6 Isolation valve

7,8,9,14 Inlet valves

10 Vacuum

11-13 Unrestricted vacuum sample ports

Analyzer Schematic Components

Icon or Symbol Description
Valve options Open.Opens the selected valve.

Close.Closes the selected valve.

Pulse.Use to quickly turn the valve on and off allowing the operation to
proceed in small increments.

For Servo valve:

n Set.Use to set the servo valve target pressure and dose or evacuate.
n Open.Opens the servo valve. The valve symbol changes to green.
n Close.Closes the servo valve. The valve symbol changes to solid

black.

Elevator options Right click the elevator icon, then select:

Raise.SelectRaise to raise the elevator. When it ismoving, press the
keyboard space bar to stop themovement (or right click and selectStop
from themenu).

Lower.Select Lower to lower the elevator. When it ismoving, press the
keyboard space bar to stop themovement (or right click and selectStop
from themenu).

Stop.Stops the elevator frommoving.

Schematic Shortcuts

Show Instrument Schematic
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2 About the Software

SHOW STATUS

Unit [n] > Show Status

If multiple units are attached to the computer, selectShow Status on eachUnit [n]menu. The status
for all units display.

CONVERT FILES
File > Convert
Converts StarDriver files (.MGD extension) to a sample file with a .SMP file extension. Only those
files with a .MGD file extension display in theName column.
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EXPORT FILES
File > Export

See also:

Exported Data Example on page C - 1

Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or to a file. Data can be exported as a .PDF, .REP, .TXT, .XML, or .XLS file format.
The type of data to include or exclude can be selected during the export process.When exported to a
file, the data can be imported into other applications that read these file formats.

LIST FILES
File > List
Provides the option to create a list of sample file information—such as file name, date, time the file
was created or last edited, file identification, and file status.

Select one or more files from the file selector, clickList, then provide the file destination.

Export Files
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SOFTWARE UNINSTALL

If uninstalling in a 21CFR11 environment, seeUninstall Software in 21CFR11 Envir-
onments on page 2 - 29.

UNINSTALL THE SOFTWARE USING THE COMPUTER
When the software is uninstalled using uninstall.exe, only the files required to run the application are
removed. Parameter files, sample files, reports, calibration files, and data files are not removed.

To uninstall the software, double click the uninstall.exe file located in the software installation
directory, then follow the prompts.

SOFTWARE UPDATES

User Account Control in theWindows operating systemmust be enabled to ensure all
components of theMicromeritics application are installed properly. If UAC is not
enabled, right click theSetup.exe installer file and selectRun as administrator.

Log in to your customer portal to access and download the latest analyzer software version.

When performing a software update, existing data files are not overwritten. There are three types of
subsequent installation:

n a later version than the current installation
n the same version as the current installation
n an earlier version than the current installation

Insert the setupmedia into themedia drive. The setup program starts automatically. If the program
does not start automatically, navigate to the installationmedia drive, locate and double click the
setup.exe file.

Existing Confirm application users and groups are not affected by software updates.
Any changes to Confirm users and Confirm groupsmust bemade usingWindows
Users andGroups.
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SOFTWARE IN 21CFR11 ENVIRONMENTS

TheMicromeritics Confirm applications for 21CFR11 environments require an
operating system ofWindows 10 Professional or Windows 10 Enterprise or higher.
Management of users and groups is performed inWindowsUsers andGroups.

TheMicromeritics Confirm application enables laboratorymanagers to develop analysismethods,
enforce industry standards, and produce audit trails. It also enables laboratory analysts to perform
analyses and produce reports.

USER PERMISSIONS

Confirm User Name Description
mic_[analyzer model
number]_controller

mic_[analyzer model number]_controller is the user name used by all
installations.

n This user should have complete control over the installation dir-
ectory.

n The application is launched under this user name and has this
user’s privileges to the windows file system.

n This user should not be used by anyone or any other software that
is not aMicromeritics application.

n The system administrator has the option of modifying this account
so that the password never expires. Alternatively, if the password
does expire while the application is running, the application auto-
matically changes the password for this account.

Software in 21CFR11 Environments
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Confirm Group Name Description
Developer Group The default Developer group name is

mic_[analyzer model number]_developer. Members of the Developer
group:

n have rights to all functions of theMicromeritics application - includ-
ing Advanced option presentation which allows the creation and
modification of methods, sample files, and parameter files.

n can run an analysis.
n can also be assigned Administrator rights which control the user pro-

files.

Analyst Group The default Analyst group name is
mic_[analyzer model number]_analyst. Members of the Analyst group:

n have access to the Basic presentation option only.
n may create sample files from pre-definedmethods and canmodify

only a limited number of input fields.
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OPTION PRESENTATION FOR 21CFR11 ENVIRONMENTS

Options > Option Presentation

Presentation Display Description
Show Degas
Conditions

When enabled, displays theDegasConditions tab when using
Advanced option presentation and the DegasConditions drop-down
list when usingBasic orRestricted option presentation. This option
may be deselected to hide theDegasConditions tab.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display

For members of the Developer group only. To change the view fromAdvanced
(for Developers) toBasic (for Analysts), click the view selector drop-down list at the
bottom of the window. Select either Advanced (when inBasic view) or Basic (when in
Advanced view).

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option is

used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Option Presentation Display

The following examples show the same sample file inAdvanced andBasic display.

Option Presentation for 21CFR11 Environments
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A sample file must be created for each analysis. The file can be created prior to or at the
time of analysis. The sample file identifies the sample, guides the analysis, and specifies
report options.

TheSave button is disabled on sample files with aComplete status. When thePreview button is
used to view reports for sample files with an unsaved status, the report will have aPreview
watermark. TheSave As andPrint buttons on the report window are also disabled.

CREATE A NEW FOLDER
File > Create New Folder
Provides the option to create and name a new folder in the Confirm application folder. This option
may not be available depending on how the IT administrator configuresWindows permissions.
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SYSTEM AUDIT TRAIL
File > System Audit Trail

Lists the current user, successful and failed application user login attempts, and contains a
description of all the changesmade to sample files.

Contains an audit trail of all system initializations, user login attempts, and sample analyses.

UNINSTALL SOFTWARE IN 21CFR11 ENVIRONMENTS

When the software is uninstalled using uninstall.exe, only the files required to run the application are
removed. Parameter files, sample files, reports, calibration files, and data files are not removed.

To uninstall the software, double click the uninstall.exe file located in the software installation
directory, then follow the prompts.

To uninstall theMicromeritics Confirm application, the owner of the application
directory and its contentsmust be set to the account of the administrator that is
removing the application installation. This account must also have permission tomodify
the application directory and its contents. Thismay requiremodification to the owner
and to the access permissions of the application directory and its contents.

Upon uninstalling the Confirm application, the system administrator should go into
WindowsUsers andGroups to remove the Confirm users and groups. See the Confirm
Administrator Guide [part number 004-42821-01].

Depending on the network, Windowsmay not allow the uninstall.exe program to run. If this happens.
follow these steps:

1. InWindowsUsers andGroups, verify that the current user is not amember of the analyst
group or developer group. If so, remove the user from the group(s). LogOFF, then log back
ON to the computer.

2. InWindowsExplorer, in the Confirm installation directory, double-click the uninstall.exe file to
run the uninstall program.

Uninstall Software in 21CFR11 Environments
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3 SAMPLE FILES
Sample files include the information required by the analyzer to perform analyses and collect data. A
sample file identifies the sample, guides the analysis, and specifies report options andmay be
displayed in either Advanced, Basic, orRestricted presentation displaymode.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either prior to or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example— if the same analysis
conditions exist for multiple analyses, anAnalysis Conditions file containing the recurring conditions
can be created.When the sample file is created, theAnalysis Conditions file can be selected for the
analysis conditions. Once it becomes part of the new sample file, the new file can be edited as
needed without affecting the originalAnalysis Conditions file.

The analysis application contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

To change the view for the selected window, use the drop-down list at the bottom of the
sample file editor.

3 Sample Files
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3 Sample Files

CREATE SAMPLE FILES
Options > Option Presentation > Show Degas Conditions

File > New Sample > [.SMP File]

File > Open > [.SMP File]

For 21CFR11 environments, this section is applicable only to members of the
Developer group, however, members of the Analyst groupmay find information in this
section helpful. Sample file information that is available to Analysts is created by amem-
ber in the Developer group using information in this section.

Each analysismust be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone.

Specify or change the option presentation by selectingOptions > Option Presentation, or use the
view selector drop-down list at the bottom of the window.

Sample files created inBasic option presentationmust selected from parameter files created in
Advanced option presentation.

The values specified in the parameter portions of the default method are the defaults for new sample
files. To navigate from one set of parameters to another, select the parameter tab across the top of
the window.

Sample Tube parameters are edited on theSample Description tab.

TheDegasConditions tab displays only if enabled inOptions > Option Presentation
> Show Degas Conditions
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A bar code reader may be used to enter text into many of the fields on theSample
Descriptionwindow. Use amouse to click in the field first where information is to be
entered then scan the bar code with the bar code reader.

Field or Button Description
Add Log Entry [button] Use to enter information to appear in the sample log report that cannot

be recorded automatically through the application. Click the button
again to enter multiple log entries.

Bar Code [text box] Enter bar code reader information if a bar code reader is connected to
the computer’s USB port. If a bar code reader is not used, this alpha-
numeric field can be used to enter additional information about the
sample, such as a sample lot number, sample ID, etc. This field label
may have been renamed or may not display if modified inOptions >
Default Methods.

Comments [text box] Enter comments about the sample or analysis. Comments display in
the report header.

Mass [group box] Enter a value for samplemass. Mass can be changed any time before,
during, or after analysis.

Enter.Enables theSamplemass field. Enter a value for the sample
mass.

Calculate.Enables theEmpty tube andSample + tube fields. Enter

Sample Files

Create Sample Files
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3 Sample Files

Field or Button Description
the values necessary to calculate the samplemass. Equation used to
calculate samplemass:

Masssample = Masssample+tube –Masstube
Method [drop-down box] Select amethod from the drop-down list.

Operator [text box] Enter operator identification information. This field label may have
been renamed or may not display if modified inOptions > Default
Methods.

Sample [text box] Enter a sample description. This field label may have been renamed or
may not display if modified inOptions > Default Methods.

Sample Tube
[drop-down box]

Select a sample tube file from the drop-down list, or clickEdit to
modify or create a new sample tube file.

Submitter [text box] Enter submitter identification information. This field label may have
been renamed or may not display if modified inOptions > Default
Methods.

Type of Data
[group box]

Automatically collected.Select if the type of data will be
automatically collected by the systemwhile an analysis is running.

Manually entered.Use to enter datamanually that was collected
from another source. IfManually entered is selected, the Isotherm
Report becomes available in theBasic/Advanced drop-down list for
pasting or importing data into the file.

SeeManually Enter Data on page 3 - 7.
User Parameters
[group box]

These fields are primarily used for the SPC (Statistical ProcessCon-
trol) reporting to specify sample characteristics or itsmanufacturing
process but may be used for other data by entering specific analysis
conditions or sample criteria. The entered parameters display on the
SPC Report. Some fieldsmay not display (or may have a different field
label) if modified in themethod fromwhich the sample file was created,
either through Options > Default Method or File > Open >
Method.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Sample Files (continued)
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OPEN A SAMPLE FILE
File > Open > [.SMP File]

Whenworking with an existing sample file, consider making a copy of the sample file to
maintain the original configuration options.

File Status Displays
Preparing
Prepared
No Analysis

Tabbed file editor

Complete
Analyzing
Entered

MicroActive report window

Open a Sample File
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3 Sample Files

If a sample file with aComplete status is opened, to return to the tabbed file editor, selectAdvanced
or Basic from the view selector drop-down list at the bottom of the window.

In 21CFR11 environments, this feature is applicable tomembers of the Developer
group only.
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MANUALLY ENTER DATA

In 21CFR11 environments, this feature is applicable tomembers of the Developer
group only.

This process allows themanual entry of pressure data from a sample file with aComplete status.
There are twomethods for manually entering data into a sample file:

n Copy and paste onto the graph area of the interactive window
n Import data into the interactive window

COPY AND PASTE MANUALLY ENTERED DATA

To display the file status in a search window, go to File > Open. Right click the column
header then clickMore... Scroll to theMIC entries and enableMIC Status.

1. Open a sample file with aComplete status. The file will open to the interactive reports window.
2. Right click in the graph area of the interactive reports window, then selectCopy data.

3. Open another sample file usingAdvanced option presentation.
4. On theSample Description tab, selectManually entered in the Type of Data group box.

Manually Enter Data
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3 Sample Files

5. In the view selector drop-down list at the bottom of the window, click theAdvanced, then
select Isotherm.

6. Ensure that all parameter fields are set appropriately, then clickPaste.
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IMPORT MANUALLY ENTERED DATA
When importing isotherm data from an external ASCII text file using the Import button on the
interactive window, the ASCII text file must use the following rules:

ASCII text file format rules

Datamust be in two columns and separated by a comma or white-space. Acceptable column
headings are:

n Relative Pressure
n Absolute Pressure (mmHg)
n Absolute Pressure (kPa)
n Absolute Pressure (mBar)
n Quantity Adsorbed (mmol/g)
n Quantity Adsorbed (cm³/g STP)
n Quantity Adsorbed (cm3/g STP)

Sample Physical Adsorption ASCII Text File

Silica Alumina : Adsorption
Relative Pressure Quantity Adsorbed (cm3/g STP)
0.108629 50.6657
0.22288 60.7813
0.339909 71.3095
0.459512 84.4172
0.577447 102.672
0.654583 121.707
0.760074 179.096
0.855713 334.565
0.958511 394.675
0.996251 403.793

Silica Alumina : Desorption
Relative Pressure Quantity Adsorbed (cm3/g STP)
0.996251 403.793
0.86016 389.626
0.753567 256.264
0.664418 133.099
0.542416 96.7366
0.422295 79.7351
0.346371 71.5994
0.2519 62.8256
0.152718 54.2336
0.103389 49.5803

Manually Enter Data
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3 Sample Files

To import the ASCII text file

1. Open a new sample file inAdvanced option presentation.
2. On theSample Description tab, selectManually entered.
3. In the view selector drop-down list at the bottom of the window, click theAdvanced, then

select Isotherm.

+

4. Ensure that all parameter fields are set appropriately, then click Import.
5. Open the .TXT file. The data from the original sample file is imported and displayed. If an error

message appears instead, verify that the .TXT file format is correct.
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4 PARAMETER FILES

In 21CFR11 environments, this section is applicable only to members of the Developer
group, however, members of the Analyst groupmay find information in this section help-
ful. Parameter file information that is available to Analysts is created by amember in the
Developer group using information in this section.

Parameter files allow for repeated use of parameter sets. For example— if the same analysis
conditions exist for multiple analyses, anAnalysis Conditions file containing the recurring conditions
can be created.When the sample file is created, theAnalysis Conditions file can be selected for the
analysis conditions. Once it becomes part of the new sample file, the new file can be edited as
needed without affecting the originalAnalysis Conditions file.

Methods include both analysis conditions and report options, offering themost convenient way to
repeat most analyses.

Predefined parameter files are included with the program and can be edited as needed or new
parameter files can be created.

The following file types can exist as part of the sample file aswell as individual parameter files:

File Type File Extension
Adsorptive Properties .ADP

Analysis Conditions .ANC

Degas Conditions .DEG

Method .MTH

Report Options .RPO

Sample Tube .STB

Parameter File Types

4 Parameter Files

MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020 4 - 1



4 Parameter Files

ADSORPTIVE PROPERTIES
File > Open > [.ADP File]
(or clickEdit next to theAdsorptive selection on theAnalysis Conditions tab when inAdvanced
option presentation)

Adsorptive properties provide the adsorptive (analysis gas) characteristics for the analysis.

Field or Button Description
Adsorbate molecular
weight [text box]

Themolecular mass is used for the weight % column of the isotherm
tabular report and for the pressure composition isotherm plot.

Adsorptive [text box] Name of the adsorptive gaswhose properties are being defined.

Density conversion
factor [text box]

Factor determined by obtaining the ratio of the gas density (STP) to
the liquid volume. This field is disabled ifNon-condensing Adsorptive is
selected.

or

where

ρgas = gas density at STP

ρliq = liquid density

ʋl = molar liquid volume

ʋg = molar gas volume at STP

Adsorptive Properties
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Field or Button Description
Dosing Method
[group box]

Normal.Dose from a pressurized tank of gas attached to a gas inlet
port.

From Psat tube. Select if the Psat tube is to be filled with condensed
adsorptive and dosed from the Psat tube. Select this option if using
krypton. The analyzer will determine themaximumpressure that can
be dosed on the analysis temperature and the saturation pressure
information in Fluid Properties.

Maximum manifold
pressure [text box]

The highest pressure to which themanifold will be dosed. To avoid
damage to the analyzer, this number is limited to 925mmHg. Low pres-
sure sourceswill require lower numbers. For gases to be used for dos-
ing after charging a tube from a gas inlet, enter themaximumpressure
for dosing from the inlet, not from the tube of condensate.

Mnemonic [text box] Enter themnemonic name for the adsorptive. .

Molecular cross-sec-
tional area [text box]

The area that a single adsorbedmolecule occupies on the surface of
the sample. It is used in surface area calculations.

Non-condensing
adsorptive [check box]

Select if using a non-condensing analysis gas.When selected, the
Density conversion factor field and thePSAT vs T button are dis-
abled.

Non-ideality factor
[text box]

Compensates for the forces of attraction betweenmolecules in a real
gas. This value is used for a calculated free space.

Psat vs T [button] Click to edit thePsat vs Temperature table. The table contains sat-
uration pressures and their corresponding temperatures. To edit, click
in a field and enter the value.

Therm. tran.
hard-sphere diameter
[text box]

An estimate of molecular size used in calculating the thermal
transpiration correction.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Adsorptive Properties (continued)
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4 Parameter Files

ANALYSIS CONDITIONS
File > Open > [.ANC File]
(or click theAnalysis Conditions tab when inAdvanced option presentation)

Analysis conditions specify the parameters used to guide an analysis.

Field or Button Description
Absolute pressure dos-
ing [check box]

Specifies pressure targets in mmHg, mbar, or kPa instead of relative
pressure. If this option is selected, theRelative Pressure labels and
entries change toAbsolute Pressure in the selected pressure units.

Adsorptive
[drop-down box]

Select anAdsorptive Properties file from the list of defined gases to be
used for analysis. After selection, clickEdit to modify adsorptive prop-
erties. SeeAdsorptive Properties on page 4 - 2. 

Analysis Conditions
[drop-down box]

Use to browse for anAnalysis Conditions file that contains analysis
condition parameters to be used in the analysis.

Analysis Conditions
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Field or Button Description
Backfill [button] Select gas for backfilling the sample tube at the start and end of an ana-

lysis.

The options are disabled if the file status isEntered,Complete, or
Analyzing.

Dose increments
[selection]

The sample is dosed repeatedly with a fixed amount of gas and
isotherm points are collected after equilibrating each dose.

Options. [button] Each entry in the table defines how much to dose for
a segment of the isotherm. In this form of dosing, there is no
predefined pressure table. Define target ranges for up to 10 dose
increments. The ending relative pressure and the dose amount
(entered or as the fraction of the previous quantity adsorbed) for each
target range are shown.

Analysis Conditions (continued)
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4 Parameter Files

Field or Button Description
Equilibration [button] Provides options to specify the equilibration interval and delay time.

(Column heading readsAbsolute Pressure (mmHg)whenAbsolute
Pressure Dosing is selected.)

Minimum equilibration delay at p/po > = 0.995. Theminimum
number of seconds required before equilibration can occur for a
relative pressure greater than or equal to 0.995. This field is not
available if Absolute pressure dosing is selected on theAnalysis
Conditions tab.

Relative Pressure (p/po) or Absolute Pressure. The pressure the
equilibration interval will be applied.

Free Space [button] Use to enter the free spacemeasurement type.

Measure:

n Lower Dewar for evacuation. If the Dewar is to be lowered for
evacuation, select this option and enter the length of time for evac-

Analysis Conditions (continued)
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Field or Button Description

uation after the free spacemeasurement in theEvacuation time
field. If using a cryostat, the operator must manuallymove the cryo-
stat assembly when prompted.

n Evacuation time. The length of evacuation time prior to free space
measurement.

n Outgas test.Checks for system leaks or sample outgassing. After
free space ismeasured, the Dewar is lowered and the sample evac-
uated for the specified amount of time. The leak test is performed
after evacuation. If the pressure risesmore than 0.025mmHg
within the time specified in theOutgas test duration field, outgassing
is present. If a leak is found, the analysis stops and the operator is
notified. While leak testing slightly increases analysis time, it pre-
vents the continuation of analysis and collection of erroneous data if
a leak occurs.

Enter.Measures free space after analysis ends. Enter the estimated
free spacemeasurements.

n Ambient free space. Empty sample tube gas capacitymeasured
at room temperature.

n Analysis free space.Empty sample tube gas capacitymeasured
with the Dewar raised.

Calculate.Use to have the free spacemeasurement calculated using
the sample and tube parameters.

Options [button] Available when the Target Pressures option is selected.

First Pressure Fixed Dose.

This option ismost frequently used when performing a standard
nitrogen analysis of mesoporousmaterials such as catalysts. If the
first pressure table point is low and the gas uptake of the sample is
expected to be high, this option can shorten the time required to

Analysis Conditions (continued)
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4 Parameter Files

Field or Button Description
reach the first point on the pressure table.

The sample is dosed repeatedly at low pressureswith a specified
amount of gas until the first pressure point is reached. This initial
dosing quicklymeets the adsorptive demand of the sample.

The first point on the pressure table is the threshold value,
triggering the transition from the Fixed DoseMode toPressure
TableMode. When the first pressure table value is reached, Fixed
DoseMode is disabled, and points are equilibrated and recorded in
accordance with the specified pressure table.

Enter the amount of gas to be added to the sample for each dose
cycle.

Maximum volume increment.

Select to determine when additional data points are collected
between target pressures in regions of adsorption.When the
maximum increment has been adsorbed since the last collected
data point, another point is equilibrated and collected. During
desorption, this field is treated as amaximum volume decrement
value.

Absolute / Relative pressure tolerance.

Values used to determine how close the actual pressuremust be to
each target pressure from the pressure table. At lower pressures,
the relative tolerance value is lower. At higher pressures, the
absolute tolerance value is lower.

Experiment 1. Theremight be an absolute tolerance of 5 mmHg, a
relative tolerance of 5%, and a target pressure of 40 mmHg; 5% of
40 mmHg is 2 mmHg. Since 2 mmHg (relative tolerance) is lower
than 5 mmHg (absolute tolerance), 2 mmHg is used. Therefore a
minimumpressure of 38 mmHg (40 - 2) must be attained to collect
data for a target pressure of 40 mmHg.

Experiment 2. Theremight be an absolute tolerance of 5 mmHg, a
relative tolerance of 5%, and a target pressure of 200 mmHg; 5% of
200 mmHg is 10 mmHg. Since 5 mmHg (absolute tolerance) is
lower than 10 mmHg (relative tolerance), 5 mmHg is used.
Therefore aminimumpressure of 195mmHg (200 - 5) must be
attained to collect data for a target pressure of 200 mmHg.

Analysis Conditions (continued)
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Field or Button Description
Normally, surface areameasurement points are widely spaced and
the resultingmeasurement is not very sensitive to the precise
location of points so wider tolerancesmay be used. Unnecessarily
tight tolerances lengthen the analysis.

p° and T [button] Click to select one option for obtaining the saturation pressure (Po)
and analysis bath temperature. Each selected option presents a
different set of parameters at the bottom of the window.

Options and descriptions:

1. Analysis bath temperature (not used for krypton analyses).
Measures the p0 on a continuous basis. Allows themeas-
urement of each data point without slowing the analysis.

2. Analysis bath temperature (not used for krypton analyses).
Measures the p0 on a continuous basis and over the sample,
then adjusts themeasured p0 in the sample tube to agree with
the p0 over the sample.

3. The p0 and analysis bath temperatures or an analysis bath tem-
perature only (whenAbsolute pressure dosing is selected on the
Analysis Conditionswindow). Thismethod uses the entered val-
ues.

4. Psat gas. If this is a krypton analysis, select theNitrogen@
77.35K option from theAdsorptive drop-down box. ClickPsat
vs T to edit the values of the Psat vs T table. Editing the values
in the current table does not affect the original table.

5. Analysis bath temperature.Analysis bath temperature and
an estimate for the initial p0 (not used for krypton analyses).
Measures the p0 over the sample. After the p0 is measured, the
value is reapplied to all data points.

6. Analysis bath temperature. Thismethod calculates the p0 at
the time of analysis using the entered temperature.

Analysis Conditions (continued)
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Field or Button Description
Preparation [button] Use to enter analysis preparation details.

Evacuation rate. The rate for restricted evacuation.

Evacuation time. The length of time for preliminary evacuation.

Fast Evacuation.Select for samples (such as pellets) that do not
fluidize or shed particles during evacuation.

Leak Test.Enables the system to check for leaks or sample
outgassing before the analysis. The leak test allows sample pressure
to rise during the test. If the pressure risesmore than 0.15mmHg, the
analysis does not proceed and the operator is notified. While leak
testing slightly increases analysis time, it prevents the continuation of
analysis and collection of erroneous data if a leak exists.

Leak test duration.Enter the duration of the leak test.

Unrestricted evac. from. The pressure at which unrestricted
evacuation is to begin. This option is enabled when Fast evacuation is
not selected.

Use TranSeal.Select if using the TranSeal to transfer the sample
from the preparation port to the analysis port under vacuum.

Analysis Conditions (continued)
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Field or Button Description
Pressures [button] Available when the Target Pressures option is selected. Use to edit the

Entered Pressures table.

The pressure table consists of relative pressure points at which
isotherm data are to be collected. An optional pressure increment can
be entered in thePressure Increment column, which will cause
additional points to be collected at intervals of the pressure increments
up to the relative pressure specified in theEnding Pressure column.

The relative pressure pointsmay span the entire range of
0.000000000 to 0.000000001 p/p0. Theremust be one adsorption
branch (strictly increasing pressures) followed optionally by one
desorption branch (strictly decreasing pressures).

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Analysis Conditions (continued)
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DEGAS CONDITIONS
File > Open > [.DEG File]
(or click theDegasConditions tab when usingAdvanced option presentation)

Use this option only when the SmartPrep or Smart VacPrep is installed. Degassing is a
required step in preparation for an analysis. TheDegasConditions tab provides settings
that will be automatically applied during the degassing procedure when using the Smart
VacPrep.

If using a FlowPrep or a VacPrep use the heating phase section for reference only.

TheDegasConditions tab displays only if enabled inOptions > Option Presentation
> Show Degas Conditions.

Log in to your customer portal to access the Smart VacPrepOperator Manual.
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Field or Button Description
Copy QuickStart degas
conditions from
Smart VacPrep Unit
[drop-down box]

Use to copy the degas conditions settings from the selected Smart
VacPrep unit and port.

Degas conditions
[drop-down box]

Use to browse for a .DEG file that contains degas condition para-
meters to be used in the analysis.

Heating Phase [table] This option is applicable when degassing with either a Smart VacPrep
or a SmartPrep.

Enter up to five stages of degas conditions.

Temperature. Temperature at which the sample is to be held while
degassing.

Time.How long the sample is to be held at the specified temperature
before beginning to cool down.

Temperature Ramp Rate. The rate at which the temperature will
change while advancing to the hold temperature.

Smart VacPrep
Evacuation [group box]

Backfill sample tube. Indicate if the sample tube should be backfilled
automatically or wait for operator response.

Evacuation rate.Rate used for evacuation.

Evacuation time. Length of time for preliminary evacuation before
proceeding with theHeating Phase temperature schedule. The timer
starts when the vacuum level is reached.

Hold pressure.Pressure at which heating will stop and hold the
sample temperature approximately constant until the pressure falls
below theHold pressure. This prevents damage to the sample
structure due to 'steaming' and /or elutriation due to excessive
escaping gas velocity.

Target temperature. Targeted temperature for evacuation.

Temperature ramp rate.Rate at which the temperature is to change
when advancing to the target pressure.

Degas Conditions

DegasConditions
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Field or Button Description
Unrestricted evac. from.Pressure at which the unrestricted
evacuation is to begin.

Vacuum level.Evacuation time starts when the vacuum level is
reached.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Degas Conditions (continued)
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REPORT OPTIONS

File > Open > [.RPO File]
(or click theReport Options tab when inAdvanced option presentation)

See also:

n About Reports on page 7 - 1
n Selected Reports on page 8 - 1

Log in to your customer portal to access the Calculations document.

Additional reports are available using theReportsmenu.

Use to specify report options for data collected from an analysis or manually entered data.Report
Options files also help in customizing report details such as axis scale, axis range, column headings,
and components of thickness curve equations. These filesmay contain tabular reports, plots, or
both, as well as advanced report tables.

Customized report options files can be created then loaded into a sample file, allowing quick
generation of reports.

Report Options filesmay be defined to include overlay options. This system allows the overlay of up
to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a different
plot type from the same analysis. SeeGraph and Sample Overlays on page 7 - 27.

Report Options
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Field or Button Description
Apply thermal
transpiration correction
[check box]

Use to correct the temperature-induced pressure difference between
themanifold and the chilled sample tube. This option ismost significant
for pressures less than approximately 1.0mmHg.
Always use thermal transpiration when performingmicropore
analyses.

Inside diameter of sample tube. Enabled whenApply thermal
transpiration correction is selected. Enter the inside diameter of the
sample tube used in the analysis.

Refer to the Thermal Transpiration Correction section of the
Calculations document. Log in to your customer portal to access the
Calculations document.

Overlays [button] SeeGraph and Sample Overlays on page 7 - 27.

Report options
[drop-down box]

Browse for a .RPO file that contains report options parameters to be
used in the report.

Selected Reports
[group box]

Select the report names to include in the report. For BJH reports, BJH
pore dimension can be calculated in pore width (w), pore radius (R), or
pore diameter (D). Go to Options > Units to specify default
calculations.

Show graphic [text box] Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select, then enter a report title to appear on the report header.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Report Options
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SAMPLE TUBE
File > Open > [.STB File]
(or clickEdit next to theSample Tube selection on theSample Description tab when inAdvanced
option presentation)

Sample Tube files specify information about the sample tube.

Field or Button Description
Ambient free space
[text box]

Empty sample tube gas capacitymeasured at room temperature.

Analysis free space
[text box]

Empty sample tube gas capacitymeasured with the Dewar raised.

Load from Sample File
[button]

Loads parameters from the selected sample file.

Non-ideality factor
[text box]

Compensates for the forces of attraction betweenmolecules in a real
gas. This value is used for a calculated free space.

Sample tube
[drop-down box]

It is a good practice to label each sample tube with a unique iden-
tification. Enter that information here. This information will also appear
in theSample Tube drop-down list on theSample Description tab.

Use filler rod
[check box]

Select if a filler rod is to be used in the sample tube. A filler rod reduces
the stem free space volume resulting in reduction of free space error. It
is generally a good practice to use filler rods for samples having less
than 100 squaremeters of total surface area.

Sample Tube

Sample Tube
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4 Parameter Files

Field or Button Description
Use isothermal jacket
[check box]

Select if an isothermal jacket is to be used. An isothermal jacket main-
tains a constant temperature profile along the sample tube stem during
an extended analysis of more than 1 or 2 hours.

Vacuum seal type
[group box]

Select the seal type to be used.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Sample Tube (continued)
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5 DEGASSING
Most solid materials absorbmoisture and other contaminants when exposed to the atmosphere. The
samplemust be clean when an analysis is performed. The degas process heats the sample to
remove themoisture and contaminants.

Log in to your customer portal to access the Smart VacPrepOperator Manual or the SmartPrep
Operator Manual.

DEGAS ON THE SMARTPREP

See:

Degasser Options on page 1 - 4

If a SmartPrep is not connected to the analyzer, the SmartPrepmenu items are not
available.

Log in to your customer portal to access the SmartPrepOperator Manual.

SMARTPREP CONFIGURATION
Unit [n] > Degas > SmartPrep Configuration
Displays the SmartPrep configuration and software versions.

5 Degassing
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5 Degassing

SHOW SMARTPREP STATUS
Unit [n] > Degas > Show SmartPrep Status
The SmartPrep Statuswindow allows themonitoring of degas operations and to stop the gas flow
after samples are degassed.

Button Description
Cancel [button] Discards any changes or cancels the current process.

Set Temperature
[button]

Use to set the temperature of the selected port.

Skip [button] Use to bypass the current stage.

Stop Gas flow [button] Stops the gas flow to the selected port.

Show SmartPrep Status
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START SMARTPREP DEGAS
Unit [n] > Degas > Start SmartPrep Degas
The six SmartPrep heating stations are represented by row numbers on theAutomatic Degas
window.

Button Description
Browse [button] Searches for a file.

Cancel [button] Discards any changes or cancels the current process.

Clear [button] Clears the sample file selection for a port.

Start [button] Starts degassing.

Start SmartPrep Status

DEGAS ON THE SMART VACPREP

See:

Degasser Options on page 1 - 4

Log in to your customer portal to access the Smart VacPrep operator manual.

Degas on the Smart VacPrep
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5 Degassing

TRANSFER A DEGASSED SAMPLE TO AN ANALYSIS PORT

See also:

Sample Data Worksheet for Gas Adsorption
on page F - 1

When degassing on a separate degasser such as a Smart VacPrep or SmartPrep, the sample tube
must be removed from the degas port, weighed, and then installed onto the analysis port for
analysis.

If the sample tube is not mounted on the analysis port immediately, leave it on the degas
port. If it is necessary to remove the sample tube and a Check Seal or TranSeal was not
used, insert a rubber stopper into the sample tube.

1. Allow the sample tube to cool to room temperature (approximately 15minutes).

Do not touch the sample tube or the heatingmantle until they have reached room tem-
perature. Touching the sample tube, heatingmantle, or heatingmantle clip before they
have cooled could result in burns.

2. Carefully remove the heatingmantle clip and the heatingmantle from the sample tube.
3. While holding the sample tube, loosen the port connector nut and remove the sample tube

from the degas port. If a Check Seal or TranSeal was not inserted prior to degassing, imme-
diately insert a rubber stopper into the sample tube.

4. Complete theSample DataWorksheet.
5. If using a Check Seal, ensure that the Check Seal opener is installed in the analyzer sample

port. If a rubber stopper was used, remove it from the sample tube.
6. Slide an isothermal jacket down over the sample tube stem until it touches the sample tube

bulb.
7. Place the connector nut, ferrule, andO-ring onto the sample tube stem.
8. On the analyzer, loosen the connector nut on the Psat tube and rotate it out of the way.
9. Position the Dewar cover so that the slot for the Psat tube is on the left.
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A. O-ring
B. Ferrule
C. Connector nut
D. Dewar cover

10. Insert the sample tube through one of the holes in the Dewar cover.
11. Place the sample port nut, ferrule, andO-ring onto the sample tube stem.
12. Insert the sample tube into the analysis port and ensure it is completely in the port. Securely

hand tighten the sample port nut onto the analysis port.
13. Position the Dewar cover approximately 3/4 in. (19mm) below the sample port nut.
14. Slide the Psat tube into the Psat slot in the Dewar cover and retighten the Psat tube connector

nut.
15. Insert the jacket onto the Psat tube. Ensure that the Psat tube jacket is level with the sample

tube isothermal jacket.
16. Attach the sample tube to the analysis port, pushing it fully up. Turn the connector nut clock-

wise and hand tighten.
17. Install the Dewar onto the elevator and Close the sample compartment door.
18. Begin the analysis.

Transfer a Degassed Sample to an Analysis Port
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6 PERFORM AN ANALYSIS

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled until
the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

DEWAR PRECAUTIONS

Always handle glassDewars with care. Any product incorporating a vacuum is a poten-
tial safety hazard and should be treated with caution. If in doubt, contact your safety
officer.

Improper handling, disposing of, or transporting potentially hazardousmaterials can
cause serious bodily harm or damage the instrument. Always refer to theMSDS when
handling hazardousmaterials.

Do not pour liquid nitrogen directly into a sink. Doing somay cause drain pipes to burst.

When handling Dewars containing liquefied gases or cryogenic liquids:

n Wear protective equipment:
o goggles or face shield
o an insulated or rubber apron
o insulated gloves

n When pouring liquefied gases from one container to another:
o cool the receiving container gradually to minimize thermal shock
o pour the liquified gas slowly to prevent splashing
o vent the receiving container to the atmosphere

6 Perform an Analysis

MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020 6 - 1



6 Perform an Analysis

FOR GLASS DEWARS

n Use a plastic stirring rod when stirring substances in a Dewar containing liquefied gases (or other
materials of extremely low temperature). Do not use a glass or metal stirring rod unless it has a
protective coating.

n Do not handle heavy objects above the Dewar. If unavoidable, place a protective cover over the
Dewar opening. If an object of sufficient weight is accidentally dropped into the Dewar, shattering
may occur.

n If the Dewar has a protectivemesh covering, do not remove it. This cover minimizes the risk of fly-
ing particles should the Dewar be knocked over, dropped, or broken.
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PREPARE FOR ANALYSIS
The steps in this topic properly prepare the equipment for an analysis. It is recommended to perform
the tasks in the provided order.

n Dewar Precautions on page 6 - 1
n Step 1 -Clean and Label Sample Tubes below
n Step 2 -Create Sample Files on page 3 - 2
n Step 3 -Determine the Sample Mass on page 6 - 5
n Step 4 -Degas the Sample on page 6 - 7
n Step 5 - Sample Tube Installation on page 6 - 8
n Step 6 - Fill and Install the Dewar on page 6 - 11

CLEAN AND LABEL SAMPLE TUBES

The equipment images in this topicmay differ slightly from your equipment, however the
instructions are the same unless otherwise noted.

Sample tubes and filler rodsmust be clean and dry before samples are added and weighed. The
following table indicateswhichmaterials are supplied byMicromeritics and which are supplied by the
user. The procedures following thematerials table are recommended.

Supplied by Micromeritics Supplied by User

n Filler rod
n Funnel
n Sample data worksheet
n Sample tube
n Sample tube brush
n Sample tube rack
n Sample weighing support
n Stopper for sample tube

n Acetone or isopropyl alcohol
n Analytical balance
n Detergent (such as Alconox)
n Drying oven
n Forceps
n Insulated gloves
n Pipe cleaners
n Rubber gloves or lint-free cloth
n Safety glasses
n Ultrasonic cleaning unit
n Waste container

1. Preheat drying oven to 110 ºC.
2. Verify that the ultrasonic cleaning unit is clean.

Prepare for Analysis
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6 Perform an Analysis

3. Use 5 grams of Alconox (or other suitable detergent) per 500mL of warmwater and fill the
ultrasonic unit with enough water to cover the sample tubes and filler rods (if used). If too
much detergent is used, it may be difficult to rinse from the sample tubes. Ensure the deter-
gent is dissolved before placing the sample tubes and filler rods into the water.

4. Fill the sample tubeswith warmwater and place them in the ultrasonic cleaning unit, then
place the filler rods in the unit. Turn on the ultrasonic cleaning unit for approximately 15
minutes.

5. Use rubber gloves to ensure no oils or residue are transferred to the clean tubes and filler
rods, then remove the sample tubes and filler rods from the unit.

6. Clean the interior of the sample tubeswith the brush supplied with the analyzer.
7. Rinse the sample tubes and filler rods thoroughly with hot water. Rinse again with isopropyl

alcohol or acetone. If isopropyl alcohol or acetone is not available, deionized water may be
used.

8. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in the
rack. Bake in a vacuum oven for two hours at 110 °C.

Samples tubes can also be cleaned with high purity acetone or isopropyl alcohol and
dried for about 10minutes under heat. If using thismethod, continue with step 10.
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9. Remove the sample tubes and filler rods from the oven and allow to cool.

Do not insert the filler rods at this time. Filler rods are inserted before the sample tube is
installed on the analysis port.

10. Blow out the sample tubeswith oil-free compressed air.
11. Rinse the sample tube closure with isopropyl alcohol, then wipe the sample tube closure dry

with a clean, lint-free cloth.
12. Label the sample tube and stopper for identification.
13. Replace the rubber stopper, Check Seal, or TranSeal.

CREATE THE SAMPLE FILE

See:

Create Sample Files on page 3 - 2

DETERMINE THE SAMPLE MASS

See also:

Sample Data Worksheet for Gas Adsorption on page F - 1

Clean, dry sample tubes are essential for accurate results. How much sample to use can be
determined best by experiment. In general, a sample providing 40 to 120 squaremeters of total
surface area is recommended for nitrogen analysis. Less than 40 squaremetersmay cause
unreliable results. More than 120 squaremeters will extend analysis time.

Smaller quantities are required for samples having high surface areas. These samples require
careful weighing after degassing because a small error may represent a considerable percent of
total weight. Proper weighing techniques aremost important in this case. Use no less than 100mg to
reduce the effect of weighing errors.

Care should be taken when loading powders— the accessory funnel is useful for this purpose.
Large granules or chunksmay be loaded with forceps.

Analysis results are expressed in units of surface area per gram of sample; therefore, it is important
to know the true samplemass.

Follow the instructions on theSample DataWorksheet and complete all fields to find the true sample
mass.

1. Record the sample tube identification on theSample DataWorksheet.

Create the Sample File
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6 Perform an Analysis

2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize at
zero (0).

3. Place the empty sample tube set (empty sample tube and stopper) on the sample weighing
support and place it on the balance.

4. Record the stabilizedmass on theSample DataWorksheet . Remove the sample tube set
from the balance.

Do not touch the sample with bare handswhile performing the following steps. Doing so
could affect the accuracy of results.

5. Place a sample container on the balance. Tare the balance and allow it to stabilize to zero.
6. Slowly pour the specified amount of sample into the sample container.
7. Remove either the rubber stopper, Seal Frit, Check Seal, or TranSeal from the sample tube.
8. Use the sample tube funnel (provided in the accessories kit) and pour the sample from the

weighing container into the sample tube. TIP: Use a drinking straw tube (approx 6mm [1/4 in.]
diameter) that fits inside the sample tube to keep the inside wall of the sample tube clean.

A. Sample tube
B. Funnel
C. Straw
D. Weighing support

TIP: Use a drinking straw tube (approx. 6mm [1/4in.] diameter) that
fits inside the sample tube to keep the inside wall of the sample
tube clean.

Balance
9. Replace either the rubber stopper, Seal Frit, Check Seal, or TranSeal.
10. On theSample DataWorksheet, record the following:

a. Mass of the sample tube set with the sample.
b. Subtract theMass of empty sample tube set from theMass of sample tube set plus

sample.
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DEGAS THE SAMPLE

See also:

n Degas Conditions on page 4 - 12
n Degassing on page 5 - 1
n Sample Data Worksheet for Gas Adsorption on page F - 1

If using the Smart VacPrep degasser, go toSmart VacPrep > Unit [n] > Start
Degas, then degas the sample usingmenu commands and information entered on the
DegasConditions tab. Log in to your customer portal to access the Smart VacPrep
Operator Manual.

For instructions on degassing on the SmartPrep, seeDegas on the SmartPrep on
page 5 - 1.

After the sample has been weighed, use a degassing unit to remove any contaminants whichmay
have adsorbed to the surface or pores. Appropriate degassing units are available from
Micromeritics.

After degassing is complete, perform the following steps:

1. Weigh the sample tube set containing the sample. Record themass on theSample Data
Worksheet for Gas Adsorption on page F - 1 asMass of Sample tube set plus sample
(After Degas).

2. Subtract theMass of empty sample tube set (Before Degas) from theMass of Sample tube
set plus sample (After Degas) to obtain the sample’smass. Record this value asMass of
sample (After Degas).

Degas the Sample
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6 Perform an Analysis

SAMPLE TUBE

Sample Tube Installation

Repeat these steps for each sample tube to be installed.

If using... Then...
A rubber stopper Remove it.

An isothermal jacket Slide the jacket down over the stem of the sample tube until it touches
the sample tube bulb.

A filler rod Hold the sample tube horizontally and carefully slide the filler rod into the
tube.

Do not hold the rod vertically and drop the rod into the tube;
this could break the rod and/or tube.

1. Remove the sample tube stopper.

n If using a filler rod, hold the sample tube horizontally and carefully side the filler rod into the
tube.

n If using an isothermal jacket, slide the jacket down over the stem of the sample tube until it
touches the sample tube bulb.

2. Insert the P0 tube into the center hole of the Dewar cover and slide the cover up. Ensure the
tapered side of the cover is facing downward.

3. Insert the sample tube through one of the holes in the cover.
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A. O-ring
B. Ferrule
C. Connector nut
D. Dewar cover

4. Place the connector nut, ferrule, andO-ring onto the sample tube stem.
5. Attach the sample tube to the analysis port and ensure it is completely in the port. Securely

screw the connector nut onto the analysis port. Hand tighten the connector nut.
6. Slide the Dewar cover upward until it stops.

Sample Tube O-ring Replacement

The equipment images in this topicmay differ slightly from your equipment, however the
instructions are the same unless otherwise noted.

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-ring
becomesworn or cracked, it does not provide a good seal and will need to be replaced.

Before removing (or installing) a sample tube, ensure that the port valve is closed.
Observe the analyzer schematic to verify valve status.

Do not allow the sample tube connector nut drop onto the bottom of the tube as it may
break the tube.

Use the proper size frit for the sample port. The analyzer will not operate properly if an
incorrect size is used.

Sample Tube
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6 Perform an Analysis

1. Carefully remove the Dewar from the analyzer. Take care not to bump the sample tube bulbs
with the Dewar during this process. Place the Dewar aside.

2. Hold the sample tube firmly with one hand, loosen the sample tube connector nut by turning
counter-clockwise.

3. Carefully pull the sample tube down until it is free from the port. It may be necessary to grasp
the sample tube with both hands.

A. O-ring
B. Ferrule
C. Connector nut

4. Remove theO-ring from the top of the sample tube and replace it with a new one.

If the O-ring remains inside the sample port, use theO-ring removal tool from the access-
ory kit [tool part number 004-54618-00] or use a pair of tweezers or needle-nose pliers
to remove it.

5. After the new O-ring is in place, insert the sample tube back into the sample port until it is fully
seated.

6. Slide the sample tube connector nut up the tube until it comes in contact with the port fitting
(the ferrule andO-ring will move along with the connector nut). Then, turning clockwise, hand
tighten the connector nut to the sample connector.
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FILL AND INSTALL THE DEWAR

The equipment images in this topicmay differ slightly from your equipment, however the
instructions are the same unless otherwise noted.

See also:

Dewar Precautions on page 6 - 1

1. Fill the Dewar with the analysis bath liquid (such as liquid nitrogen) to no higher than 2 1/4 in.
(5.7 cm) from the top. Filling the Dewar higher than this will cause an error in the free space
measurement.

Incorrect fluid levels can lead tomeasurement errors. Check the level of the bath liquid
before each analysis.

2. Insert the dipstick and check the level of the analysis bath liquid. Condensation should not
exceed the level indicator mark.

Fill and Install the Dewar
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6 Perform an Analysis

3. For best results, if the Dewar has not been used for a while, allow approximately 30minutes
for the temperature of the Dewar to stabilize with the bath liquid, then recheck the level of the
bath liquid. Add additional liquid if necessary.

4. Slide the Dewar cover to approximately 3/4 in. (19mm) from the sample port nuts to ensure a
proper seal on the top of the Dewar.

5. Place the Dewar on the elevator.
6. Close the safety shield on the front of the analyzer.
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PERFORM A KRYPTON ANALYSIS
Unit [n] > Krypton Analysis

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled until
the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

Krypton analyses are available only if the krypton option is installed.

Data collection is done sequentially— one analysis starts and completes before the next
analysis begins.

Use to perform up to three simultaneous krypton analyses. Use the following guidelines for
performing krypton analyses:

n All analysesmust use krypton gas. An error message occurs if a gas other than krypton is spe-
cified.

n FromPsat tubemust be selected as theDosingMethod onAdsorptive Properties. An error
message displays ifNormal is selected as theDosingMethod. Samples cannot be removed
from or added to ports until the full set of analyses has completed.

1. ClickBrowse to select a sample file.
2. ClickReport after analysis to automatically generate reports when the analysis is complete.

On theReport Settingswindow, select the report destination. ClickOK.
3. ClickStart to start the analysis. A window displays data as they are collected. A short delay is

encountered before the port status changes from the Idle state at the bottom of the window.

When analysis is complete, remove the sample tube and store (or dispose) of the sample
material as applicable.

4. ClickStart to start the analysis. A window displays data as they are collected. A short delay is
encountered before the port status changes from the Idle state at the bottom of the window.

When analysis is complete, remove the sample tube and store (or dispose) of the sample
material as applicable.

Perform a Krypton Analysis
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6 Perform an Analysis
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PERFORM A QUICKSTART ANALYSIS
Unit [n] > QuickStart Analysis

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled until
the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

Use to analyze up to three samples of the same type using the same analysis conditions, adsorptive
properties, and report options. TheQuickStart Analysis option automatically creates a sample file for
each port and assigns the default parameters. Edit the parameters of a file using theEdit button or
select another file using theBrowse button.

ClickNext to schedule additional analyses after the completion of the first set of analyses. TheNext
button appears after the first series of analyses is complete. Samples cannot be removed or added
to ports until the full set of analyses has completed.

1. ClickBrowse to select a sample file.
2. ClickReport after analysis to automatically generate reports when the analysis is complete.

On theReport Settingswindow, select the report destination. ClickOK.
3. ClickStart to start the analysis. A window displays data as they are collected. A short delay is

encountered before the port status changes from the Idle state at the bottom of the window.

When analysis is complete, remove the sample tube and store (or dispose) of the sample
material as applicable.

4. ClickStart to start the analysis. A window displays data as they are collected. A short delay is
encountered before the port status changes from the Idle state at the bottom of the window.

Perform aQuickStart Analysis
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6 Perform an Analysis

When analysis is complete, remove the sample tube and store (or dispose) of the sample
material as applicable.

Field or Button Description
Sample tube
[drop-down box]

Click the drop-down arrow to select a sample tube file. This option is
applicable only if the calculatedmethod for measuring free space is
selected for analysis conditions.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

QuickStart Analysis
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PERFORM A SAMPLE ANALYSIS
Unit [n] > Sample Analysis

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled until
the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

Use to perform up to three analyseswith different analysis conditions and/or report options. Sample
files can be loaded into ports 1, 2, and 3 allowing one analysis using different analysis conditions to
run on each port.

WhenStart is selected, the selected sample file’s analysis conditionswill be compared with the
port’s hardware configuration to verify that the specified analysis is supported by the hardware:

n If Krypton is selected as the adsorptive, theremust be a 10mmHg transducer present on the
port.

n Theminimum target pressuremust be no less than theMinimumRecord Pressure for themin-
imum range transducer present on the port.

n The selected sample files will be checked for matching adsorptive gases, matching Psat or P0
gases if measured, andmatching backfill gases. All selected gases, except those in a pre-
charged vapor source, must be connected to gas inlets and identified on theUnit [n] > Unit
Configuration > GasSelectionswindow. SeeSpecify Gas Ports and Unit Configuration
on page 2 - 15.

Perform a Sample Analysis
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6 Perform an Analysis

n If any selected sample file specifies anAdsorptive DoseMethod from port 3 and a sample file
is selected for port 3, an error message displays indicating the problem and theStartwindow
will remain active.

1. ClickClose Valves to manually close all analyzer valves.
2. For a selected port, either clickBrowse and select a sample file, or clickNew to create a new

sample file.
3. Verify the information populated into the sample identification. This information is pulled from

the selected or newly created sample file. TheDensity value is applicable only if using theCal-
culatemethod for the free space determination.

4. Edit theP0 andBath temperature fields, if necessary.
5. If using a cryostat, selectUseCryoStat and complete the Target tolerance andHold time

fields.
6. ClickReport after analysis to generate reports automatically when the analysis is complete.

On theReport Settingswindow, select the report destination. ClickOK to return to the pre-
viouswindow.

7. ClickStart to start the analysis. A window displays data as they are collected. A short delay is
encountered before the port status at the bottom of the window changes from the Idle state.

8. When the analysis is complete, remove the sample tube and store (or dispose of) the sample
material as applicable.

Use caution when removing the sample tube if using a hanging filler rod. The sample
tubeO-ring or Dewar cover may snag the filler rod retaining ring. Loosen the snag
gently; excessive forcemay break the tip of the filler rod.

Field or Button Description
Bath temperature
[text box]

Enter the temperature for the analysis bath.

Close Valves [button] Closes all valves on the unit.

Density / Mass /
Sample + Tube /
Empty Tube [text box]

Enter values for the sample’smass and density. These valuesmay be
edited after analysis.

New [button] Creates a new sample file.

P0 [text box] Enabled if Entered is selected for the P0measurement for at least one
file.

Report after analysis
[button]

Generates reports to the selected destination when the analysis is
complete.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Sample Analysis
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A. Suspend/Resume/Skip
buttons

B. Port report buttons
C. Live graph settings

Field or Button Description
Live Graph Settings
[button]

Select Thermal transpiration, x-axis Quantity (relative or absolute pres-
sure), and the x-axis Scale (linear or logarithmic).

Report after analysis
[button]

Generates reports to the selected destination when the analysis is com-
plete.

Port [button] Generates a report on data being collected on the respective port. The
reports are displayed on the computer monitor only.

Resume [button] Restarts the suspended analysis.

Skip [button] Moves to the next step. This button is visible only when an analysis is in
progress. Select the ports to skip. In 21CFR11 environments, steps
cannot be skipped.

Status window Displays the last point pressure and relative pressure for each port
with varying numbers of digits after the decimal if 10mmHg and 0.1
mmHg transducers are present on that port, as follows: P < 0.1: 6
digits, 0.1 <= P < 10: 4 digits, P >= 10: 2 digits. Relative pressure will
show 3more digits than absolute pressure.

Suspend [button] Suspends an analysis in progress. Select the ports containing the ana-
lysis to suspend.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Sample Analysis Graph

Perform a Sample Analysis
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6 Perform an Analysis

PERFORM AN EMPTY TUBE ANALYSIS
Unit [n] > Empty Tube Analysis

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled until
the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

Use to obtain sample tube parameters when using a calculated free space. An empty tube analysis
can also be used for diagnostic purposes. The empty tube analysis should result in zero adsorptive.
An amount other than zero could indicate a possible leak.

1. ClickBrowse to select a sample file.
2. ClickReport after analysis to automatically generate reports when the analysis is complete.

On theReport Settingswindow, select the report destination. ClickOK.
3. ClickStart to start the analysis. A window displays data as they are collected. A short delay is

encountered before the port status changes from the Idle state at the bottom of the window.

When analysis is complete, remove the sample tube and store (or dispose) of the sample
material as applicable.

4. ClickStart to start the analysis. A window displays data as they are collected. A short delay is
encountered before the port status changes from the Idle state at the bottom of the window.

When analysis is complete, remove the sample tube and store (or dispose) of the sample
material as applicable.
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PERFORM A REFERENCE MATERIAL ANALYSIS

Service Test Mode is required for this test. SeeService Test Mode on page 11 - 20.

The equipment images in this topicmay differ slightly from your equipment, however the
instructions are the same unless otherwise noted.

1. Remove the sample tubes from the degassing unit and reweigh the samples.
2. Place the filler rods into the sample tubes. Place the isothermal jackets on the sample tubes

and install the tubes on the sample ports.
3. Go to Unit [n] > Service Test > PCP Analysis.
4. Select the correct sample for the instrument:

n Nitrogen - if the instrument is a nitrogen unit.
n Krypton - if running an alumina sample for a krypton analysis.

5. ClickStart to begin the analysis.
6. When the analysis completes, go toReports > Start Report to view the report. Locate the

report file in the c:\......Data\PCP\ directory. An example of the file name is 1N217-0.SMP
where the first digit is the port number (1, 2, or 3), the letter N (for nitrogen), the unit serial num-
ber (217), and -0 (1, 2, 3, etc.) to indicate the number of the run.

7. Select the report and clickReport.
8. On theReport Settingswindow, selectPreview as the destination for the report and clickOK.
9. When the analysis is complete, compare the BET Surface Area shown in the report with the

BET Surface Area shown on the referencematerial bottle.

n If the results are within tolerance, the instrument is operating properly.
n If the results are not within tolerance, refer to the following table for possible causes and

actions. After performing the action, perform the referencematerial analysis again.

Cause Action
The sample was not degassed
properly.

Degas the sample again.

The gas lines are not clean. Clean and verify the gas lines. SeeClean and Verify the
Gas Line on page 11 - 8. See.

Themeasured free space is too high.
This indicates the heliummay not be
pure enough.

Ensure the helium is 99.999% pure.

Perform aReferenceMaterial Analysis
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7 ABOUT REPORTS
Reports > Open Report > [.REP file]
Opens a saved report.

Reports > Close Reports
Closes all open reports. This option is unavailable if reports are being generated.

Reports > Start Report
Generates a report on a sample analysis.

Reports can be generated for data collected on a sample that has completed analysis, collected on a
sample currently being analyzed, or manually entered.

START REPORTS
Reports > Start Report
Starts the selected report. Select a file from the Files list. Ensure the selected file has a status of
eitherComplete or Analyzing.

7 About Reports
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7 About Reports

HEAT OF ADSORPTION REPORT
Reports > Heat of Adsorption

Use to select sample files, define quantities, and generate aHeat of Adsorption report. The isosteric
heat of adsorption is an important parameter for characterizing the surface heterogeneity and for
providing information about the adsorbent and the adsorption capacity. Multiple adsorption
isotherms are obtained on the same sample using the same adsorptive but at different temperatures
to obtain the heat of adsorption.

Field or Button Description
Add Samples [button] Adds a sample file to the table.

Clear Samples [button] Removes all entries from the table.

Edit Quantities [button] Use to specify the range of surface coverage to include in the report.

Heat of Adsorption Report
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Field or Button Description

Insert Range.Click to specify the starting and ending quantities
adsorbed and number of points to insert.

Load Table. Imports values from another file.

Save Table.Saves the current table as a .QNT file.

Apply.Applies all table changes.
Heat of adsorption plot
[selection]

Generates theHeat of Adsorption data in a graphical format.

Isostere plot [selection] Generates a graph showing quantities of gas adsorbed versus the tem-
perature.

Remove Sample
[button]

Removes the selected sample from the list.

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select, then enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples. A tabular report
contains the numeric values contributed by each sample.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Heat of Adsorption Report (continued)

Heat of Adsorption Report
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7 About Reports

SPC REPORT
Reports > SPC Report Options
Use to generate reports with variousSPC (Statistical ProcessControl) options. All selected
variablesmust be computed for each sample file used in an SPC report; therefore, it is more efficient
to select only the necessary variables.

The selected items display as graph variable selections in Reports > Regression Report and
graph selections inReports > Control Chart. If report options for NLDFT Advanced PSD are
required, clickMore.
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REGRESSION REPORT
Reports > Regression Report
Use to generate a Statistical ProcessControl (SPC) Regression report to determine the
interdependency between two variables. Up to three dependent variables (y-axis) may be plotted
against a single independent variable (x-axis). The degree of correlation between the variables is
also reported.

Field or Button Description
Autoscale [check box] When enabled, allows the x- and y-axes to be scaled automatically.

Axis Range [text box] Enter the beginning and ending values for the x- and y-axis ranges.
These fields are disabled if Autoscale is selected.

Label data [check box] Use to label the points on the plot to correspond with the values in the
sample files.

Recalculate archived
SPC results [check box]

The first time this option is used, the time it takes to generate the report
is lengthened. The second time the report is generated, if using the
same sample files used in the initial calculation, it is recommended that
this option not be selected since the data was recalculated previously.
If a sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data
from the newly added or removed sample file is recalculated.

Samples [button] Select additional sample files to add to the report.

Save as Default [button] Click to save selected report options as default report settings.

Regression Report

Regression Report
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7 About Reports

Field or Button Description
Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select, then enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples. A tabular report
contains the numeric values contributed by each sample.

X- and Y-Axis variable
[drop-down box]

Use to designate the x- and y-axes variables. The variables in the
drop-down lists are those selected in theReports > SPC Report
Optionswindow. Use these options to plot the regression of up to
three y-axis variables against the x-axis variable.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Regression Report (continued)
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CONTROL CHART REPORT
Reports > Control Chart
Generates a Statistical ProcessControl (SPC) chart report which plots the changes in a statistic.

Field or Button Description
Graph [n] [button] Defines the y-axis of each graph.

Statistic. Displays the SPC variables selected on theReports >
SPC Report Optionswindow. The selected variable will be plotted
for each selected sample. This selection also becomes the y-axis label.

Autoscale.Allows the y-axis to be scaled automatically. To specify a
range, deselect this option and enter a range in the From and To fields.

Center Line.Displays placement options for the center line in the

Control Chart Report

Control Chart Report
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7 About Reports

Field or Button Description
graph. SelectEntered to specify placement of the line orMean to place
the center line at the calculatedmean value for the selected samples.

Limit Lines. Displays limiting lines options. Lines can be placed at
somemultiple of the standard deviation or at specified positions
(Entered). WhenEntered is selected, enter theHigh limit and Low limit
fields with appropriate values.

Recalculate archived
SPC results [check box]

The first time this option is used, the time it takes to generate the report
is lengthened. The second time the report is generated, if using the
same sample files used in the initial calculation, it is recommended that
this option not be selected since the data was recalculated previously.
If a sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data
from the newly added or removed sample file is recalculated.

Report [button] Generates the report.

Samples [button] Select additional sample files to add to the report.

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select, then enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples. A tabular report
contains the numeric values contributed by each sample.

Control Chart Report (continued)
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Field or Button Description
X Axis Order By
[group box]

Select the order in which x-axis statistics are placed. Sort by: 

Time. Time the files were analyzed.

File name. Alphanumeric order.

Date. Date the files were analyzed.

Minutes.Minutes elapsed from the first file placed on the list, which is
the earliest-analyzed file.

Days. Number of days elapsed from the first file placed on the list,
which is the earliest-analyzed file.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Control Chart Report (continued)

Control Chart Report
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7 About Reports

MICROACTIVE REPORTS
MicroActive reports are generated automatically after an analysis is performed. This feature
provides a quick and easyway to investigate andmanipulate analysis data using a variety of
reportingmethods.

When a sample file with a status ofComplete, Analyzing or Entered is opened, a linear plot and log
plot of the data collected during analysis are displayed aswell as a summary of the analysis giving
the total pore volume. Numerous reports are accessible from a drop-downmenu.

When a report is opened, plots and summary data are displayed, and in some reports certain
parameters (for example, thickness curve type, pore geometry, and interaction parameters) are also
displayed. Plotsmay be edited by selecting the data points or data point range to be included in the
plots andmodifying the parameters. When a report is edited, the results are immediately reflected in
the plots and summary data.
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INTERACTIVE REPORTS
When opening a sample file that contains data from a complete or in-progress analysis, the
interactive reporting feature is enabled.

1. When opening a sample file that contains analysis data, a window with the following inform-
ation will display:

n a linear plot and log plot of the data collected during analysis
n a summary of the analysis giving a single total pore volume and surface area

2. To view the plots in either relative or absolute pressure, select either theRelative Pressure or
Absolute Pressure option.

3. To view the reports selected for generation during the analysis, clickPreview.
4. From the view selector drop-down list at the bottom of the window:

n change the option presentation of the sample information window to either Basic or
Advanced to modify certain file parameters, or

n select another plot from the list and edit the data contained in the plot.

5. When ranges are edited, the changes are reflected immediately in the plots and the summary
data displayed in the window. Some editing options are:

n Drag the blue bars to increase or decrease the range of data included in the plot.
n Edit the Isotherm Linear Plot to include or omit the data point from the BET plot.
n Right click to display a popupmenu to include reports; enable or select overlays; edit

curves, axes, legends, titles; and copy and paste the data in a graph or in tabular format.

6. ClickSave.

Interactive Reports
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7 About Reports

EVALUATE REPORT RESULTS
Analysis reports provide a record of test conditions, experimental data, and information extracted
from the experimental data by application of various reductionmethods. This topic discusses the
elements of various reports presented byMicromeritics’ static volumetric physical adsorption
analyzers and suggests ways bywhich themerit of the reported informationmay be evaluated.

Regardless of the precautions exercised before the analysis, problems still may occur during the
analysis, or as a result of using inappropriate parameters or even inappropriatemethods. The
analysis data should be inspected for evidence of experimental error. The traditional method of
confirming the quality of the experiment is to repeat the analysis. Toward that end, Micromeritics’
analyzers log and report the exact conditions of each analysis.

Analysis data can be evaluated by:

n Viewing the Validation Report
n Inspecting the IsothermPlot
n Evaluating the Isotherm Tabular Data Set
n Reviewing Reduced Data

7 - 12 MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020



VIEW THE VALIDATION REPORT
TheValidation report showswhether the data collected during an analysis are within typical ranges.
Select the types of reports to include by selecting the report in theValidation Report Optionswindow.

When a selected report is generated, if errors occur, a message is displayed across the top portion of
the report and a unique symbol displays on the graph.

INSPECT THE ISOTHERM PLOT

Evaluation of data should begin with a visual inspection of the isotherm plot. The plot should be
composed of data which have not been subjected tomathematical smoothing as far as possible. If
the data describe a Type I isotherm, then the plot is best shown on a logarithmic pressure axis so that
details of the low pressure region are revealed. Data in this region are important particularly for
micropore studies. Examine the plot to determine if any points are outliers or if a region of the
isotherm exhibits characteristics (spikes, steps, etc.) which are inconsistent with the physical process
beingmonitored. The philosophical question of whether or not these suspected extraneous data
points should be removed from the raw data is not considered here, but it may be appropriate to
exclude an outlier from reduced data. Toomany outliers can cause the integrity of the total data set
to come under suspicion.

Examine specific reported values to confirm that the isotherm data were collected under reasonable
conditions and using reasonable parameters. For example, confirm that the free space values
reported are typical for the sample holder and bath in use. A problemwith either ambient or analysis
free space valuesmay indicate a free spacemeasurement error and affect all calculations of quantity
adsorbed.

The raw data should be carefully examined before it is reduced. Errors that occur in raw data will
only be exacerbated in reduced data.1 )

1 ) The information in this article is extracted fromAnalytical Methods in Fine Particle Technology,
Webb, P. andOrr, C., (1997).

Evaluate Report Results
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7 About Reports

EVALUATE THE ISOTHERM TABULAR DATA SET

Another place to look for reasonableness of the data is the adsorptive uptake by the sample in the
BET range (P/P0 = 0.05 to 0.30). Total uptake is the specific quantity adsorbed (cm3/g STP) times
the samplemass (g). As an example, the level of uncertainty in this range typically is less than
0.1 cm3 STP for a high performance system. Total uptake quantities should be somemultiple of this
level of uncertainty. Otherwise, an unfavorable signal-to-noise ratio and unreliable data result. The
solution is to use a greater quantity of sample to increase adsorptive uptake.

Another valuable bit of information resides in the tabulated saturation pressure. This pressure is
expected to change somewhat over the duration of an analysis, but it is not expected to do so with
large or abrupt transitions. Unreasonable saturation pressures or unusual changesmay indicate that
a gas different from the adsorptive was used in determining P0, that the level of the cryogen fell too
far, or that the cryogen is impure or inappropriate.

With experience, obvious signs of problems can be detected by a quick inspection of the tabular and
graphical data. If the data appear satisfactory, the next step is to evaluate the reduced data.1 )

REVIEW REDUCED DATA

Isotherm datamay be analyzed by any one of several reductionmethods depending on the analyzer
model and pressure range employed. The quality of the results depends on the quality of the
isotherm, the congruity of the data reduction parameters with experimental conditions, the
agreement of the theoretical model with the physical gas-solid system, and compliance to the
pressure range over which themethod is valid. Typically, results can be appraised by examining a
few salient areas of the report as described in the following topics.2 )

1 ) Most of the information in this article is extracted fromAnalytical Methods in Fine Particle
Technology,Webb, P. andOrr, C., (1997).
2 ) Most of the information in this article is extracted fromAnalytical Methods in Fine Particle
Technology,Webb, P. andOrr, C., (1997).
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PHYSICAL PARAMETERS

The value of physical parameters which are used only in data reduction routines should be reviewed
to assure that they agree with experimental conditions. These parameters can be changed and the
experimental data recalculated if an error is discovered or if exploring an alternate value is desired.
Analysis condition values used in the calculation of quantity adsorbed can be changed also. These
are typically themanually entered free space(s), nonideality correction factor, and bath temperature.

The area occupied by a single adsorbedmolecule is a required parameter in the calculation of
surface area by the BET and Langmuir methods. The software provides a default value, but other
values are found in the literature. McClellan and Harnsberger1 ) provide a comprehensive review of
such values.

The volume of pores of a specific size range is calculated from the gas quantity adsorbed in them by
converting the quantity to its liquid equivalent volume. This is achieved through use of a density
conversion factor calculated from the ratio of molar densities of the condensed adsorbate at bath
temperature to the gaseous phase at STP. The necessary information is found in handbooks. The
software contains default values for common adsorptives; values for other adsorptivesmust be
calculated.

The terms for liquid surface tension , contact angle between solid and liquid phase , molar volume
of the adsorbate , gas constant , and sample temperature are treated as one constant, the
adsorbate property factor expressed by:

using which, the Kelvin equation2 ) reduces to

Either surface tension, contact angle, or molar volume can be revised individually to give a new value
for the factor , or can simply be altered arbitrarily for exploratory purposes.

The thermal transpiration correction requires two parameters whichmay be adjusted from those of
the default values. The first is the inside stem (neck) diameter of the sample holder, and the second
is the hard-sphere diameter of the adsorptivemolecule. The sample holder inside diameter is
available from the documentation provided with it or ismeasurable. Information on hard-sphere
diameters of moleculesmay be obtained from handbooks.

1 ) McClellan, A.L., and Harnsberger, H.F., Journal of Colloid and Interface Science, 23, 577 (1967).
2 ) Thomson,W., Phil. Mag. S., 42, 448 (1871).

Evaluate Report Results
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7 About Reports

For terms such as the interaction parameter found in the Horvath-Kawazoe calculation1 ) , the
Dubinin affinity coefficient, or Astakhov exponent2 ) , the default values as provided by the software
generally are adequate. A search of the technical literature is required if the analysis involves a gas-
solid system other than that covered by the default values.

The t-Plot method plots quantity adsorbed (Va) against thickness (t) derived from a thickness
equation, and the Dubinin transform plots quantity adsorbed against log(P/P0)n. All of these data
reductionmethodswere first proposed for specific applications. The user must make a judgment as
to the applicability of themethod to a gas-solid system.

If applied appropriately, all transform plots will exhibit a linear range and the regression analysismust
be applied only over the linear range and within the range of application. Fitting a regression line to
surface area transformation plots should yield a correlation coefficient of 0.9999 or better and for
t-plots and Dubinin plots the correlation coefficient should be 0.99 or better.

If the data reductionmodel does not apply to the gas-solid system under examination, then it may be
that either no linear range exists within the pressure range of validity, or that solutions derived from
the regression line of the linear range are intuitively incorrect, that is, they have no relevance to the
physical situation, such as a negative C-value from a BET transform.

BET C-VALUE

BET theory assumes uniform surface coverage with no favored adsorption sites and it also assumes
that the gas ismore strongly attracted to the surface than to other gasmolecules. The typical range
of BET C-values is from about 5 to well over 100. Valuesmuch less than 5 imply that the gas-to-gas
affinity is competing with the gas-to-solid affinity which conflicts with the basic assumptions of BET
theory. C-valuesmuch greater than 100 indicate very strong attraction for the surface or preferential
adsorption.

Provided the isothermwas determined with negligible error and the regression line to the BET
transformation data was fit properly, then an out-of-range C-value probably indicates that the gas-
solid interaction for the particular samplematerial does not conform to the BETmodel. An
inappropriate adsorptionmodel may be indicated also by the coefficient of correlation of the
regression line, 0.999 being about theminimum value expected with fivemore or less equally spaced
points. In the case of indications of poor conformance to the BETmodel, the Langmuir data
reductionmethod should be examined.

1 ) Everett, D.H. and Powl, J.C., J. ChemSoc., Faraday Trans. 1, 72, 619 (1976).
2 ) Dubinin, M. and Radushkevich, L.V., Proc. Acad. Sci. USSR, 55, 331 (1947).
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DATA ANALYSES BY THE BJH METHOD

In general, thismethod visualizes the incremental decomposition of an experimental isotherm,
starting at the highest relative pressure or pore size. At each step the quantity of adsorptive involved
is divided between pore-emptying and film-thinning processes and is accounted for totally. This
computational algorithm frequently leads to inconsistencies when carried to small mesopore sizes. If
the thickness curve used is too steep, ultimately it will predict a larger increment of adsorptive for a
given pressure increment than is actually observed. The algorithmmust stop since a negative pore
volume is nonphysical. Accumulated error results in the calculation of a too large volume of (possibly
nonexistent) small pores if the thickness curve used underestimates film thinning.

Evaluate Report Results
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7 About Reports

REPORT FEATURES AND SHORTCUTS

See also:

Graph Features and Shortcuts on page 7 - 22

In 21CFR11 environments, members of the Analyst groupmust clickPreview on the
sample file window to access this screen.

Reports can be customized andmanipulated using the toolbar, shortcut menus, the zoom feature, or
axis cross-hairs.

n After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.
n The report zoom feature provides the viewing of fine graph details and the ability to shift the axes.
n All reports contain a header displaying file statistics.

A. Data display (graph or text)
B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

If configured, the report header can also contain a graphic and/or a title.

n Tabular and graphical reports contain sample and analyzer statistics such as analysis date/time,
analysis conditions, etc.

n The headers contain notes of sample file changes occurring after analysis.
n Summary report headers contain the same information as tabular and graphical reports with the

exception of notes.
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REPORT HEADER SHORTCUTS
Display header shortcuts by right clicking in the report header.

Field or Button Description
Copy header as text Use to copy the report header as text. Text is copied to the clipboard

and then can be pasted into other documents.
Edit Use to edit the report title and/or graphic in the report header.

Report Header Shortcuts

Report Features and Shortcuts
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7 About Reports

REPORT TOOLBAR
TheReportwindow has a toolbar on the right portion of the window and selectable tabs at the top of
the report header. To view a specific report, either select the tab or the report in theReports list box,
then clickShow.

A. Data display (graph or text)
B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

Field or Button Description
Default Style [button] Specify default report parameters for fonts and curve properties.

Delete [button] Deletes the selected report in theReports list box. Deleted reports will
have to be regenerated if deleted in error.

Hide [button] Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in theReports list box.

Print [button] Displays thePrintwindow for report output.

Reports [group box] Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hidden
using theHide button.

Show [button] Displays the selected or hidden report in theReports list box.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Report Toolbar
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TABULAR REPORT FEATURES AND SHORTCUTS
Display tabular report shortcuts by right clicking in the body of the tabular report. Column shortcuts
require right clicking on the column to bemodified.

Field or Button Description
Align column Select to change the column alignment to either left, right, or centered.

Copy table as text Use to copy the report contents to the clipboard as tab-delimited text. It
can then be pasted into another document.

Edit title Use to edit the report title and/or title font attributes. ClickFont to
modify font attributes.

Move column Right click the column to bemoved. SelectMove column on the short-
cut menu and select Left orRight for themove.

Rename column Right click the column to be renamed. SelectRename column on the
shortcut menu and enter the new column name.

Resize column Right click the column to be resized. SelectResize column on the short-
cut menu and enter the new columnwidth in inches.

Show column Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font Right click in the report data. Select Table data font on the shortcut
menu.

Table header font Right click in the report data. Select Table header font on the shortcut
menu.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Tabular Report Shortcuts

Report Features and Shortcuts
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GRAPH FEATURES AND SHORTCUTS
Right click in the graph area to display graph report shortcuts.

Field or Button Description
Autoscale all axes Returns the report to full view after using the zoom feature.

Copy data Copies the report data to the clipboard. It can then be pasted into other
software programs as tab-delimited columns or copied as an overlay
onto another graph.

Copy graph Copies the graph to the clipboard. It can then be pasted into other soft-
ware programs.

Edit axis Use to edit the selected axis properties.

Grid lines.Use to change how to displaymajor / minor grid lines.

Scale. [group box]

n Autoscale minimum/maximum. [check box] Tomanually specify
minimum / maximumautoscale, deselect the option and enter the

Graph Shortcuts
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Field or Button Description

new amount in the text box.
n Invert scale. [check box] Use to invert the scale.
n Linear/Logarithmic. [selection] Select the option to scale the

graph as linear or logarithmic.
n Scale font. [button] Use tomodify the font for the scale label.

DeselectUse default font to enable font options.

Title. [text box] Use to edit the selected axis label.

Title font. [button] Use tomodify the font for the selected axis label.
DeselectUse default font. Select new font attributes for report data.
EnableUse default font to reset default fonts.

Edit curve Use to edit selected curve properties.

Color. [button] Click to change the curve color.

Curve. [group box] Use to change the interpolation, point style, and
pen style for the selected curve. These options are disabled ifUse
default fill style is selected in theHistogram group box.

Histogram. [group box] Enabled only ifHistogram is selected in the
Style drop-down list. Use to specify the type of fill, fill color, and label
position for the selected curve.

Label. [drop-down box] Select where the graph point labels will
display (left, right, center, etc.) on the SPC report.

Graph Shortcuts (continued)

Graph Features and Shortcuts
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7 About Reports

Field or Button Description

Style. [drop-down box] Use to select another style for the collected
data curve.

Title. [text box] Use to change the title of the selected curve.

Use default thickness. [check box] Uses the default curve thickness.
Deselect to enter a new thickness number in the Thickness text box.

Edit legend Use to change the legend location and font.

Edit title Select to change the report title.

Enable overlays If overlays have been selected, this option displays (or hides) the over-
lays.

Include report When selected, places a checkmark to the left of the report in the
Select Reports list box on theReport Options tab.

Graph Shortcuts (continued)
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Field or Button Description
Reset axis limits to
initial setting

Removes the cross-hair and returns the graph back to the initial set-
ting.

Select overlays... Displays the option to select files to overlay onto the active graph. To
view the overlays, clickEnable Overlays on the shortcut menu.

Show curve Displays a list of all curves. Select the curve(s) to display.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Graph Shortcuts (continued)

AXIS CROSS-HAIR
Left click on the graph to view the cross-hair coordinates.

ZOOM FEATURE
Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A boxwill display in the area to be enlarged. To return to normal view,
right click in the graph and selectAutoscale all axes.

Graph Features and Shortcuts
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7 About Reports

GRAPH GRID LINES
Options > Graph Grid Lines

Use to select how grid lines appear on reports. Thismenu option is not available if usingRestricted
option presentation.

Field or Button Description
Grid Line Styles
[selection]

Select if themajor and/or minor grid lines should appear as solid or dot-
ted lines.

X-Axis / Y-Axis
[selection]

Select major and/or minor lines to display in reports for the logarithmic
and linear scales. Deselect this option to remove the grid lines.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Graph Grid Lines
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GRAPH AND SAMPLE OVERLAYS

In 21CFR11 environments, this feature is applicable tomembers of the Developer
group only.

Use the graph overlay functions to comparemultiple graph options. Graphical lines are differentiated
by the use of varying colored symbols outlined on a legend. Overlaysmay be generated in two ways:

n Multiple Graph Overlays.Overlay two different types of graphs from one sample.
n Multiple Sample Overlays.Overlay graphs of the same type with that of the current plot. This

type of overlay is available only for:

o BJH Adsorption / Desorption
o DFT Pore Size / Surface Energy
o Dollimore-Heal Adsorption / Desorption
o Horvath-Kawazoe
o M-P Method

This feature is available only when usingAdvanced option presentation. Go toOptions
> Option Presentation > Advanced.

Graph and Sample Overlays
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7 About Reports

GENERATE PORE SIZE DISTRIBUTION GRAPH OVERLAYS

The following reports in the physical adsorption applications can produce graphical results for a
samplematerial's pore size distribution:

See also:

n BJH Adsorption/Desorption Report Options on page 8 - 6
n DFT Pore Size Report Options on page 8 - 12
n Dollimore-Heal Adsorption/Desorption Report Options on page 8 - 15
n Horvath-Kawazoe Report Options on page 8 - 29

Twomethods can be used to import and overlay report data into another interactive graph using
shortcut menu options:

n Import ASCII text data.Data can be imported from an ASCII text file into the interactive graph.
The ASCII text file must follow certain rules.

n Copy/paste.Data can be copied from one sample file (source) and pasted into another sample
file (target).

Pore size distribution report overlaysmenu selections are:

n Copy data.Used to copy data sets.
n Paste data.Used to paste data sets.
n Edit Imported Data.Used to edit data sets.
n Display Imported Data.Used to hide or show the imported data.
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IMPORT ASCII TEXT DATA
ASCII text file format rules

n The header must consist of one line to include title, two unit specifications, and distribution type:

o Accepted pore dimension units are: A, nm, um
o Accepted pore volume units are: cm3/g, cm3/g, ml/g
o Accepted distribution types are: cumulative, incremental

Two examples of a header format:

My Title (A, cm3/g, incremental)
My Title (A, cm3/g, cumulative)

n The datamust be in two columns and should be separated by a comma or white-space.
n The data linesmust be ordered so that pore dimensions aremonotonically increasing or decreas-

ing.

Window appearance will vary depending on the selected report. This function can be performed on
samples files with aComplete status or during an analysis.

1. Create the ASCII text file using the proper format as indicated above.
2. In the analyzer application, go to File > Open. Select a sample file to overlay graphs on to.

ClickOpen (or double-click the file name).
3. Right click in the graph area and selectEdit imported data.

Generate Pore Size Distribution GraphOverlays
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7 About Reports

4. In theSelect Imported Overlayswindow, if the ASCII text file does not display, click Import to
locate the file. Select the ASCII text file in theSelect Imported Overlayswindow, then click
OK. If an error message will display instead, verify that the .TXT file format is in the correct
format.

5. To include the overlay data in a printed report, seePrint Pore Size Distribution Overlay
Data in Reports below.

OVERLAY PORE SIZE DISTRIBUTION DATA USING COPY/PASTE
1. Open a source sample file and a target sample file; both should have aComplete status. The

report will open to the interactive reports window.
2. In the source sample file, right click on the graph and selectShow Curve. Deselect any dif-

ferential curve data to hide them in the graph.
3. Right click in the graph area again and selectCopyData.
4. Change to the target sample file, right click the graph, and selectPaste data. The graph now

displays overlayed data from the source sample file.

Typically, one new graph will appear showing both the cumulative and differential curves. To
show or hide individual curves, right click the graph and select (or deselect)Display imported
data.

5. Ensure that all parameter fields are set appropriately, then clickPaste.
6. To include the overlay data in a printed report, seePrint Pore Size Distribution Overlay

Data in Reports below.

PRINT PORE SIZE DISTRIBUTION OVERLAY DATA IN REPORTS
1. Open the sample file containing the overlay data and selectAdvanced from the view selector

drop-down list at the bottom of the window.
2. Click theReport Options tab.
3. In theSelected Reports list box, select the cumulative, differential, or incremental intrusion

graph to show the imported distribution data, then clickEdit (or double-click the selected
report).

4. In theOverlay drop-down box, select Imported.
5. ClickOK to close the window.
6. ClickPreview on theReport Options tab. ClickPrint in the reports toolbar section to display

print options.
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OVERLAY MULTIPLE SAMPLE FILES

In 21CFR11 environments, this feature is applicable tomembers of the Developer
group only.

To overlay the same type of graph onmultiple samples:

1. Go to File > Open.
2. Select a .SMP file, then clickOpen. If the Isotherm plot displays, selectAdvanced from the

view selector drop-down list at the bottom of the window to display the tabbed window view.
3. Click theReport Options tab.
4. In theSelected Reports list box, highlight a report then clickEdit. Use the following table to

complete the process for the selected report.

OverlayMultiple Sample Files
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7 About Reports

If overlaying this type of
report...

Then...

n Isotherm

a. On the IsothermReport Optionswindow, select one or
more plots in theSelected Reports group box, then click
Options to the right of the selected plot.

b. On thePlot Optionswindow, selectPlot curve and/or Plot
points if they are to be included in the overlay. If the x-
and/or y-axes are to be autoscaled, enableAutoscale; oth-
erwise, enter the From and To points for the axes. Click
OK.

c. On the IsothermReport Optionswindow, in thePlot
Options group box, selectPlot overlays. ClickOK.

d. Continue to Step 5.

n Alpha-S Method
n BET Surface Area
n f-Ratio Method
n Freundlich
n Langmuir Surface Area
n t-plot
n Temkin

a. On the pop-up window, selectOverlay samples. Verify
other fields. ClickOK.

b. Continue to Step 5.

n BJH
n Dollimore-Heal
n MP-Method

a. Select the report variable from theSelected Reports group
box, then clickEdit.

b. Click the down arrow on theOverlay field, then select the
Samples option. Verify other fields. ClickOK.

c. ClickOK again.

5. On theReport Options tab, clickOverlays.
6. On thePlot Overlay Sample Selectionwindow, move up to 25 files from theAvailable Files

box to theSelected Files box:

7. ClickOK.
8. To view the report, clickPreview.

7 - 32 MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020



Field Description
Status [drop-down box] Select the status of files to be combined.

Look in [button] Click theBrowse icon to change the file folder location.

Available Files
[selection]

Lists files that meet the selected criteria. Select the files to be com-
bined, then clickAdd. The selected files aremoved to theSelected
Files list box.

Selected Files
[selection]

Lists the files selected to be combined. ClickOK to combine the files.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Overlay Sample Selection

OverlayMultiple Sample Files
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7 About Reports

IMPORT ASCII PORE DISTRIBUTION DATA

IMPORT AN ASCII TEXT FILE USING GRAPH SHORTCUTS

1. Create an ASCII text file. SeeManually Enter Data on page 3 - 7.
2. Open a report with aComplete status.
3. Select a pore-size distribution report from the view selector drop-down list at the bottom of the

window.
4. Right click on the graph and selectEdit imported data on the shortcut menu.

If the ASCII text file does not display on theSelected Imported Overlayswindow, click Import.
Locate and select the file, then clickOpen. Header information from the ASCII text file will
appear in theSelect Imported Overlayswindow. Select the entry, then clickOK. If an error
message appears, verify that the .TXT file format is correct.

5. To hide or show imported data, right click in the graph area and use theDisplay imported data
option on the shortcut menu.

COPY/PASTE AN ASCII TEXT FILE USING GRAPH SHORTCUTS

1. Create an ASCII text file. SeeManually Enter Data on page 3 - 7.
2. Copy the ASCII text data to the clipboard.
3. Open a report with aComplete status.
4. Select a pore-size distribution report from the view selector drop-down list at the bottom of the

window.
5. Right click on the graph and selectPaste data on the shortcut menu.
6. To hide or show imported data, right click in the graph area and use theDisplay imported data

option on the shortcut menu.

COPY/PASTE GRAPH DATA FROM ANOTHER GRAPH

1. Open a source pore distribution data report with aComplete status.
2. Right click on the graph and selectCopyData on the shortcut menu.
3. Open the target pore distribution data report.
4. Right click on the graph and selectPaste Data on the shortcut menu.
5. To hide or show imported data, right click in the graph area and use theDisplay imported data

option on the shortcut menu.
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REPORT EXAMPLES

BET REPORT

Report Examples
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7 About Reports

BET SURFACE AREA PLOT
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BJH ADSORPTIVE CUMULATIVE PORE VOLUME

BJH Adsorptive Cumulative Pore Volume
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BJH DESORPTION CUMULATIVE PORE VOLUME
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ISOTHERM LINEAR PLOT

Isotherm Linear Plot
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ISOTHERM LOG REPORT
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T-PLOT

t-Plot
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8 SELECTED REPORTS

In 21CFR11 environments, this feature is applicable tomembers of the Developer
group only.

To edit reports, open theSample file then select theReport Options tab. Highlight the
report name in theSelected Reports list box and clickEdit.

ADVANCED REPORT OPTIONS

See:

Advanced Reports - Python Module on page A - 1

8 Selected Reports

MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020 8 - 1



8 Selected Reports

ALPHA-S METHOD REPORT OPTIONS

TheAlpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm using the
quantity adsorbed at a relative pressure of 0.4.

One predefined curve is located in theReference file directory. Use the table buttons to enter relative
pressure and the Alpha-S values.

Field or Button Description
Open [button] Use to import values from an existing thickness curve (.ALS).

The table to be importedmust be saved as ASCII text with a .ALS file
extension. It must have a two-column format with the relative
pressures in the first column and the alpha-s values in the second
column. Columnsmust be separated by a space or a tab.

Alpha-S Method Reports
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Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Ref. surface area
[text box]

Enter the surface area from the reference curve. This value is used to
calculate the sample surface area.

Select Range
for Alpha-S Fit
[group box]

Enter minimumandmaximum relative pressures to determine the fit.

Selected Reports
[group box]

Alpha-S Plot.Use to plot data in graph format.
n Autoscale x-axis. The x-axis field shows the relative pressure.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples.Use to overlay sample files on the plot.
Tabular Report.Use to have a tabular report of data generated.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Alpha-S Method Reports (continued)

Alpha-S Method Report Options
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BET SURFACE AREA REPORT OPTIONS

The BET calculation obtains the sample surface area value by determining themonolayer volume of
adsorbed gas from the isotherm data. BET uses amultilayer model.

Field or Button Description
Pressures [button] This option is available when the sample file has a status of Analyzing

orComplete. Use to enter a range of pressure points to be included in
the report or to modify table values for pressure points.

Calculation pressure range.Enter theminimumandmaximum
pressures to be used in the pressure table if not using theUse
Interpolation option.

Exclude All. Select to exclude all pressure points in the table.

BET Reports
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Field or Button Description
Include All. Select to include all pressure points in the table.

Insert Predefined.Click to insert a predefined (default) set of points
into the report.Use Interpolationmust be selected to enable this
button. This button displays for BET reports only.

Use Interpolation.Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range
for BET fit [text box]

Enter values to indicate the fitted pressure range.

Selected Reports
[group box]

BET Isotherm plot.Uses BET monolayer volume and constant to
produce an isotherm.

n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the relative pressure for BET.

n Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

n Overlay samples.Use to overlay sample files on the BET isotherm
plot.

BET Transform plot.Use to generate a traditional BET surface area
plot used to determinemonolayer volume and BET C constant.

n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the relative pressure for BET.

n Autoscale y-axis. The y-axis field showsBET transformation.
n Overlay samples.Use to overlay sample files on the

BET transform plot.

Tabular report.Use to have a table of measured and calculated
values generated.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

BET Reports (continued)

BET Surface Area Report Options
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BJH ADSORPTION/DESORPTION REPORT OPTIONS

The BJH calculation determines themesopore volume/area distribution, which accounts for both the
change in adsorbate layer thickness and the liquid condensed in pore cores. Reports can be
generated from both adsorption and desorption data. The fields for bothBJH Adsorption Report
Options andBJH Desorption Report Options are identical unless otherwise specified.

An incomplete pore distributionmay be generated if a thickness curve selection is not a
goodmatch for the sample being analyzed.

Field or Button Description
Adsorptive [button] Displays theAdsorptive Optionswindow. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and adsorbate
property factor combinationsmay be specified.

BJH Adsorption/Desorption Reports
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Field or Button Description

BJH Correction
[group box]

Select the type of correction to apply to calculations. The selected type
will display in the report header.

Faas.Good for statistical thickness curves.

Kruk-Jaroniec-Sayari.Good for reference thickness curves.

Standard.Uses original BJH models.
Cumulative Reports
[group box]

Larger.Use to report the total volume found in pores larger than the
current pore size.

Smaller.Use to report the total volume found in pores smaller than the
current pore size.

Pores [group box] Enter theminimumandmaximumdiameter (radius or width) of pores
to include in the BJH reports.

Fraction of pores open at both ends. This field is not available for
theBJH Desorption Report Optionswindow.

During adsorption calculations, the analysis program assumes that all
pores are closed at one end. Occasionally, a percentage of poresmay
be open at both ends causing disagreement in the adsorption and
desorption data or in the values for total volume and total BJH pore
volume. Enter the fraction of pores open at both ends to compensate
for this error.

BJH Adsorption/Desorption Reports (continued)

BJH Adsorption/Desorption Report Options

MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020 8 - 7
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Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then clickEdit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations in
the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then clickEdit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA.Select the thickness curve option,
then clickEdit. Modify the equation for the selected curve as needed.

Reference.SelectReference, then clickEdit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
theReference directory.

BJH Adsorption/Desorption Reports (continued)

8 - 8 MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020



Field or Button Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
importedmust have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columnsmust be separated by
a space or a tab.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

BJH Adsorption/Desorption Reports (continued)

BJH Adsorption/Desorption Report Options
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BJH PLOT OPTIONS

The fields for all plot options are identical for specifying plottingmethods and customizing plots.
Highlight any plot option in theSelected Reports list box in theBJH Report Optionswindow, then
clickEdit.

Field or Button Description
Autoscale [check box] When enabled on the report parameters windows, allows the x- and

y- axes to be scaled automatically.Autoscalemeans that the x- and
y- rangeswill be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Plot curve / Plot points
[check box]

Select to plot points on the graph.

X-Axis [group box] Use to have the x-axis on a logarithmic or linear scale.

Y-Axis [group box] Overlay. Select an option to overlay onto the current report.

Variable.Select a variable.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

BJH Plot Reports
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BJH TABULAR REPORT OPTIONS

HighlightBJH Tabular Report in theSelected Reports list box on theBJH Adsorption Report
Optionswindow, then clickEdit to specify themethod of data reduction.

Field or Button Description
Collected points
[selection]

Use to include all relative pressure points collected. Refer to the
Columns button below.

Columns [button] Select the data types to include in the report.Column [n] indicates the
column order and data contents for the report.

Fixed pore size table
[selection]

Use to specify exact pore sizes for volume or area data. ClickTable to
modify the fixed pore size table. Refer to Table andColumns buttons
elsewhere in this table.

Table [button] The fixed pore size tablemust contain aminimumof two points. The
pointsmust be strictly decreasing. Enabled only when Fixed pore size
table is selected.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

BJH Tabular Reports

BJH Adsorption/Desorption Report Options
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DFT PORE SIZE REPORT OPTIONS

TheDFT Pore Size report contains the results of pore size distribution analyses using a non-local
DFT range of micro andmesopore ranges.

Field or Button Description
Geometry
[drop-down box]

Select the pore shape.

Model [drop-down box] Lists themodels that meet the specified criteria andmatch the
adsorbate and temperature of the sample data. If nomodels appear,
nomodelsmeet the selected criteria. Onemodel must be selected.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

DFT Pore Size Reports

8 - 12 MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020



Field or Button Description
Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user) is
selected, enter a number in the text box giving a relative weight for the
smoothing during deconvolution. Larger values producemore smooth-
ing.

Select Reports
[group box]

Select the reports to generate. To edit graph details, highlight the
graph option and clickEdit. The LogGoodness of Fit andGoodness of
Fit graphs cannot be edited.

Autoscale Options.Use to autoscale the x-axis and/or y-axes.

Axis Range. From/To fields are enabled whenAutoscale options are
not selected. Enter the starting and ending values for the x- and/or y-
axes.

n x-axis.Shows the pore size.
n y-axis.Shows the area.

Overlay.Select an overlay for the report.

Plot Type.Select themethod for data display.

DFT Pore Size Reports (continued)

DFT Pore Size Report Options
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Field or Button Description
Type [drop-down box] Classical.Model based on the Kelvin equation and thickness for

determining the pore size distribution. SeeDFT Models on page B -
1.

DFT.Model based on the density functional theory.
Version 2
deconvolution
[check box]

If enabled, adds improved performance for nonzero values of the DFT
regularization. The DFT results will be slightly better than when the
checkbox is not selected and when using a regularization parameter.
When the checkbox is not selected, the legacy behavior of the DFT
calculation used by earlier versions of the application is produced.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

DFT Pore Size Reports (continued)

DFT SURFACE ENERGY REPORT OPTIONS

See also:

DFT Pore Size Report Options on page 8 - 12

TheDFT Surface Energy report contains the results of surface energy distribution analyses.

DFT Surface EnergyReport Options fields and buttons are identical to theDFT Pore Size Report
Options.
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DOLLIMORE-HEAL ADSORPTION/DESORPTION REPORT OPTIONS

See also:

BJH Adsorption/Desorption Report Options on page 8 - 6 for additional
information on field and buttons for this report.

TheDollimore-Heal Adsorption Report Option and theDollimore-Heal Desorption Report Option
generate reports from both adsorption and desorption data.

Field or Button Description
Adsorptive [button] Displays theAdsorptive Optionswindow. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and adsorbate
property factor combinationsmay be specified.

Dollimore-Heal Adsorption/Desorption Reports

Dollimore-Heal Adsorption/Desorption Report Options
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8 Selected Reports

Field or Button Description
Cumulative Reports
[group box]

Larger.Use to report the total volume found in pores larger than the
current pore size.

Smaller.Use to report the total volume found in pores smaller than the
current pore size.

Pores [group box] Enter theminimumandmaximumdiameter (radius or width) of pores
to include in the BJH reports.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then clickEdit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations in
the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then clickEdit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA.Select the thickness curve option,
then clickEdit. Modify the equation for the selected curve as needed.

Reference.SelectReference, then clickEdit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
theReference directory.

Dollimore-Heal Adsorption/Desorption Reports (continued)
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Field or Button Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
importedmust have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columnsmust be separated by
a space or a tab.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Dollimore-Heal Adsorption/Desorption Reports (continued)

Dollimore-Heal Adsorption/Desorption Report Options
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8 Selected Reports

DOLLIMORE-HEAL PLOT OPTIONS

See also:

BJH Plot Options on page 8 - 10

The fields for all plot options are identical for specifying plottingmethods and customizing plots.
Highlight any plot option in theSelected Reports list box in theDollimore-Heal Report Options
window, then clickEdit. The fields and buttons for these reports are identical to theBJH Plot Report
Options.
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DOLLIMORE-HEAL TABULAR REPORT OPTIONS

See also:

BJH Tabular Report Options on page 8 - 11

Dollimore-Heal Tabular Report Options are identical to theBJH Tabular Report Options.

Dollimore-Heal Adsorption/Desorption Report Options
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8 Selected Reports

DUBININ REPORT OPTIONS

TheDubininmethod provides pore volume distributions for microporousmaterials bymaking use of
an expression for the adsorption potential.

Field or Button Description
Adsorptive [button] Displays theAdsorptive Optionswindow. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and adsorbate
property factor combinationsmay be specified.

Fitted Relative
Pressure Range
[group box]

Enter theminimumandmaximum limits for Radushkevich or Astakhov
relative pressures included in the line fit.

Dubinin Reports
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Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Report Type
[group box]

Select report types. If Astakhov is selected, either selectOptimize expo-
nent or enter an appropriate exponent value in the text box.

Select Reports
[group box]

Select the reports to generate. Highlight the report, then clickEdit to
modify report options.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Dubinin Reports (continued)

Dubinin Report Options
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8 Selected Reports

DUBININ PORE VOLUME REPORT OPTIONS

In theDubinin Report Optionswindow, highlight dV/dw Pore Volume in theSelected Reports list
box, then clickEdit.

This option plots differential pore volume as a function of pore width.

Field or Button Description
Autoscale x-axis /
Autoscale y-axis
[check box]

Select an option to have the x- and/or y-axes scaled automatically.
Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Enable to enter beginning and ending valuesmanually.
Overlay samples
[selection]

Use to overlay sample files on the plot.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Dubinin Pore Volume Reports
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DUBININ TABULAR REPORT OPTIONS

In theDubinin Report Optionswindow, highlightDubinin Tabular Report in theSelected Reports list
box, then clickEdit.Column [n] indicates the column order and data contents for the report.

Log (po/p )^n. The value for [n] is the optimized exponent ifOptimize exponent is selected on the
Dubinin Report Optionswindow. If not, then the value for [n] is the entered exponent value.

Dubinin Report Options

MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020 8 - 23



8 Selected Reports

DUBININ TRANSFORMED ISOTHERM PLOT OPTIONS

Highlight Transformed Isotherm in theSelected Reports list box in theDubinin Report Options
window, then clickEdit.

The transformedDubinin isotherm is the logarithm of quantity adsorbed as a function of the log of
relative pressure raised to a power. Isotherms for which the Dubinin method is applicable produce
straight lineswhen transformed in this way.

Field or Button Description
Autoscale x-axis /
Autoscale y-axis
[check box]

Select an option to have the x- and/or y-axes scaled automatically.
Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Deselect to enter beginning and ending valuesmanually.

Autoscale x-axis.Shows the quantity of gas adsorbed at standard
temperature and pressure.

Autoscale y-axis.Shows the log of relative pressure.
Overlay samples
[check box]

Use to overlay sample files on the plot.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Dubinin Transformed Isotherm Plot Reports
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F-RATIO METHOD REPORT OPTIONS

The f-Ratio report uses themeasured isotherm and normalizes it using a reference isotherm.

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

f-Ratio Reports

f-Ratio Method Report Options
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8 Selected Reports

Field or Button Description
Reference isotherm
[group box]

Browse to select a sample file to use as a reference for the isotherm.
Select a file containing an isothermmeasured from a non-porous
sample of the samematerial as the current sample.

Selected Reports
[group box]

Tabular Report.Use to have a tabular report of data generated.

f-Plot.Use to generate a normalized isotherm.

n Autoscale x-axis. The x-axis field is dimensionless in units of f-
ratio.

n Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

n Overlay samples.Use to overlay sample files on the f-plot.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

f-Ratio Reports (continued)
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FREUNDLICH REPORT OPTIONS

The Freundlich Isotherm is an empirical isotherm used tomodel low pressure adsorption data. It can
also be applied tomodel somemicropore isotherms. In theSelected Reports list box, highlight
Freundlich, then clickEdit.

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Freundlich Reports

Freundlich Report Options
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8 Selected Reports

Field or Button Description
Select Reports
[group box]

Freundlich Isotherm plot.Plots the absolute pressure vs quantity
adsorbed. Shows best fit line.

n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure.

n Autoscale y-axis. y-axes begin at zero. The y-axis field shows the
quantity of gas adsorbed.

n Overlay samples.Use to overlay sample files on the Freundlich iso-
therm plot.

Freundlich Transform plot.Plots the log(P) vs log(Q) and the best
fit.

n Autoscale x-axis. The x-axis field shows the absolute pressure.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples.Use to overlay sample files on the Freundlich

transform plot.

Tabular report.Select to include pressure points included in the
report.

Specify monolayer
capacity [selection]

Select and enter themonolayer capacity of the sample.

Tabular report
[selection]

Use to have a report of the pressure points generated.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Freundlich Reports (continued)
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HORVATH-KAWAZOE REPORT OPTIONS

TheHorvath-Kawazoemethod plots individual peaks for different pore sizes even if the difference
between one pore size and the next is only one angstrom (0.10 nm) or less.

Field or Button Description
Apply Cheng-Yang
correction [selection]

Use to apply the Cheng-Yang correction to the pore size analysis. This
correction substitutes the Langmuir equation of state for Henry’s Law
in the Horvath-Kawazoe derivation.

Interaction Parameter
[group box]

Use to determine which interaction parameter will be used in the
report. These options are disabled if Sphere is selected in thePore
Geometry group box.

Computed.Use to calculate using the parameters on theHorvath-
Kawazoe Physical Propertieswindow (clickProperties to display the
Physical Propertieswindow). The interaction parameter is
recalculated each time a parameter in thePhysical Propertieswindow
is edited.

Entered.Calculates using the value entered in the text box.
Pore Geometry
[group box]

Select the option that best represents the physical geometry of the
micropores in the samplematerial. WhenSphere is selected, options
in the Interaction Parameter group box are disabled.

Horvath-Kawazoe Reports

Horvath-Kawazoe Report Options
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8 Selected Reports

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Properties [button] Click to view or edit the constants describing the physical properties of

the adsorbent and adsorptive.

Adsorbent. Contains the parameters for the sample. If using
Computed for the interaction parameter, all fields are enabled. If using
Entered, only the values in theDiameter andDiameter at zero energy
text fieldsmay be edited.

n Density.Enter the density per unit area of the sample. *
n Description.Select the name of the sample used in the analysis.
n Diameter.Enter the diameter of the sample atom.
n Diameter at zero energy.Enter the diameter of an atom at zero

interaction energy: (2/5)1/6 × diameter.
n Magnetic susceptibility.Enter themagnetic susceptibility of the

sample. *
n Polarizability.Enter the polarizability of the sample. *
Adsorptive.Contains the parameters for the adsorptives. If using
Computed for the interaction parameter, all fields are enabled. If using
Entered, only the values in theDiameter andDiameter at zero energy
text fieldsmay be edited.

n Density.Enter the density per unit area of the adsorptive. *
n Diameter.Enter the diameter of the gas phase atom.

Horvath-Kawazoe Reports (continued)
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Field or Button Description

n Diameter at zero energy.Enter the diameter of an atom at zero
interaction energy: (2/5)1/6 × diameter.

n Magnetic susceptibility.Enter themagnetic susceptibility of the
adsorptive. *

n Mnemonic. Select themnemonic of the adsorptive gas in use.
n Polarizability.Enter the polarizability of the adsorptive. *

* Option is disabled if Entered is selected in the Interactions
Parameter group box.

Select Reports
[group box]

Select the types of reports to generate. Highlight the report, then click
Edit to modify report parameters.

Smooth differentials
[selection]

Use to smooth all differential calculations, thus eliminating variations in
the differential computation caused by noise in the input data.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Horvath-Kawazoe Reports (continued)

Horvath-Kawazoe Report Options

MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020 8 - 31



8 Selected Reports

HORVATH-KAWAZOE PLOT OPTIONS

See also:

BJH Plot Options on page 8 - 10 for additional information on fields and buttons for
this report.

Highlight a plot option in theSelected Reports list box in theHorvath-Kawazoe Report Options
window, then clickEdit to customize the plottingmethod.

HORVATH-KAWAZOE TABULAR REPORT OPTIONS

HighlightH-K Tabular Report in theSelected Reports list box in theHorvath-Kawazoe Report
Optionswindow, then clickEdit. Select the data types to include in the report.Column [n] indicates
the column order and data contents for the report.
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ISOTHERM REPORT OPTIONS

The Isotherm report indicates adsorption (up to saturation pressure) and desorption (down from
saturation pressure) of a gas by a solid held at constant temperature.

Field or Button Description
Options [button]  Click to display related linear plot options. All plot windows contain

identical fields.

Autoscale x-axis. Linear x-axes begin at zero. Logarithmic x-axes
begin at an appropriate value. The x-axis field shows the relative or
absolute pressure.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Plot curve / Plot points.Select to plot points on the graph.
Plot Options [group box] Select the types of isotherm to plot.

Quantity Adsorbed
[group box]

Select how to report the quantity adsorbed.

n per gram (cm3/g) STP
n per BET Surface Area (cm3/m2) STP or mmol/g
n per other Surface Area (cm3/m2) STP or mmol/m2

Isotherm Reports

IsothermReport Options
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8 Selected Reports

Field or Button Description
Selected Reports
[group box]

Select each option to include on the final report. Click the Options
button of a selected item to include plot curve, plot points, and to
autoscale x- and y-axes.

Tabular Options
[group box]

Select the options to include on the report.

Elapsed time. Time elapsed during the analysis.

Time between points. Time elapsed between points during the
analysis.

Weight %. Enter themass percentage when plotting pressure
composition.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Isotherm Reports (continued)
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LANGMUIR REPORT OPTIONS

The Langmuir calculation determines the surface area of a sample by relating the surface area to the
volume of gas adsorbed as amonolayer. Langmuir uses a single layer model.

Field or Button Description
Pressures [button] This option is available when the sample file has a status of Analyzing

orComplete. Use to enter a range of pressure points to be included in
the report or to modify table values for pressure points.

Calculation pressure range.Enter theminimumandmaximum
pressures to be used in the pressure table. To exclude a point from the
calculations used to generate the report, selectExclude.

Langmuir Reports

Langmuir Report Options
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8 Selected Reports

Field or Button Description
Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Use Interpolation.Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range
for Langmuir fit
[group box]

Enter values to indicate the fitted pressure range.

Select Reports
[group box]

Langmuir Isotherm Plot.Uses the Langmuir monolayer volume and
constant to produce an isotherm.

n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure for Langmuir.

n Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

n Overlay samples.Use to overlay sample files on the Langmuir iso-
therm plot.

Langmuir Transform Plot.Use to generate a traditional Langmuir
surface area plot used to determinemonolayer volume constant.

n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure for Langmuir.

n Autoscale y-axis. The y-axis field shows Langmuir transformation.
n Overlay samples.Use to overlay sample files on the Langmuir

transform plot.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Langmuir Reports (continued)
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MP-METHOD REPORT OPTIONS

TheMP-Method Report Options provides pore volume distributions for microporousmaterials by
correlating quantity adsorbed with the thickness of the adsorbed layer as determined from a user-
selected thickness curve. Pore size can be expressed in angstroms or nanometers. Go to Options
> Units to specify the unit.

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

MP-Method Reports

MP-Method Report Options
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8 Selected Reports

Field or Button Description
Select Reports
[group box]

Select the reports to generate. Highlight the report, then clickEdit to
modify report options.

Thickness Curve
[group box]

Select the thickness curve, then clickEdit to modify the values in the
equation for the selected curve.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

MP-Method Reports (continued)
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MP-METHOD PLOT REPORT OPTIONS

In theMP-Method Report Optionswindow, highlight a plot option in theSelected Reports list box,
then clickEdit to customize the plottingmethod.

Field or Button Description
Overlay [drop-down box] Select an option to overlay on the current report.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

Thickness Curve
[group box]

Select the thickness curve, then clickEdit to modify the values in the
equation for the selected curve.

X-Axis [check box] Use to have the x-axis autoscaled or enter beginning and ending
values.

Y-Axis [group box] Autoscale.Use to have the y-axis autoscaled or enter beginning and
ending values.

Overlay.Select an option to overlay on the current report.

Variable.Select a variable.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

MP Method Plot Reports

MP-Method Report Options
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MP-METHOD TABULAR REPORT OPTIONS

In theMP-Method Report Optionswindow, highlightMP Tabular Report in theSelected Reports list
box, then clickEdit.Column [n] indicates the column order and data contents for the report.

TheMPMethod reports hydraulic radius only. If Pore size in diameter is selected on the
Unit Selection window, pore size in radius will be reported.
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NLDFT ADVANCED PSD REPORT

TheNLDFT Advanced PSD report allows for more advanced computation of the pore size
distribution of amaterial using two separate analyses and two non-local DFTmodels.

TheNLDFT Advanced PSD report option provides the same calculations as the DFT Pore Size
report option andmore. The NLDFT report compares two sample files. Themodels that can be
selected are restricted to only thosemodels which have the same analysis temperature and analysis
gas as the sample file that is open. For instance, if the sample file was analyzed with N2 at
77 degrees Kelvin, then only the N2DFTmodels at 77 degrees Kelvin will be available in theModel
drop-down list.

Themodel curve fit is shown in the lower right quadrant along with the adsorption isotherm. This
curve fit is updated each time the calculation parameters change (selection of isotherm data points,
choice of model, choice of regularization parameter).

A second sample file and secondmodel is used to compute amore accurate pore size distribution
(PSD), which is shown in the upper left quadrant. Typically, the second sample file will have used the
same samplematerial as the first sample file yet will have used a different analysis gas and
temperature.

In general, the isotherm for this second sample will be different than the first sample. The advanced
DFT calculation takes the data from both sample files and combines all this data into amore accurate
calculation of the pore size distribution. More accuratemeans getting the pore distribution at smaller
pore sizes (a few Angstroms) aswell as larger pore sizes (one thousand Angstroms).

NLDFT Advanced PSD Report
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8 Selected Reports

Tomake a successfulAdvanced calculation, a second sample file must be selected
using theSelect button. A secondmodel must also be selected. Use the options next to
the two sample file names to select the isotherm data points for each sample. After
selecting an option, the blue bars in the isotherm graph will be toggled to select either
the red points or the green points. Once these selections have been done, the results
will appear in the left-hand plots and a second isothermwill appear in the isotherm plot
(lower right) as well as a second curve-fit. As the selection of points is adjusted, the DFT
editor will recalculate the PSD results and also recalculate the twomodel curve fits.

Field or Button Description
Geometry
[drop-down box]

Select the pore shape.

Model [drop-down box] Lists themodels that meet the specified criteria andmatch the
adsorbate and temperature of the sample data. If nomodels appear,
nomodelsmeet the selected criteria. Onemodel must be selected.

Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user) is
selected, enter a number in the text box giving a relativemass for the
smoothing during deconvolution. Larger values producemore
smoothing.

Select Reports
[group box]

Use to select the second sample file.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

NLDFT Advanced PSD Reports
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To run the NLDFT report:

1. Go to File > Open. Select a sample file with aComplete status, then clickOpen.
2. In the view selector drop-down list at the bottom of the window, selectNLDFT Advanced

PSD. Graphs for the first sample file display and the sample description shows as the first
group box title in the upper right corner of the window.

a. Select theGeometry andModel from the drop-down lists for the first sample file.
b. To select isotherm data points for calculation for the first sample file, ensure the option to

the left of the first sample file description is selected. Slide the two blue bars on the iso-
therm graph to select data points. Without a second sample selected, the report will per-
form a singlemodel DFT calculation and show the results in the two left-hand result
windows.

3. To calculate data from the second sample file, clickSelect to locate and open the second
sample file with aComplete status. Graphs for the second sample file display and the sample
description will display as the second group box title in the upper right corner of the window.
a. Select theGeometry andModel from the drop-down lists for the second sample file.
b. To select isotherm data points for calculation for the second sample file, ensure the option

to the left of the second sample file description is selected. Slide the two blue bars on the
isotherm graph to select data points. Data are automatically calculated for both sample
files.

c. ClickEdit to make any necessarymodifications to the second sample file.

NLDFT Advanced PSD Report
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OPTIONS REPORT

Lists the conditions used to perform the analysis— such as:

n Adsorptive properties
n Analysis conditions
n Analysismethod
n Degas conditions
n Free space
n Saturation pressure (P0) and temperature

Options reports cannot be edited.
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SAMPLE AUDIT TRAIL REPORT

For 21CFR11 environments only.

This report lists all changes and comments that have been applied to sample files with aComplete
status.

SAMPLE LOG REPORT

Not applicable to 21CFR11 environments. SeeSample Audit Trail Report above.

Sample Log reports cannot be edited.

Inserts a log of sample operations in the reports.

This report provides information on:

n Manual control operations performed during analysis.
n Information entered usingAdd Log Entry on the sample file editor.
n Warnings and/or errors which occurred during analysis.

Sample Audit Trail Report
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SUMMARY REPORT

TheSummaryReport for physical adsorption analyses provides a condensed summary of selected
data results.

In thePore Volume group box, if Adsorption total orDesorption total is selected, the p/po field is
enabled. Enter the relative pressure used to calculate the total pore volume.

Field or Button Description
Item [n] [selection] Use to enable the first Pass/Fail item. Until theSummaryReport is

selected,S A Single-point BETwill be displayed by default. When
selected, clickPass/Fail, then select pass/fail criteria options.

Pass/Fail [n].Click to display thePass/Fail Optionswindow for
selection of pass/fail criteria.

S A: Single-point BET.Use to enablePass/Fail [n] in the Item [n]
group box.

Summary Report
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Field or Button Description
Upper/Lower.Specify upper and lower limits for the selected
parameter. A range can be left open by not selecting the limit. In the
text box to the right ofUpper / Lower, enter operator instructions to be
displayed if a failure is encountered.

Select All / Deselect All
[button]

Selects (or deselects) all options.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Summary Report (continued)

SummaryReport
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8 Selected Reports

T-PLOT REPORT OPTIONS

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to
micropores. Matrix area (the area external to micropores) is directly determined and often proves to
be a valuable way of characterizing complexmixedmaterials.

Field or Button Description
Fitted thickness range
[text box]

Enter theminimumandmaximum thicknesses (in angstroms or nano-
meters) to include in the thickness curve. Go toOptions > Units to
specify default units.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

t-Plot Reports
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Field or Button Description
Selected Reports
[group box]

Tabular Report.Use to have a tabular report of data generated.

t-Plot.Use to have a graphical representation of data generated.
n Autoscale x-axis. The x-axis field shows the statistical thickness of

the adsorbed film.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples.Use to overlay sample files on the t-plot.

Surface area correction
factor [text box]

Enter the value to correct for surface areas that are not smooth. This
brings the values for BET surface area andmicropore surface area
into accordance. For most samples, the default value of 1.000 is
adequate.

Surface Area
[group box]

Select the surface area value used for thickness calculations. BET is
themost commonly used option.

Thickness Curve
[group box]

Select the thickness curve, then clickEdit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA.Select the thickness curve option,
then clickEdit. Modify the equation for the selected curve as needed.

Reference.SelectReference, then clickEdit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
theReference directory.

t-Plot Reports (continued)

t-Plot Report Options
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8 Selected Reports

Field or Button Description
To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
importedmust have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columnsmust be separated by
a space or a tab.

t-Plot [check box] Use to have a graphical representation of data generated.

Autoscale x-axis. The x-axis field shows the statistical thickness of
the adsorbed film.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Overlay samples.Use to overlay sample files on the t-plot.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

t-Plot Reports (continued)
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TEMKIN REPORT OPTIONS

The Temkin isotherm is used tomodel adsorption data where the heat of adsorption drops linearly
with increasing coverage.

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Temkin Reports

Temkin Report Options
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8 Selected Reports

Field or Button Description
Select Reports
[group box]

Tabular Report. Generates a tabular report of the included samples.
A tabular report contains the numeric values contributed by each
sample.

Temkin Isotherm plot. Overlays the Temkin isothermwith the
analysis data.

n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure.

n Autoscale y-axis. y-axes begin at zero. The y-axis field shows the
quantity of gas adsorbed.

n Overlay samples.Use to overlay sample files on the isotherm plot.

Temkin Transform plot. Plots a linear form of the Temkin transform
plot.

n Autoscale x-axis. The x-axis field shows the logarithm of pressure
(ln).

n Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

n Overlay samples.Use to overlay sample files on the transform
plot.

Specify differential heat
of adsorption
[check box]

Select and enter the differential heat of adsorption at zero surface cov-
erage. This allows inclusion of all Temkin constants.

Specify monolayer
capacity [check box]

Select and enter themonolayer capacity of the sample.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Temkin Reports (continued)
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VALIDATION REPORT OPTIONS

This report allows data to be examined by the analysis program to determine if the results are within
typical ranges. If the data for any reports selected for validation are determined to be out of range, a
warning will display and suggestions are given for corrective action.

Validation Report Options
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9 DIAGNOSTICS
Unit [n] > Diagnostics
Use to display diagnostic readings, start diagnostic tests, and open saved diagnostic reports. Each
test generates a file to the default directory name and path of ...\...\Service\userdiag unless another
directory namewas specified. These reports can be sent to aMicromeritics Service Representative
for examination.

SHOW ALL READINGS
Unit [n] > Diagnostics > Show All Readings
TheShow All Readingswindow displays the calibrated readings of all sensors in the system.

START DIAGNOSTIC TEST
Unit [n] > Diagnostics > Start Diagnostic Test
Use to clean and verify gas lineswhen connecting or changing a gas. SeeClean and Verify the
Gas Line on page 11 - 8 for detailed instructions. Also used to perform diagnostic tests requested
by aMicromeritics Service Representative.

This option is typically used and /or requested by a Service Representative. These tests create and
save files to the ...\...\Service\userdiag directory. TheMicromeritics Service Representativemay
request an emailed or faxed copy of the file for diagnostic purposes.

9 Diagnostics
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9 Diagnostics

Field or Button Description
Comments [text box] Displays comments from the selected diagnostic test.

Estimated time (min.) Approximate time for test completion.

File [group box] Shows a status bar of steps complete once the test begins.

Next [button] Starts the next test.

Operator [text box] Enter information to identify the person running the service test.

Repeat [button] Repeats the selected diagnostic test.

Report after test
[check box]

Automatically generates reports to the selected destination when the
test is complete.

Sequence Sequence number assigned to the test.

Start [button] Starts the diagnostic test.

Test [drop-down box] Select the diagnostic test to be performed.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Start Diagnostic Test
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10 CALIBRATION
Unit [n] > Calibration

Service Test Mode is required for this test. SeeService Test Mode on page 11 - 20.

A calibration file was created specifically for the analyzer and included with the accessories. It is not
necessary to recalibrate the system unless it seems out of calibration.

Disabled calibrationmenu options can be accessed only with the assistance of an authorized
Micromeritics Service Representative. Calibrations can be saved to a file and reloaded later.

To review calibration details of the analyzer, go toUnit [n] > Unit Configuration.

Generally it will not be necessary to change the data in the calibration file. However, if a condition
occurs during the operational verification that requires changes to the calibration data, changes
should be saved in a file. Calibration data files are retained in the analyzer history file and can be
reloaded in the event that calibration data becomes corrupt.

10 Calibration
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10 Calibration

MATCH TRANSDUCERS
Unit [n] > Calibration > Match Transducers
Use to evacuate the system and zero the pressure transducers, then adjust the scale tomatch them
to themanifold transducer near full scale pressure.

A blank sample tube or small plugmust be installed on each selected port prior to start-
ing this process.

1. Install a blank sample tube or small plug on each applicable port.
2. Ensure that all applicable transducers are selected, then clickStart. The window closeswhen

the operation is complete. ClickOK when the process is complete.
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PRESSURE OFFSET

Unit [n] > Calibration > Pressure Offset
This procedure evacuates the system and zeroes the pressure transducers. This calibration should
only be performed by qualified service personnel. In order to perform this procedure, sample tubes
must be attached to each port.

1. Install a blank sample tube or small plug on each applicable port.
2. Ensure that all applicable transducers are selected, then clickStart. ClickOK when the pro-

cess is complete.

The current pressure readings and operation statusmessages display. When the calibration is
complete, a confirmationmessage is displayed with the event logmessage for the pressure
transducer offset calibration. ClickOK.

Pressure Offset
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10 Calibration

SERVO VALVE
Unit [n] > Calibration > Servo Valve
Use to calibrate the servo valve to themanifold pressure transducer. The servo valve should always
be recalibrated after a pressure calibration has been performed. The pressure transducer should be
calibrated before starting this calibration procedure.

Ensure the pressure transducer has been calibrated before performing this procedure.
Go toUnit [n] > Unit Configuration and view the calibration information. Contact your
Micromeritics Service Representative if calibration dates are not listed.

ClickStart. The window closeswhen the calibration is complete. ClickCancel to stop the calibration
process.

SAVE CALIBRATION TO FILE
Unit [n] > Calibration > Save to File
Use to save the current calibration settings to a backup file which can later be reloaded using the
Unit [n] > Calibration > Load from Filemenu option.

The default file naming convention for calibration files can be used or the file name can be changed.
The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 is the analyzer serial number
2013-04-25 is the date the calibration file was saved
.CAL is the file name extension
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LOAD CALIBRATION FROM FILE
Unit [n] > Calibration > Load from File
Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved usingUnit [n] > Calibration >
Save to File prior to loading another calibration file. When loading a previously saved calibration file,
a backup of the current file is created and saved as [SN]last.cal. The backup file is overwritten each
time a new one is created.

Changing the calibrationmay affect the analyzer’s performance.

Load Calibration from File
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11 TROUBLESHOOTING AND MAINTENANCE

Do not modify this instrument without the authorization of aMicromeritics service per-
sonnel.

Improper handling, disposing of, or transporting potentially hazardousmaterials can
cause serious bodily harm or damage the instrument. Always refer to theMSDS when
handling hazardousmaterials.

When lifting or relocating the instrument, use proper lifting and transporting devices for
heavy instruments. Ensure that sufficient personnel are available to assist in moving the
instrument. The TriStar weighs approximately 82 lbs (37 kg).

Use of a power cord or power supply not provided with the instrument could cause
personal injury or damage to the equipment. If a replacement is needed, contact your
Micromeritics Service Representative. Detachable power supply cordswith an
inadequate rating could cause significant instrument damage or physical harm.

Do not add anything between the power cord and the power source that would
compromise the earth ground.

Do not remove or disable the grounding prong on the instrument power cord.

The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time.When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided:

Log in to your customer portal to access error messages. Parts and accessories can be found online
at www.Micromeritics.com.

Most operational problems are caused by:

n Leaks (commonly found at the sample tubeO-ring at the analysis port)
n Sample weighing errors
n Use of toomuch analysis bath fluid in the Dewar at the start of an analysis
n Entry of incorrect system volume for analysis
n Impure gas supply

When unexpected analysis results occur, check the above first. Some common operational
problems not indicated on the window and their respective causes and solutions are provided below:

11 Troubleshooting andMaintenance
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11 Troubleshooting andMaintenance

Elevator cannot be raised or lowered.

Cause: Dewar elevator stuck.

Action: Check for possible obstruction to elevator movement.

Elevator is noisy.

Cause: The elevator screw may need greasing.

Action: Contact your Micromeritics Service Representative.

Sample is not within specifications.

Cause A: Theremay be amanifold leak.

Action A: Run amanifold leak test. SeeDiagnostics on page 9 - 1.
Cause B: Gasmay be contaminated.

Action B:
n Perform a blank analysis. If results are good, perform a referencematerial

analysis.
n Replace tank.
n Check for line leak, which could cause contamination.
n Flush the lines occasionally to help prevent contamination.

Cause C: Incorrect type of gas line.

Action C: Ensure the gas line is all metal. It is best to use the one shipped with the ana-
lyzer. Do not use polymer gas lines or flexible gas lines that may be coated
internally with a polymer.

Valves cannot be operated.

Cause: Cable from computer to the instrument is loose.

Action: Reconnect the cable.

Vacuum pump is noisy.

Cause A: Sample tube connector is loose.

Action A: Tighten fitting. ReplaceO-ring.

Cause B: Sample tubeO-ring is worn or cracked.

Action B: ReplaceO-ring. SeeReplace the Sample Tube O-ring on page 11 - 18.
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Cause C: Sample tube is cracked.

Action C: Replace with new sample tube.

Cause D: No sample tube loaded on a selected port.

Action D: Install plug or empty sample tube.

Cause E: Gas inlet valve open while vacuum valve open.

Action E: Withmanual control enabled, use the instrument schematic to close gas inlet
valve.

POWER

The TriStar II Plus is designed to operate with universal input power supply (100-240V~, 50/60Hz,
150VA). Noise-free power of the correct voltage and frequency, with a safety earth ground, should
be available through a standard wall receptacle. The power outlet should be able to supply
15 amps@ 100 or 115 VAC ± 10% or 7.5 amps@ 230 VAC ± 10%. These requirements can be
checked by using a circuit analyzer (available at most hardware or electronic supply houses) or a
multimeter. There should also be sufficient outlets for the computer, dry roughing pump, monitor,
printer, and any other peripheral devices.

The power cord, IEC, 300V, 10A (available in the accessories kit) should be connected to noise free
power of the correct voltage and frequency, with a safety earth ground, through a standard wall
receptacle.

The analyzer and peripheral devicesmust be installed on their own dedicated power
line. Other devices— such asmotors, generators, or ovens— should not be placed on
the same power line.

Replacement power supply cordsmust be rated for the specifications stated above.

PARTS REPLACEMENT

n To ensure proper form, fit, and function, consumablesmay be purchased fromMicromeritics.
n Repair parts are proprietary andmust be obtained fromMicromeritics.

Power
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11 Troubleshooting andMaintenance

GUIDELINES FOR CONNECTING GASES

n Place gas cylinders within 6 feet (2m) of the gas inlets of the analyzer. Using gas line extenders
on gas cylinders located in remote areasmay degrade gas quality and reduce pressure. Gas lines
are typically five to six feet long. Place the cylinders close enough to allow for proper connection at
the analyzer inlet.

n Use a retaining strap (or other appropriate tether) to secure the gas cylinder.
n Always use the gas lines provided with the analyzer. It is very important that proper gas lines are

used with the analyzer.

o Do not use polymer tubing for the gas line.
o Do not use flexible gas lines. Some flexible linesmay appear to be appropriate, such as those
with a herringbone covering, but the linemay be coated internally with a polymer.

n Long gas lines, such as those used with gas cylinders placed in remote areas, must be evacuated
for an extended period of time to remove ambient gases.When possible, avoid placing gas cyl-
inders in remote locations. It is always best to have gas cylinders located near the analyzer.

n Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or entangling
gas lines. This will help avoid confusion whenmaintenance is required.

n Label the gas line at the analyzer inlet for proper identification andmaintenance.
n Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pres-

sure reads approximately 500 psi (3500 kPa) on the high pressure gauge. Contaminants
absorbed to the walls of the cylinder will desorb as the pressure decreases.

n Ensure the gas cylinder is closed before connecting to the analyzer.

11 - 4 MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020



REPLACE A GAS CYLINDER

These instructions apply to working with inert gases only. Whenworking with hazardous
gases, follow the safety procedures established by your lab.

A power failure or loss of cryogen can result in dangerous pressures in the sample
chamber. When using toxic or flammable gases, additional venting of the cabinet may
be required.

A. Gas tubing to instrument
B. Gas regulator shut-off valve
C. Low pressure gauge
D. High pressure gauge
E. Gas cylinder shut-off valve
F. Regulator connecter nut
G. Regulator control knob
H. Brass reducer fitting

Disconnect a Depleted Gas Cylinder

1. Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clock-
wise.

2. Disconnect the gas line from the regulator. Gaswill be vented from the line. It is not necessary
to disconnect the gas line from the analyzer inlet if the cylinder will be replaced immediately
with one of the same type.

3. Open the gas regulator shut-off valve by turning the knob counter-clockwise. Gaswill be ven-
ted from the regulator.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges
should read at or near zero. If not, make sure the gas regulator shut-off valve is open.

5. Close the regulator by turning the control knob counter-clockwise.
6. Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the

regulator from the cylinder.
7. Replace the protective cap on the depleted cylinder. Disconnect the retaining strap andmove

the cylinder to an appropriate location.

Replace aGasCylinder
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11 Troubleshooting andMaintenance

Connect a Gas Cylinder

Analyzer Series Gauge should indicate
3Flex 15 psig (103 kPag)

AccuPyc 25 psig (172 kPag)

ASAP 15 psig (103 kPag)

AutoChem 15-18 psig (103 - 124 kPag)

AutoPore 50-60psig (345 - 404 kPag)

Gemini 15-18 psig (103 - 124 kPag)

MIC SAS II 15-20 psig (103-138 kPag)

TriStar 15-18 psig (103 - 124 kPag)

Regulator Pressure Settings

Exceeding themaximum recommended air pressure could cause personal injury or dam-
age the instrument.

Move the replacement cylinder close to the analyzer and tether it into place. It is not necessary to
disconnect the gas line from the regulator or the analyzer.

1. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas
cylinder. Place the protective cap in a secure location. It will be needed to recap the gas cyl-
inder when it is depleted and replaced.

2. Attach the gas regulator to the gas cylinder connector. Hand tighten the nut, then use an
appropriate wrench to tighten an additional 3/4 turn.

Over-tightening the fittingmay cause a leak.

3. Check for leaks at the high pressure side of the regulator and in the connector.
a. Turn the regulator control knob fully counter-clockwise.
b. Slowly open the gas cylinder shut-off valve, then quickly close it.
c. Observe the pressure on the high pressure gauge for approximately oneminute:

n If the pressure is stable, proceed with the next step.
n If the pressure decreases, tighten the regulator connector nut until it becomes stable.

If the pressure does not remain stable, remove the regulator and clean all contacts at
the regulator connection, then reinstall the regulator.

11 - 6 MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020



4. Purge the air from the lines.

Purge the regulator before proceeding to prevent contamination of the analysis gas sup-
ply.

a. Open the gas cylinder valve to pressurize the regulator, then close the valve.
b. Adjust thePressure Control knob to approximately 5 psi.
c. Turn the regulator Shut-off valve counter-clockwise to open. Allow gas to flow until both

gauges read approximately zero.
d. Close the regulator Shut-off valve to stop gas flow.
e. Reconnect the gas line to the regulator.
f. Use two 7/16 in. (11mm) wrenches to tighten the gas line connection. Hold one wrench fit-

ting steady and the other to tighten the connector nut.
5. Set the analyzer pressure.

a. Turn theRegulator Control knob clockwise until the low pressure gauge indicates the
appropriate pressure. See theRegulator Pressure Settings table inConnect a Gas
Cylinder on the previous page.

b. Open the regulator Shut-off valve.
c. Open the gas cylinder Shut-off valve and flow gas for 10 to 30 seconds.
d. Close the gas cylinder Shut-off valve.
e. Close the gas cylinder valve.

6. If the gas line to the instrument inlet was previously disconnected, reconnect it now.

Replace aGasCylinder
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11 Troubleshooting andMaintenance

CLEAN AND VERIFY THE GAS LINE

Unit [n] > Diagnostics > Start Diagnostic Test
Always clean the gas lines and verify there are no leaks at the connections after a gas cylinder is
connected. This test examines the gas line from the analyzer to the gas cylinder, then from the
analyzer to the regulator shut-off valve. A report is generated at the completion of the test to verify
that it has passed or failed. Causes and corrective action for a failure are provided.

Before beginning, confirm that the state for valves and the low pressure gauge are as follows:

A. Gas tubing to instrument
B. Gas regulator shut-off valve -

OPEN
C. Low pressure gauge - 14-15

psig
D. High pressure gauge
E. Gas cylinder shut-off valve -

CLOSED
F. Regulator connecter nut
G. Regulator control knob -

OPEN
H. Brass reducer fitting

1. SelectClean and Verify Analysis Gas Line [n] Test Rev [n] in the Test field. The length of time
a test will run is also indicated on the window. TheSequence field indicates the file created as
a result of this test.

2. In theOperator field, enter either the name or initials of the operator performing this test.
3. Resize the window (if necessary) to display theReport after test option, then selectPreview

as the destination. ClickStart.
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4. From theView drop-down list, select eitherOperation, Instrument Log, or Instrument Schem-
atic.

5. The following series of prompts display on the window requiring operator response:
a. This is the gas line clean and leak check test for inlet port [n]. Inlet ports being testedmust

be connected to a gas cylinder according to the user manual. A Nupro isolation valve
should be installed on the line between the analyzer and the regulator.

b. The test starts with amanual leak check (requires Snoop or equivalent, and IPA), then the
line and regulator are evacuated for 20minutes for cleaning. Next, the leak rate of the gas
line is determined.

c. With the regulator set to 15 psig, open the cylinder, regulator shut-off valve, and isolation
valve. Check each joint for bubbleswith Snoop or equivalent. If a joint is leaking, attempt
tightening (without over-tightening) or replace ferrules.

d. When there are no leaking joints, use IPA to remove water from each joint, then wipe dry.
e. Close the gas cylinder valve. Leave the regulator shut-off and isolation valves open.
f. User will be needed in 30minutes to close the isolation valve. ClickOK to begin auto-

mated testing.
6. A popup window indicates the test is complete. ClickOK. The reports display.

7. Click each tab across the top of the window and look for a reading of Passed. A Passed read-
ing indicates all valves are in a proper state for operation. If any test shows a Failed reading,
refer to the following table to help determine the location of the gas leak.

Clean and Verify the Gas Line
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11 Troubleshooting andMaintenance

Tab Test If Failed status, then...
Gas Line to Inlet
Port [n]
Test 1

Gas Line to GasBottle
Test

This test will show a reading of Failed if any of the
other tabs has a Failed reading. Correct the failed
connection and rerun the test.

Gas Line to Inlet
Port [n]
Test 2

Gas Line to Isolation
Valve Test

Check for a leak between the gas line and the isol-
ation valve. Correct the problem and rerun the
test.

Gas Line to Inlet
Port [n]
Test 3

Isolation Valve To
Bottle LeakRate

Check for a leak between the isolation valve and
the gas cylinder. Correct the problem and rerun
the test.

If the Fail if above field indicatesFailed, one or more valves is not in the proper position. Set the
valves, then ensure the appropriate pressure is displayed on the low pressure gauge.

If re-running the test, close the gas cylinder valve before starting the test.

ENABLE MANUAL CONTROL
Unit [n] > Enable Manual Control

See also:

Show Instrument Schematic on page 2 - 20

Use to enable themanual control of certain system valves and elevator components on the analyzer
schematic. When this option is enabled, a checkmark appears to the left ofUnit [n] > Enable
Manual Control. If the analyzer schematic is not immediately visible, go toUnit [n] > Show
Instrument Schematic.
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PERFORM A LEAK TEST
Unit [n] > Diagnostics > Start Diagnostic Test
AMicromeritics Service Representativemay request that a leak test be performed to determine if
there is a system leak andmay also require a copy of the report generated by this test.

The test provides:

n Prompts on preparing the analyzer for the test
n Approximate time period of the test
n Prompts in which an operator response is required

1. Select the test to run.
2. Select Report After Analysis and choose Preview as the destination.
3. ClickStart.
4. Verify all tests have aPassed status by selecting the tabs and looking for thePassed status for

each test run.
5. ClickSave As to save the test file results.

Perform a Leak Test
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11 Troubleshooting andMaintenance

A. Suspend/Resume/
Skip/Play buttons

B. Port report buttons
C. Live graph settings

11 - 12 MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020



PREVENTIVE MAINTENANCE

Perform the following preventivemaintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventivemaintenance procedures and
calibration be performed by aMicromeritics Service Representative every 12months.

Maintenance Required Frequency
Alumina in vapor oil traps * Replace as required.

Analyzer exterior Clean as required or every 3 to 6months.

Dewar Check and clean weekly.

Diaphragm vacuum pump ** If an oil-free pump is used, replace diaphragm(s) every 12
months.

Dry forepumps As required or every 24months.

Port filters and O-rings Replace every 3 to 6months.

Sample tube O-ring Replace as required or every 3 to 6months.

Test for leaks As required or every 12months.

Vacuum pump exhaust filter Replace as required or every 12months.

Vacuum pump fluid * Inspect and change as required or every 3 to 6months.

* Oil sealed vacuum pumps only.

** For oil-free pumps only: After 12 to 18months of operation, the diaphragm(s) in the pumpwill
wear out and the pump becomes completely inoperable. To prevent instrument downtime due to
an inoperable pump, it is recommend that the diaphragm(s) be replaced by aMicromeritics
Service Representative every 12months.

PreventiveMaintenance
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11 Troubleshooting andMaintenance

CHECK AND CLEAN THE DEWAR

When handling Dewars, follow the precautions outlined inDewar Precautions on
page 6 - 1.

Always handle glassDewars with care. Any product incorporating a vacuum is a poten-
tial safety hazard and should be treated with caution. If in doubt, contact your safety
officer.

Ice and suspended frost particlesmay accumulate in the bottom of the analysis port Dewar. Particles
or deposits exceeding 1/4 in. in depthmay jam between the bottom of the sample tube and the
bottom of the Dewar, causing the Dewar not to raise fully. Accumulations of fine particles impede
liquid nitrogen circulation around the bottom of the sample tube. This causes the sample
temperature to be slightly higher which, in turn, can cause pore volumemeasurement errors in those
samples exhibiting high isotherm slope above 0.97 relative pressure. Accumulated ice is likely to melt
and form a pool of water in the Dewar if all liquid nitrogen evaporates. The water must be removed,
otherwise it will solidify when liquid nitrogen is added and could press on the bottom of the sample
tube causing breakage.

To ensure problems do not develop due to ice accumulation, check the Dewar after each use. Clean
on a weekly basis.

1. Remove the Dewar from the analyzer.
2. Pour out liquid nitrogen into an appropriate cryogenic container. Do not re-use liquid nitrogen.

Do not pour liquid nitrogen directly into a sink. Doing somay cause drain pipes to burst.

3. Rinse the Dewar with warmwater to melt any remaining ice accumulation whichmay remain.
Dry thoroughly.

4. Replace the Dewar.
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CLEAN THE INSTRUMENT

The exterior casing of the instrument may be cleaned using a clean cloth dampened with isopropyl
alcohol (IPA), amild detergent, or a 3% hydrogen peroxide solution. Do not use any type of abrasive
cleaner.

n Do not allow liquid to penetrate the casing of the analyzer. Doing so could result in
damage to the unit.

n Use only amild detergent in water to clean safety shields. The use of isopropyl alco-
hol can damage the shield surface.

CLEAN THE GAS DELIVERY TUBES

If using a FlowPrep or SmartPrep, gas delivery tubes should be wiped with a lint-free cloth after each
use to remove any particles of sample that may have adhered to the tube. If a gas delivery tube
becomes clogged or damaged, it should be replaced.

1. Remove the gas delivery tube from the flexible tubing.
2. Attach a new gas delivery tube by pressing the flexible tubing over the gas delivery tube.

Ensure that the flexible tubing completely covers the ferrule at the end of the gas delivery tube.

LUBRICATE THE ELEVATOR DRIVE ASSEMBLY

The elevator screw is lubricated before it leaves the factory and should not require lubricating. If the
elevator starts to vibrate or becomes noisy when traveling, contact aMicromeritics Service
Representative for disposition.

Should lubrication become necessary, apply a light coat of TeflonMagnalube-G grease
[Micromeritics part number 004-16163-00] to the elevator screw. Do not grease the guide rods.

Clean the Instrument
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11 Troubleshooting andMaintenance

POWER INSTRUMENT ON AND OFF

DO NOT connect or disconnect cables when the instrument is poweredON.

Power ON the equipment in the following order:

1. Computer, monitor, and printer
2. Analyzer
3. External vacuum pump

The pumpmust warm for approximately two hours before performing analyses.

Power OFF the equipment.

The analyzer should remain poweredON at all times, however it if becomes necessary,
power OFF the equipment in the following order:

1. Exit the analysis program. Failure to do so could result in loss of data. If an analysis is in pro-
gresswhen closing the application, the followingmessage is displayed:

2459 - An Instrument is busy. A delay in restarting this application
could result in loss of new data. Continue program exit? Yes / No

Yes. Closes the program. The analysis continues and data continue to be collected. The
data will be restored when the application is restarted. Reports queued in the print manager
will print. If a power failure occurs and an uninterruptible power supply (UPS) is not attached
to the analyzer, the data collected after exiting the analysis program are lost.

No. The program remains open and the analysis continues to run.

2. Computer, monitor, and printer
3. Analyzer
4. External vacuum pump
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SAMPLE PORT FRIT REPLACEMENT

The equipment images in this topicmay differ slightly from your equipment, however the
instructions are the same unless otherwise noted.

A frit is located in the connecting nut attached to each analysis port. If the frit becomes contaminated,
the contaminant may adsorb or desorb during analysis, affecting the results. A contaminated frit on
the analysis port may be indicated as a leak or a free space readingmuch lower than normal.

Use the proper size frit for the sample port. The analyzer will not operate properly if an
incorrect size is used.

1. Go toUnit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go toUnit [n] > Show Instrument
Schematic.

2. Right click on the valve of the appropriate port. If the valve is open, clickClose to close the
valve.

3. Use a wrench to remove the connecting nut from the sample port. Pry out the filter (frit) andO-
ring.

To avoid degassing problems, the frit should be clean and should not be touched with
bare hands.

4. Place a new frit into the connecting nut.

A. O-ring
B. Filter (frit)
C. Sample tube fitting

5. Replace the filter andO-ring. Carefully reassemble the sample tube fitting and reinstall on the
sample port. Tighten by hand, then with a wrench to prevent leaks.

Sample Port Frit Replacement
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11 Troubleshooting andMaintenance

REPLACE THE SAMPLE TUBE O-RING

The equipment images in this topicmay differ slightly from your equipment, however the
instructions are the same unless otherwise noted.

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-ring
becomesworn or cracked, it does not provide a good seal and will need to be replaced.

Before removing (or installing) a sample tube, ensure that the port valve is closed.
Observe the analyzer schematic to verify valve status.

Do not allow the sample tube connector nut drop onto the bottom of the tube as it may
break the tube.

Use the proper size frit for the sample port. The analyzer will not operate properly if an
incorrect size is used.

1. Carefully remove the Dewar from the analyzer. Take care not to bump the sample tube bulbs
with the Dewar during this process. Place the Dewar aside.

2. Hold the sample tube firmly with one hand, loosen the sample tube connector nut by turning
counter-clockwise.

3. Carefully pull the sample tube down until it is free from the port. It may be necessary to grasp
the sample tube with both hands.

A. O-ring
B. Ferrule
C. Connector nut
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4. Remove theO-ring from the top of the sample tube and replace it with a new one.

If the O-ring remains inside the sample port, use theO-ring removal tool from the access-
ory kit [tool part number 004-54618-00] or use a pair of tweezers or needle-nose pliers
to remove it.

5. After the new O-ring is in place, insert the sample tube back into the sample port until it is fully
seated.

6. Slide the sample tube connector nut up the tube until it comes in contact with the port fitting
(the ferrule andO-ring will move along with the connector nut). Then, turning clockwise, hand
tighten the connector nut to the sample connector.

RECOVER FROM A POWER FAILURE
The analyzer saves entered and collected data in case of power failure. File parameters and any
other data entered will still be present when power is restored. If an analysis was in progresswhen
the power failure occurred, it will be canceled when the analyzer restarts. Any data collected during
the analysis will still be present, but the analysis should be restarted in order to produce complete
results.

Recover from a Power Failure
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11 Troubleshooting andMaintenance

SERVICE TEST MODE

Options > Service Test Mode

Service Test Mode is a password protected option used to perform certain service tests with the
assistance of a trainedMicromeritics Service Representative. This password is supplied by your
Micromeritics Service Representative.

If a menu item is grayed out, it is usually an indication that Service Test Mode is required.

To exit Service Test Mode, go toOptions > Service Test Mode and deselect theService Test
Mode option or close the application.

OIL-BASED VACUUM PUMP
Log in to your customer portal to access the VacuumPumpGuide.
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A ADVANCED REPORTS - PYTHON MODULE

In a 21CFR11 environment, the Advanced reports feature is applicable tomembers of
the Developer group only.

n Summary reports.Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with themic.summary call.

n Tabular reports.Consist of one or more tables each containing one or more labeled columns of
data. Tabular reports are created with themic.table call.

n Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with themic.graph call.

Calls for accessing the sample file data can be found in theMicModule Python Calls section of this
appendix. More advanced example python scripts are included in the analyzer software. Application
specific discussions can be found on https://www.micromeritics.com/Pressroom/MicroReport.aspx

The examples in this topic are also included as a part of theMicromeritics installation pro-
cess and are located in theScripts sub-directory.

A Advanced Reports - PythonModule
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A Advanced Reports - PythonModule

ADVANCED REPORT OPTIONS

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports a
"mic" Pythonmodulemust be created. SeeMicModule Python Calls on page A - 16 for an
example of Python script and functions for the "mic" Pythonmodule.

1. Create the Python script and save it in theScripts directory.
2. Open a sample file with aComplete status.
3. SelectAdvanced in the view selector drop-down list at the bottom of the window to return to

the tabbed view.
4. On theReport Options tab, selectAdvanced Reports in theSelected Reports list box, then

clickEdit.
5. On theAdvanced Report Optionswindow, clickAdd in theAvailable Scripts group box to loc-

ate and select the Python script. Repeat for each script to be added.

6. In theSelected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in theAvailable Scripts box.

7. ClickPressures to add pressure points to the report. ClickOK to return to theReport Options
tab.

8. Select theOverlay samples checkbox to enable the overlay sample feature.
9. On theReport Options tab, clickPreview. The Python Reports will be included on the tabs

across the top portion of theReportswindow.
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Field or Button Description
Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace, edit,
or remove reports.

Overlay samples (if
shown) [check box]

Use to overlay samples as defined by the function.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Advanced Reports

Advanced Report Options
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A Advanced Reports - PythonModule

SCRIPTS

Run a Script

1. Open a sample file with aComplete file status.
2. SelectAdvanced in the view selector drop-down list at the bottom of the window.
3. Select theReport Options tab.
4. HighlightAdvanced in theReports list box, then clickEdit.
5. On theAdvanced Report Optionswindow, clickAdd. Locate and select one or more python

scripts then clickSelect. The selected scripts become a part of the drop-down list in theAvail-
able Scripts section of theAdvanced Report Optionswindow.

6. In theSelected Reports section, select up to five Advanced reports in the drop-down lists. Use
thePressures button to include or exclude available pressures in the report. The pressure
range is unique for each advanced report, but the excluded pressures are shared across all
five advanced reports.

7. ClickOK.
8. ClickPreview on theReport Options tab to view all reports selected in the previouswindow.

Remove a Script

Select the script in theAvailable Scripts box then clickRemove. The script is removed from the
application however, the original .py text file is not affected.
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Edit a Script

When a script is added, the code is stored within the application. If the script changes out-
side of the application, the script file will have to be re-added to the Advanced Report
Optionswindow for the changes to take affect.

Field or Button Description
Add [button] Adds one or more scripts to theAvailable Scripts box. The added

scripts then become available as options in theSelected Reports
section.

Edit [button] Edits the script stored within the application but does not affect the
original .py text file.

Overlay samples
[check box]

Select to enable the overlay sample files process.

Pressures [button] Select to include or exclude pressures from the report.

n Calculation pressure range.Enter theminimumandmaximum
pressures to be used in the pressure table.

n Cancel. Discards any changes or cancels the current process.
n Exclude All. Select to exclude all pressure points in the table.
n Include All. Select to include all pressure points in the table.
n OK. Saves and closes the active window.

Remove [button] Removes the script from theAvailable Scripts box but does not affect
original .py text file.

Replace [button] Replaces the contents of the selected script however, the script name
remains the same.

Scripts
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A Advanced Reports - PythonModule

PYTHON REPORTS

Graphic Report

This script is an example of themicmodule producing a graph with two curves:

import mic
import numpy as np

mic.graph( 'My Graph', 'x', 'f(x)' )

myx = np.array( [0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1.0 ] )
mic.graph.add( 'x^2', myx, myx*myx, marker='o' )
mic.graph.add( 'sin(x)', myx, np.sin(myx), marker='^' )

The results are:
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Summary Report

This script produces a summary report with two summaries:

import mic
mic.summary( "My Summaries" )

mic.summary.add( "Summary A",
["label 1:", "label 2:", "label 3:"],
["val1", "val2", "val3"] )

mic.summary.add( "Summary B",
["label 4:", "label 5:", "label 6:"],
["val4", "val5", "val6"] )

The result is:

Python Reports
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A Advanced Reports - PythonModule

Tabular Report

If more than one column is required, the callmic.table is employed. This script produces a tabular
report consisting of two tables.NOTE: This script uses the Python package "numpy" and c-style
formatting of the numerical values.

import mic
import numpy as np

mic.table("My Tables")

mic.table.addtable( "My set A" )
mic.table.addcolumn( "x", ["1.0", "2.0", "3.0"] )
mic.table.addcolumn( "y", ["0.5", "1.0", "1.5"] )

x1 = 0.2
x2 = 0.5
x3 = 3.14159/2
mic.table.addtable( "My set B" )
mic.table.addcolumn( "x", ["%8.3f" % x1,

"%8.3f" % x2,
"%8.3f" % x3 ] )

mic.table.addcolumn( "sin(x)", ["%8.3f" % np.sin(x1),
"%8.3f" % np.sin(x2),
"%8.3f" % np.sin(x3)] )

mic.table.addcolumn( "cos(x)", ["%8.3f" % np.cos(x1),
"%8.3f" % np.cos(x2),
"%8.3f" % np.cos(x3)] )

The result is:
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ACQUIRE BASIC INFORMATION

To acquire the adsorption isotherm and other basic information about the sample being edited, the
callsmic.isotherm,mic.sample_information, andmic.adsorptive_data are applied.

This script produces a graph of the adsorption and desorption isotherms for both relative and
absolute pressure, and prints summaries of the sample information and the adsorptive properties.

import mic

prel, qads, n_ads, ambient_fs, analysis_fs, mass, desc = mic.isotherm('rel')
mic.graph( 'Graphical Report 1', 'Rel. Press', 'Quantity Adsorbed' )
mic.graph.add( 'Sample isotherm', prel, qads )

pabs, qads, n_ads, ambient_fs, analysis_fs, mass, desc = mic.isotherm('abs')

mic.graph( 'Graphical Report 2' 'Abs. Press', 'Quantity Adsorbed')
mic.graph.add('Sample Isotherm', pabs, qads)

mass = mic.sample_information('sample mass' )
Tanl = mic.sample_information('analysis temperature' )
dens = mic.sample_information('sample density')

mic.summary( "Sample Information" )
mic.summary.add( "Sample Information:",

[ "Number of adsorption points:",
"Ambient Free space:",
"AnalysisFree space:" ,
"Sample mass (g):",
"Description:",
"Analysis Temp:",
"Sample Density (g/cm^3):" ],

[ "%8.3f" % n_ads,
"%8.3f" % ambient_fs,
"%8.3f" % analysis_fs,
"%8.3f" % mass,
desc,
"%8.3f" % Tanl,
"%8.3f" % dens ] )

csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()

mic.summary.add( "Adsorptive Data",
[ "Cross Sectional Area",

"Hard Sphere Diameter",
"Density Conversion Factor",
"Molecular Weight",

Acquire Basic Information
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A Advanced Reports - PythonModule

"Analysis gas"],
[ "%8.3f" % csa,

"%8.3f" % hsd,
"%8.3f" % dcf,
"%8.3f" % mol_weight,
analysis_gas ] )

Note the calls tomic.isotherm andmic.adsorptive_data above are each returning results as a list with
elements of varying return type.
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ACQUIRE REPORT RESULTS

Sample file report resultsmay be accessed using themic.report call. This script prints a summary of
the results of the t-plot and BET reports.

import mic

sa = mic.report("bet", "surface area")
c = mic.report("bet", "bet constant")
vm = mic.report("bet", "monolayer capacity")
esa = mic.report("tplot", "external surface area")
vol = mic.report("tplot", "micropore volume")

mic.summary( "BET and T-plot Results" )

mic.summary.add( "Report Results",
[ "bet surface area",

"bet constant",
"bety 6" ,
"tplot external surface area",
"tplot micropore volume"],

[ "%10.5f" % sa,
"%10.5f" % c,
"%10.5f" % vm,
"%10.5f" % esa,
"%10.5f" % vol ] )

The result is:

Acquiring the results from a pore-distribution report such as the BJH method is done in a similar way
as in the previous script except the return values from themic.report call are slightly different since
they involve lists of data. For example,

import mic
xdat, ydat, desc = mic.report('bjhads' ,'incremental distribution' )
mic.graph( 'BJH Ads/Des', 'Pore diameter', 'Incremental Volume' )
mic.graph.add( desc, xdat, ydat )

The result is:

Acquire Report Results
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A Advanced Reports - PythonModule

Refer to theMic Module Python Calls section for amore complete description of the usage and
scope of themic.report call.
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ACQUIRE OVERLAY SAMPLE DATA FOR GAS ADSORPTION

The call to obtain overlay sample data is similar to the calls for the primary sample. This script
involves two overlay sample files.

The calls to obtain adsorptive data and report results for an overlay sample file usingmic.report and
mic.adsorptive_data have a very similar interface as themic.overlay call, and a summary of their
usage is shown in the example in this topic.

import mic

p, q, n, fsw, fsc, mass, desc = mic.isotherm('rel')
p1, q1, n1, fsw1, fsc1, mass1, desc1 = mic.overlay( 1, 'rel')
p2, q2, n2, fsw2, fsc2, mass2, desc2 = mic.overlay( 2, 'rel')

mic.graph( 'Three Sample Isotherms',
'Rel. Press',
'Quantity Adsorbed (cm^3/g)' )

mic.graph.add( 'Primary Isotherm ', p, q )
mic.graph.add( 'Overlay Isotherm 1', p1, q1 )
mic.graph.add( 'Overlay Isotherm 2', p2, q2 )

mic.summary( "A summary report" )

mic.summary.add( "Two samples",
[ "Primary Sample:",

"Overlay Sample 1:",
"Overlay Sample 2:" ],

[ desc,
desc1,
desc2] )

Acquire Overlay Sample Data for Gas Adsorption
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A Advanced Reports - PythonModule

The results are:

To enable the use of overlay data in the Advanced reports, the following two actionsmust be taken
prior to running the script:

n Sample files to overlaymust be selected, and
n TheOverlay samples checkbox on theAdvanced Report Optionswindow must be selected
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ENABLE THE USE OF OVERLAY DATA

1. On theReport Options tab, clickOverlays.
2. On thePlot Overlay Sample Selectionwindow, tomove a file from theAvailable Files list box

to theSelected Files list box, either double click a file name in theAvailable Files list box or
click one or more files in theAvailable Files list box then clickAdd.

3. ClickOK.
4. On theReport Options tab, highlightAdvanced in theSelected Reports list box.
5. ClickEdit to the left of theSelected Reports list box.
6. Select theOverlay samples checkbox to the right of the selected report.
7. ClickOK.
8. Run the script using the instructions found inScripts on page A - 4.

Enable the Use of Overlay Data
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MICMODULE PYTHON CALLS

Tables

AvailableMic Python calls for tables:

n Create a new tabular report
n Add a column
n Add a table

Add a Table

This script adds a table to the last created tabular report:

mic.table.addtable( name )

Keyword arguments:

name --- the table name

Add a Column

This script adds a column to the last created table:

mic.table.addcolumn( header, values )

Keyword arguments:

header --- column header; must be a string (or convertible)
values --- column values; must be a list of strings (or convertible)

Create a New Tabular Report

mic.table( title='User Table' )

Keyword arguments:

title --- the tabular report title (default = 'User Table')
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Summary Reports

See also:

Python Reports on page A - 6

Add a Summary Section

This script adds a summary section to the last created summary report:

mic.summary.add( name, labels, values )

Keyword arguments:

name --- summary section name
labels --- column of labels; must be a list of strings

(or convertible) and the same length as values
values --- column of values; must be a list of strings

(or convertible) and the same length as labels

Create a New Summary Report

mic.summary( title='User Summary' )

Keyword arguments:

title --- the summary title

MicModule Python Calls
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Graphic Reports

See also:

Python Reports on page A - 6

Add a Curve

This script adds a curve to the last created graphical report:

mic.graph.add( name, x, y, yyaxis=False, color=None, linestyle='-', mark-
er='a', graphtype='both' )

Keyword arguments:

name --- the curve name
x --- list of x values; must be a list of floats

(or convertible) and the same length as y
y --- list of y values; must be a list of floats

(or convertible) and the same length as x
yyaxis --- place this curve on the yy-axis if True

otherwise place on the y-axis (default = False)
color --- RGB color as an HTML hex string (e.g., '#4169e1')

or a three-element list or tuple (e.g., [65,105,225]);
if None, color is automatically selected (default = None)

linestyle --- line style; (default = '-')
'-' : solid
'--' : dash
'.' : dot
'-.' : dash dot
'-..' : dash dot dot

marker --- marker shape; (default = 'a')
'+' : plus
'o' or '0' : circle
'x' : cross
'^' : up triangle
'v' : down triangle
's' : square
'd' : diamond
'8' : hourglass
'~' : horizontal hourglass
'' or None : no marker
'a' : automatically selected

graphtype --- graph type; (default = 'both')
'curve' or 'c' : curve
'points' or 'p' : points
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'both' or 'b' : curve-and-points
'hist' or 'h' : histogram

Add a Curve Using the Second Y-Axis

This script adds a curve to the last created graphical report using the second y-axis:

mic.graph.addyy( name, xx, yy )

Add a curve to the last created graphical report using the second
y-axis. The arguments to this call are the same as to mic.graph.add
with the argument

Create a New Graphical Report

mic.graph( title='User Graph', xlabel='X axis', ylabel='Y axis', yylabel='YY
axis', xlinear=True, ylinear=True, yylinear=True )

Keyword arguments:

title --- the graphical report title (default = 'User Graph')
xlabel --- x-axis label (default = 'X axis')
ylabel --- y-axis label (default = 'Y axis')
yylabel --- yy-axis label (default = 'YY axis')
xlinear --- x-axis linear scale; if false, use log scale

(default = True)
ylinear --- y-axis linear scale; if false, use log scale

(default = True)
yylinear --- yy-axis linear scale; if false, use log scale

(default = True)

MicModule Python Calls
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Get Primary Isotherm Data

mic.overlay( overlay_number = 1, press_type='rel' )

Keyword arguments:

overlay_number --- the overlay number (1 through 8; default = 1)
press_type --- the pressure basis; use 'rel' for relative pressure,

'abs' for absolute (default = 'rel')

Usage:

p, qads, num_ads, ambient_fs, analysis_fs, mass, desc = mic.overlay(1,
'rel')

p --- array of pressure (relative or absolute);
empty-array if overlay is unavailable

qads --- array of cumulative quantity adsorbed;
empty-array if overlay is unavailable

num_ads --- number of points in the adsorption curve;
0 if overlay is unavailable

ambient_fs --- ambient free-space; 0.0 if overlay is unavailable
analysis_fs --- analysis free-space; 0.0 if overlay is unavailable
mass --- sample mass; 0.0 if overlay is unavailable
desc --- sample description; empty-string if

overlay is unavailable
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Get Overlay Isotherm Data

mic.overlay( overlay_number = 1, press_type='rel' )

Keyword arguments:

overlay_number --- the overlay number (1 through 8; default = 1)
press_type --- the pressure basis; use 'rel' for relative pressure,

'abs' for absolute (default = 'rel')

Usage:

p, qads, num_ads, ambient_fs, analysis_fs, mass, desc = mic.overlay(1,
'rel')

p --- array of pressure (relative or absolute);
empty-array if overlay is unavailable

qads --- array of cumulative quantity adsorbed;
empty-array if overlay is unavailable

num_ads --- number of points in the adsorption curve;
0 if overlay is unavailable

ambient_fs --- ambient free-space; 0.0 if overlay is unavailable
analysis_fs --- analysis free-space; 0.0 if overlay is unavailable
mass --- sample mass; 0.0 if overlay is unavailable
desc --- sample description; empty-string if

overlay is unavailable

MicModule Python Calls
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A Advanced Reports - PythonModule

Get Adsorptive Data for Each Sample

mic.adsorptive_data( sample_number = 0 )

Keyword arguments:

sample_number --- Identifier for the adsorptive data to retrieve
0 : the current sample file
1 through 8 : the corresponding overlay sample file

Usage:

csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()
csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data(0)

csa --- cross sectional area (nm^2)
hsd --- hard sphere diameter (angstroms)
dcf --- density conversion factor (dimensionless)
mol_weight --- molecular weight
analysis_gas --- mnemonic for the analysis gas species

(e.g., 'CO', 'H2')

Get Sample Information Item

mic.sample_information( item, sample_number = 0 )

Keyword arguments:

item --- string identifying the item to be returned.
Accepted identifiers are

'sample mass'
'sample description'
'analysis temperature' (degrees Kelvin)
'sample density' ( g/cm^3 )

sample_number --- Sample to retrieve (default = 0).
0 : the current sample file
1 through 8 : the corresponding overlay sample file

Usage:

mass = sample_information('sample mass')
mass = sample_information('sample mass',0)
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Get Report Results

This script gets report results for the indicted report and sample:

mic.report( report_name, result, sample_number = 0 )

Keyword arguments:

sample_number --- Identifier for the sample data to retrieve
0 : the current sample file
1 through 8 : the corresponding overlay sample file

Usage:

sa = mic.report( 'bet' , 'surface area' )
porewidth, incvol, desc = mic.report( 'bjhads' ,

'incremental distribution' )

The available report keywords, result keywords and a corresponding
description of the result is listed in the table below:

Report keyword Result keyword Description
-------------- -------------- -----------

bet surface area Surface area ( m^2/g )
bet bet constant BET constant ( dimensionless )

bet monolayer capacity Monolayer capacity ( cm^3/g )
tplot external surface area External surface area (m^2/g)
tplot micropore volume Micropore volume (cm^3/g)
bjhads incremental distribution Incremental Distribution
bjhdes incremental distribution Incremental Distribution
dhads incremental distribution Incremental Distribution
hk incremental distribution Incremental Distribution
dft incremental distribution Incremental Distribution
nldft incremental distribution Incremental Distribution

where the incremental pore distribution result above (for those
reports which return this) is a list with three components being,

porewidth --- array of pore dimension boundaries (angstroms);
empty-array if unavailable.

incvol --- array of incremental pore volumes (cm^3/g);
empty-array if unavailable.

desc --- Name of data set; empty-string if unavailable.
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Get Imported Pore Data

mic.imported_pore_data( import_number = 1 )

Keyword arguments:

import_number --- the import number (1 through 8)

Usage:

xdat, ydat, desc = mic.imported_pore_data(1)

xdat --- array of pore dimension boundaries (angstroms);
empty-array if unavailable.

ydat --- array of incremental pore volumes (cm^3/g);
empty-array if unavailable.

desc --- Name of data set; empty-string if unavailable.
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B DFT MODELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In the
experimental physical sciences, theories are often expressed in terms of amodel that can be
visualized and describedmathematically. Earlymodels of physical adsorption were quite simple,
both conceptually andmathematically, for very practical reasons— hand computationswere
required. Todaywe can explore complexmodels that describe adsorption systems on the atomic
scale of size and sub-picosecond time frame. This is not because scientists are smarter, but because
of available tools. The DFTmodels are created by classical approaches to adsorption aswell as
models based onmodern statistical thermodynamics.

MODELS BASED ON STATISTICAL THERMODYNAMICS
Included in this group aremethods that model the adsorption system in terms of forces acting
between individual molecules.

THEORETICAL BACKGROUND
Traditional adsorption theories attempt to describe experimental adsorption isothermswith an
isotherm equation containing a small number of parameters. At aminimum, these parameters
include the extent of the surface, such as themonolayer capacity (Vm), and themolar intensity of the
gas-surface interaction, such as the Langmuir “K” constant or the BET “C” constant. In some
equations, additional parameters take into account the lateral interaction of adsorbedmolecules with
each other. Other theories, such as the Dubinin-Astakhov approach, also include parameters for the
effect of adsorbent porosity.

Instead of this classical kinetic or phenomenological approach, we can use amolecular-based
statistical thermodynamic theory that allows us to relate the adsorption isotherm to themicroscopic
properties of the system: the fluid-fluid and fluid-solid interaction energy parameters, the pore size,
the pore geometry, and the temperature.

The following example is given so that youmay understand how such a theory is constructed:

A clean sample of a solid material containing slit-shaped pores of a single width is placed in an
evacuated space. It is kept at a fixed temperature as a known quantity of pure argon gas is
admitted into the space surrounding the sample. The pressure within the space is recorded over
time. In this situation, the pressure falls rapidly from its initial value and gradually approaches a
steady reading, called the equilibrium pressure. The amount adsorbed corresponds to the
quantity of gas effectively removed from the gas phase by the solid surface. A graph that plots
amount adsorbed versus equilibrium pressure is called an adsorption isotherm.

B DFTModels
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B DFTModels

Under such conditions, the argon atoms that randomly enter the pore space feel the presence of
the solid surface as the action of an external attractive force (the dispersion forces or Van der
Waal’s forces) and spendmore time near the surface. As a result, the space near the surface
acquires a greater average density of argon atoms than regions farther removed.

If the equilibrium distribution of the gas atoms near the surface could be described as a function
of pressure and themolecular properties of the components of the system, then amodel could
be constructed for the adsorption isotherm for the system. Modern physical chemistry provides
several ways to calculate this distribution. All thesemethods are based on the fundamental
thermodynamic law that such a system adopts a configuration of minimum free energy at
equilibrium. Also needed is a description of the pairwise interaction energy between atoms, U(s),
commonly given by a Lennard-Jones potential:

where

ε = a characteristic energy of the adsorptive,
σ = the diameter of the adsorptivemolecule, and
s = the separation distance.

MOLECULAR SIMULATION METHODS

Two simulation techniques are commonly used to determine the distribution of gasmolecules in a
system in equilibrium: themolecular dynamicsmethod and theMonte Carlo method. Both of these
are used as referencemethods because their results are considered exact.

MOLECULAR DYNAMICS METHOD

In themolecular dynamicsmethod, the position and velocity of individual gas particles are calculated
over time at very short intervals. Thismethod takes into account both the forces acting between the
gas particles themselves and those acting between the gas particles and the atoms of the simulated
surface. As the simulated particles collide with each other and with the surface, the average
concentration of particles in the space near the surface is calculated; this calculation yields the
amount of gas adsorbed.

Thismethod can be thought of as a way to determine the chronological record of themovement of
each particle in the system using time steps of 10-14 seconds. Although themathematics are simple,
the number of calculations required for a system of even a few hundred particles is astronomical and
challenges even the fastest computers.
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MONTE CARLO METHOD

In theMonte Carlo method, determination of the system equilibrium distribution begins with an
assumption (whichmay be only approximate) about the initial configuration of particles in the system.
The system is “equilibrated” through a process of randomly selecting one particle and conditionally
moving it a random distance in a random direction.

If themove results in a configuration of lower total energy, then themove is completed and another
particle is randomly selected to bemoved.

If themove results in a configuration of higher energy, a probability for that event is calculated, and a
random number between zero and one is generated. If the generated number is smaller than the
probability of the event, then themove is accepted; otherwise, another particle is selected and the
process is repeated. This process continues until the average total energy of the system no longer
decreases; at this point, average configuration data are accumulated to yield themean density
distribution of particles in the system.

Monte Carlo simulations require considerably less computation time thanmolecular dynamic
simulations and can yield the same results; however, neither method provides a really practical way
to calculate complete isotherms.

DENSITY FUNCTIONAL FORMULATION
Density functional theory offers a practical alternative to bothmolecular dynamic andMonte Carlo
simulations.When compared to referencemethods based onmolecular simulation, this theory
provides an accuratemethod of describing inhomogeneous systems yet requires fewer calculations.
Because the density functional theory provides accuracy and a reduced number of calculations, it is
the basis embodied in the DFTmodels.

The system beingmodeled consists of a single pore represented by two parallel walls separated by a
distance H. The pore is open and immersed in a single component fluid (adsorptive) at a fixed
temperature and pressure. Under such conditions, the fluid responds to the walls and reaches an
equilibrium distribution. In this condition (by the definition of equilibrium), the chemical potential at
every point equals the chemical potential of the bulk fluid. The bulk fluid is a homogenous system of
constant density; its chemical potential1 ) is determined by the pressure of the system using well-
known equations. The fluid near the walls is not of constant density; its chemical potential is
composed of several position-dependent contributions that must total at every point to the same
value as the chemical potential of the bulk fluid.

1 ) Chemical potential may be thought of as the energy change felt by a probe particle when it is
inserted into the system from a reference point outside the system. It can also be defined as the
partial derivative of the grand potential energywith respect to density (or concentration).

Models Based on Statistical Thermodynamics
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As noted previously, at equilibrium, the whole system has aminimum (Helmholtz) free energy,
known thermodynamically as the grand potential energy (GPE). Density functional theory describes
the thermodynamic grand potential as a functional of the single-particle density distribution;
therefore, calculating the density profile that minimizes theGPE yields the equilibrium density profile.
The calculationmethod requires the solution of a system of complex integral equations that are
implicit functions of the density vector. Since analytic solutions are not possible, the problemmust be
solved using iterative numerical methods. Although calculations using thesemethods still require
supercomputing speed, the calculation of many isotherm pressure points for a wide range of pore
sizes is a feasible task. The complete details of the theory and themathematics can be found in the
papers listed underDFT Model References on page B - 16.

The following graphs and accompanying text illustrate the results of using density functional theory to
predict the behavior of amodel system.

Figure 1 shows the density profile for argon at a carbon surface as calculated by density functional
theory for a temperature of 87.3 K and a relative pressure of about 0.5.

Figure 1. Density Profile for Argon on Carbon at 87.3 K and a Relative Pressure of 0.5

This figure represents a cross-section of the region near the surface. Note the layerwise distribution
of adsorbate; the first monolayer is sharply defined and a third layer can be distinguished. The area
under the profile curve represents the amount adsorbed per unit area at this pressure. The positions
of themaxima are separated by a distance determined by the size of the adsorptive atom.
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Given the density profile, the amount adsorbed at the stated pressure can be easily calculated as the
integral over the profile. Repeating this calculation over a range of pressures yields the adsorption
isotherm for themodel. If the value of H is very large, the isotherm obtained corresponds to that of an
external, or free, surface. If H is smaller, a range of pressures is reached where twominima exist for
the grand potential, showing the presence of twometastable phases having different density
distributions but the same chemical potential. The phase with the lower GPE is the stable one. As the
pressure is increased, a point is reached where the other phase becomes the stable one. This phase
transition reflects condensation of adsorbate in the pore; the pressure at which it occurs is called the
critical pore-filling pressure. This pressure is analogous to the condensation pressure predicted by
the Kelvin equation in the classical model of pore filling.

Figure 2 shows how the profiles change with pressure for amodel pore with H = 40 angstroms. The
inset shows the density profiles for the corresponding points of the isotherm.

Figure 2. Model Isotherm for Argon at 87.3 K in a 40 Å Slit in a Carbon Substrate

The profiles show the density distribution from one wall to the center of the slit; the other half of the
distribution is amirror image of the profile shown.

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position close to
the surface.

n Inset a shows the profile corresponding to point a on the isothermwhere the surface is about half
covered.

n At point b, the first layer is so full that it ismore favorable for atoms to start a new layer.
n At point c, a third layer is forming. Point c, for this size slit, is the critical pore-filling pressure. In

inset c, the profile shows the density decreasing to near zero (actually the bulk gas density) at 4 or
5molecular diameters from the surface.

n Inset d shows the profile converging on a density similar to that of bulk liquid argon in the center of
the pore, indicating a phase transition.
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Note that the adsorption isotherms for pores larger than the one shown in the previous graph is
identical up to point c. The lower branch of the isotherm simply continues to a higher pressure for
larger pores. This trend is illustrated in the Figure 3, where isotherms for some larger size pores are
shown. It is clear that pore size is uniquely characterized by a corresponding critical pore-filling
pressure. At large pore sizes, density functional theory produces results for the critical filling
pressures that are in good agreement with those produced by the Kelvin equation.

Figure 3. Model Isotherms for Some Larger Pore Widths Argon on Carbon at 87.3 K

Figure 4 showsmodel isotherms for pores in themicropore size range. Note the logarithmic scale for
pressure.

Figure 4. Model Isotherms in the Micropore Size Range of Pore Width Argon on Carbon at
87.3 K
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Pores of 4 Å width, barely larger than the argon atom (3.38 Å), fill at pressures below 1millitorr.
Pores below 15 Å fill before amonolayer is completed on the surface of the larger pores. In the
micropore size range, the pore volume fills more gradually with pressure and the total shape of the
isotherm is important in characterizing the pore size.

Models Included

Non-Local Density Functional Theory with Density-Independent Weights

N2 - DFT Model
AR - DFT Model

Geometry: Slit
Substrate: Carbon (graphite)
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Using themethods of non-local density functional theory, two sets of isotherms have been calculated
to serve as kernel functions for the characterization of porous solids from adsorption data. Themodel
isotherms are stored in binary format files. Thesemodels assume a slit-like pore geometry. The pore
size range from 4.0 to 4000 Å is covered in 91 classes in a geometric progression. The class intervals
are rounded to the nearest 0.02molecular diameters. A model for the free or external surface is
included to account for unfilled pores. Each of the 92model isotherms has been calculated at 181
pressure points from near 1×10-6 to near 1.00 relative pressure.

Thesemodels are identical to those supplied with the original DOS version of DFT software. Some
slight difference from the DOS resultsmay be noted when they are applied to the same data due to
improvements in the deconvolution algorithm and better regularization of the current software.

Non-Local Density Functional Theory with Density-Dependent Weights

N2 - Modified Density Functional

Geometry: Free surface
Substrate: Surface energy
Method: Nitrogen at 77K

Using themodified Tarazona prescription described byOlivier (seeDFT Model References on
page B - 16 [items 3 and 4]), model isothermswere calculated for a wide range of adsorptive
energies to a relative pressure of 0.6. Themodel makes no provision for pore filling in themicropore
region. If the sample solid contains small mesopores, the isotherm data should be truncated (using
theSelect Data Pointswindow) to a suitably low relative pressure to avoid trying to fit this region;
mesopore filling reports as a large area of low energy in the calculated distribution of adsorptive
potential.

Models Based on Statistical Thermodynamics
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The surface energy is reported in terms of the effective Lennard-Jones interaction parameter, i.e.,
for the adsorptive / adsorbent pair divided by Boltzmann constant. The units are therefore Kelvin.

N2 - Cylindrical Pores - Oxide Surface
AR - Cylindrical Pores - Oxide Surface

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isothermswere calculated using a combination of statistical mechanical calculations and
experimental observations for macroporous silicas andMCM-41mesoporous silicas aswell as
zeolites. The pore-filling pressureswere determined as a function of the pore size from adsorption
isotherms onMCM-41materials characterized by X-ray and other techniques. The variation of the
pore fluid density with pressure and pore size has been accounted for by density functional theory
calculations. The N2model reports pore sizes ranging from 3.8 to 387 Å and the AR model from 3.8
to over 500 angstroms.

References: M. Jaroniec, M. Kruk, J.P. Olivier, and S. Koch, “A New Method for the Accur-
ate Pore Size Analysis of MCM-41 andOther Silica-BasedMesoporous
Materials,” Proceedings of COPS-V, Heidelberg, Germany (1999).

N2 – Cylindrical Pores – Pillared Clay Surface (Montmorillionite)

Geometry: Cylinder
Substrate: Crystalline Silicate
Category: Porosity
Method: Nitrogen at 77K

Model isothermswere calculated using a combination of statistical thermodynamic Non-Local
Density Functional Theory (NLDFT) calculations and experimental isotherms for reference samples
of montmorillionite. The constructionmethod for the hybrid models was analogous to that described
in the first reference below (Jaroniec et al,1999). The additional references add additional theoretical
details as well as examples of the application of themodel to pillared clay catalysts. Thismodel
reports pore widths from 3.8 to 387 angstroms.

References: Mietec Jaroniec, Michal Kruk, JamesP. Olivier and Stefan Koch, “A New
Method for the Characterization of Mesoporous Silicas,” Proceedings of
COPS-V, 1999, Studies in Surface Science, Vol 128,Characterization of
porous Solids V , Unger, et al, Eds, Elsevier, Amsterdam, 2000.

JamesP. Olivier andMario L. Occelli, “Surface Area andMicroporosity of a
Pillared Interlayered Clay (PILC) from aHybrid Density Functional Theory
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(DFT) Method,” The Journal of Physical Chemistry B; 2001, 105(3), 623-
629.

M. L. Occelli, J. P. Olivier, J. A. Perdigon-Melon, and A. Auroux, “Surface
Area, Pore VolumeDistribution, and Acidity in Mesoporous Expanded Clay
Catalysts fromHybrid Density Functional Theory (DFT) and Adsorption
MicrocalorimetryMethods,” Langmuir 2002, 18, 9816-9823.9b.

JamesP. Olivier, “The Importance of Surface Heterogeneity in Developing
CharacterizationMethods.” 6th International Symposium on the
Characterization of Porous Solids, Studies in Surface Science and Catalysis
144, Elsevier, 2002.

JamesP. Olivier andMario L. Occelli, “Surface Area andMicroporosity of
Pillared Rectorite Catalysts from aHybrid Density Functional Theory
Method,”Microporous andMesoporousMaterials 2003, 57, 291-296.

C02 - DFT Model

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Carbon dioxide at 273 K

Model isothermswere calculated using the non-local prescription of Tarazona, employingmolecular
parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional Model

Geometry: Free surface
Substrate: Any
Category: Surface energy
Method: Argon at 87K

Thismodel was produced in the samemanner as the N2Modified Density Functional model listed
earlier, except applicable to argon adsorbed at 87.3 K.

N2 - Tarazona NLDFT, Esf = 30.0K

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K

Models Based on Statistical Thermodynamics
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Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions and a cylindrical pore geometry. The wall potential used is k = 30 K, typical for a
silica or alumina surface.

Thismodel file is particularly useful for sizing zeolites or zeolite containingmaterials that have
substantial micropore volume. The reported pore size range is 3.8 to 387 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Slit Pores by NLDFT
Ar - Carbon Slit Pores by NLDFT

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions and a slit-like pore geometry. Thesemodels are slightly different fromN2-DFT
and Ar-DFTmodels that were calculated using NLDFT with density independent weighting
functions.

The reported pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Finite Pores, As=6, 2D-NLDFT
Ar - Carbon Finite Pores, As=6, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions assuming 2D model of finite slit pores having a diameter-to-width aspect ratio of
6.

Thismodel is particularly useful for microporous carbonmaterials. The reported pore size range is
from 3.5 to 250 angstroms.
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References: Jacek Jagiello and JamesP. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore structure
analysis.,” The Journal of Physical Chemistry C, 113(45):19382-19385,
2009.

N2 - Carbon Finite Pores, As=12, 2D-NLDFT
Ar - Carbon Finite Pores, As=12, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isothermswere calculated using the samemethods and assumptions that were used in the
model above except in thismodel, the aspect ratio is equal to 12.

These two finite poremodelsmay be used as a research tool in conjunction with independent
analytical techniques such as high-resolution transmission electronmicroscopy (HRTEM) and/or X-
ray diffraction (XRD) to obtain comprehensive information about the structure of studied carbon
material.

References: Jacek Jagiello and JamesP. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore structure
analysis.,” The Journal of Physical Chemistry C, 113(45):19382-19385,
2009.

N2 - Carbon Cylinder, single-wall nanotube by NLDFT
Ar - Argon Cylinder, single-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gasmolecule and the graphitic surface of an
infinitely long cylinder.

Thismodel is particularly useful for characterizing carbon single-wall nanotubes. The reported pore
size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).
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N2 - Carbon Cylinder, multi-wall nanotube by NLDFT
Ar - Argon Cylinder, multi-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gasmolecule andmultiple concentric graphitic
surfaces of infinitely long cylinders.

Thismodel is particularly useful for characterizing carbonmulti-wall nanotubes. The reported pore
size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987)

Ar - Zeolites H-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K

Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gasmolecule and the oxide surface of an infinitely
long cylinder.

Thismodel is particularly useful for characterizing oxides and H+ and (NH4)+ exchanged zeolites.
The reported pore size range is from 3.5 to 300 angstroms.

Ar - Zeolites Me-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K
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Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gasmolecule and the oxide surface of an infinitely
long cylinder.

Thismodel is similar to themodel above, but it more appropriate is for characterizing alkali metal
exchanged zeolites. The reported pore size range is from 3.5 to 300 angstroms.

MODELS BASED ON CLASSICAL THEORIES
Both surface energy distribution and pore size distributionmay be evaluated using classical
approaches tomodel kernel functions for use with equation (1) of the DFT Theory. Log in to your
customer portal to access the Calculations document. Be aware that the deconvolutionmethod only
provides a fittingmechanism; it does not overcome any inherent shortcomings in the underlying
theory.

SURFACE ENERGY
The use of classical theories to extract adsorptive potential distribution ismostly of historical interest.
At aminimum, the equationmust contain a parameter dependent on adsorption energy and another
dependent onmonolayer capacity or surface area. This is sufficient to permit the calculation of the
set of model isotherms that is used to create a librarymodel. The Langmuir equation has been used
in the past, as have the Hill-de Boer equation and the Fowler-Guggenheim equation. All of these
suffer from the fact that they only describemonolayer adsorption, whereas the datamay include
contributions frommultilayer formation.

PORE SIZE
It is well established that the pore space of amesoporous solid fills with condensed adsorbate at
pressures somewhat below the prevailing saturated vapor pressure of the adsorptive. When
combined with a correlating function that relates pore size with a critical condensation pressure, this
knowledge can be used to characterize themesopore size distribution of the adsorbent. The
correlating functionmost commonly used is the Kelvin equation. Refinementsmake allowance for
the reduction of the physical pore size by the thickness of the adsorbed film existing at the critical
condensation pressure. Still further refinements adjust the film thickness for the curvature of the pore
wall.

Models Based on Classical Theories
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The commonly used practical methods of extractingmesopore distribution from isotherm data using
Kelvin-based theories, such as the BJH method, were for themost part developed decades ago and
were designed for hand computation using relatively few experimental points. In general, these
methods visualize the incremental decomposition of an experimental isotherm, starting at the highest
relative pressure or pore size. At each step, the quantity of adsorptive involved is divided between
pore emptying and film thinning processes and exactly is accounted for. This computational
algorithm frequently leads to inconsistencies when carried to small mesopore sizes. If the thickness
curve used is too steep, it finally will predict a larger increment of adsorptive for a given pressure
increment than is actually observed; since a negative pore volume is non-physical, the algorithm
must stop. Conversely, if the thickness curve used underestimates film thinning, accumulated error
results in the calculation of an overly large volume of (possibly nonexistent) small pores.

The use of equation (1) represents an improvement over the traditional algorithm. Kernel functions
corresponding to various classical Kelvin-basedmethods have been calculated for differing
geometries and included in the list of models.

MODELS INCLUDED

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Halsey equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Halsey Thickness Curve

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K
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The calculation is the same as above except that cylindrical geometry is assumed.

Reference: G. Halsey, J. Chem. Phys 16, 931 (1948).

Kelvin Equation with Harkins and Jura Thickness Curve

N2 - Harkins and Jura Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Harkins and Jura equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

References: W. D. Harkins andG. Jura, J.A.C.S. 66, 1366 (1944).
J. H. DeBoer et al., J. Colloid and Interface Sci. 21, 405 (1966).

Kelvin Equation with Broekhoff-de Boer Thickness Curve

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Broekhoff-de Boer equation with standard parameters:

Models Based on Classical Theories

MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020 B - 15



B DFTModels

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887g cm-3

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is similar to the above except that cylindrical geometry is assumed, and the film
thickness depends on pore size (see reference).

References: Specifically, equations 20 and 21 in: J.C.P. Broekhoff and J.H. de Boer,
“The Surface Area in Intermediate Pores,” Proceedings of the International
Symposium on Surface Area Determination, D.H. Everett, R.H. Ottwill,
eds., U.K. (1969).

DFT MODEL REFERENCES
The papers listed below provide additional information on DFTmodels:

1. “Determination of Pore Size Distribution fromDensity Functional TheoreticModels of Adsorp-
tion and Condensation within Porous Solids,” J.P. Olivier andW.B. Conklin, Micromeritics
Instrument Corp; presented at the International Symposium on the Effects of Surface Hetero-
geneity in Adsorption and Catalysts on Solids, Kazimierz Dolny, Poland (July 1992).

2. “Classification of Adsorption Behavior: Simple Fluids in Pores of Slit-shapedGeometry,” Perla
B. Balbuena and Keith E. Gubbins, Fluid Phase Equilibria, 76, 21-35, Elsevier Science Pub-
lishers, B.V., Amsterdam (1992).

3. “Modeling Physical Adsorption on Porous and Nonporous solids Using Density Functional
Theory,” J.P. Olivier, Journal of PorousMaterials, 3, 9-17 (1995).

4. “The Determination of Surface Energetic Heterogeneity UsingModel IsothermsCalculated by
Density Functional Theory,” J.P. Olivier; presented at the Fifth International Conference on
the Fundamentals of Adsorption, Pacific Grove, CA (1995).
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C EXPORTED DATA EXAMPLE

C Exported Data Example
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D FREE-SPACE CORRECTION
Free space is that volume of the sample tube which is unoccupied by the sample. The quantity of gas
dosed into the sample tube is calculated from the difference in pressures in themanifold before and
after the dose is delivered. The quantity of gas adsorbed by the sample is calculated by subtracting
the quantity of gas remaining in the free space of the sample tube after equilibrium is established
from the quantity of gas originally dosed into the sample tube. Free spacemust be determined
accurately to obtain a precise value for quantity adsorbed.

Static-volumetric systems consist basically of a gasmanifold joined to a sample tube by an isolation
valve. Themanifold section has connections for an absolute pressure transducer, a temperature
gauge, and a vacuum system. It also has inlets for the adsorptive gas and helium. A Dewar flask
containing a cryogenic liquid (usually LN2 at approximately 77 K) is situated so that it can be raised to
immersemost of the sample tube. Two temperature zones exist within the sample tube when
immersed in the cryogenic bath: a warm zone (the volume above the liquid level and near ambient
temperature) and a cold zone (the volume below the liquid level at cryogenic temperature). Not only
must the total free space volume be determined, but it also is necessary to determine the quantity of
gas residing within the “cold” zone since a nonideality correctionmust be applied to only that quantity
of gas.

The total quantity of gas in the partly immersed sample holder cannot simply be determined using
n = PV/RT because temperature is not constant over the total volume, but instead is distributed as
two temperature zoneswith a steep temperature gradient between them. A convenient method for
resolving this problem is to derive two factors which, for the existing temperature profile, can be
multiplied by the prevailing pressure to reveal themolar volume of gas contained in the cold zone and
the total quantity residing in the free volume of the immersed sample holder (the analysis free
space).

The analyzer provides the followingmethods for free space determination:

n Measure
n Calculate
n Enter

MEASURE

Generally, thismethod, although requiring a little more time (approximately 10minutes), is themost
preferred one for determining free space. It is simple, automatic, requires very little information, and
essentially is error-proof. With thismethod, the instrument first evacuates themanifold and sample
tube (containing sample), then isolates the sample tube by closing the valve. Then themanifold is
charged with helium, the pressuremeasured, and the valve opened allowing the helium to expand
into the sample tube at ambient temperature. Again the pressure ismeasured.

D Free-Space Correction
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D Free-Space Correction

The Dewar is raised and the sample tube is cooled to cryogenic temperature. Again pressure drops;
when pressure has equilibrated, the value is recorded. Ambient and analysis free spaces are
calculated from (1) system volume, (2) system, ambient, and bath temperatures, and (3) measured
pressures. From these, the value of the portion of analysis free space at cryogenic temperature
which requires correction for nonideality can be determined.

Thismethodmay be undesirable if:

n Helium is unavailable; free space determination by the analyzer requires the use of helium.
n Analysis speed is amajor factor; a helium free spacemeasurement of 10 to 15minutes is

required.
n The sample tends to absorb and retain helium for a prolonged period of time or if it adsorbs

helium.

CALCULATE
Thismethod is themost rapid and efficient way of compensating for free space. Ensure the following
is accomplished:

n Perform a blank analysis on the sample tube.
n Load the blank analysis file data into the sample tube file.
n Enter the analysis bath temperature (found on the p° and Temperaturewindow).
n Enter the samplemass and density (found on theSample Description tab).

ENTER
Thismethod allows for entering predetermined values for the ambient and analysis free spaces. The
values to enter may be obtained in one of two ways:

n A pre-analysis free space calibration of the sample tube containing sample.
n The total free space of an empty sample tube ismeasured and the displacement of the sample cal-

culated from itsmass and density and subtracted from the total free space.

In either procedure, ensure that the level (or, in caseswhere the Isothermal Jacket is used, the
effective level) of the cryogen bath on the sample tube is the samewhen the analysis is performed as
it waswhen gathering data for free space calculations.
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E MAINTAIN HIGH PURITY GASES

The analysis systemwas designed to accuratelymeasure the surface area of all types of materials. It
is important that the gases (especially krypton) used for thesemeasurements be of highest purity,
especially when analyzing low surface area samples. Three ways to ensure high purity gases are to
alwaysmaintain:

n thoroughly purged gas pressure regulators
n non-permeable gas lines
n leak-free connections

Impure gas is strongly indicated, for example, if a series of measurements on a low surface area
material yields decreasing specific surface areaswith decreasing quantities of sample. The analyzer
uses very small amounts of helium; therefore any residual air in the regulator can distort results of
subsequent analyses for quite some time.

Micromeritics offers the following suggestions to assist in maintaining high purity gases (particularly
helium):

n Usemetal gas lines only
n Remove trapped air from the regulator and gas lines

USE METAL GAS LINES
Always usemetal gas lineswhich have been carefully cleaned of any oils and greases used in the
manufacturing process. Do not use plastic or rubber gas lines. When these types of permeable,
nonmetallic gas lines are used with helium, contaminants accumulate at amuch faster rate. This
causes errors in analysis results and can also contaminate a clean sample.

REMOVE TRAPPED AIR
When connecting the regulator to the gas cylinder, air is unavoidably trapped on the high and low
pressure sides of the regulator, as well as in the gas lines. Remove asmuch of this air as is possible
before opening the gas cylinder valve. If this air is allowed to remain in the regulator, it will mix with
the helium and cause inaccurate results in subsequent analyses. Or if the valve is open for any length
of time, the air trapped on the high pressure sidemay diffuse back into the gas cylinder and
contaminate its entire contents.

There are twomethods for removing trapped air from the regulator lines: the PurgeMethod and the
EvacuationMethod.

E Maintain High Purity Gases
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EMaintain High Purity Gases

PURGE METHOD

This is the preferredmethod for removing trapped air.

1. Go toUnit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go toUnit [n] > Show Instrument
Schematic.

If multiple instruments are installed, choose the correctUnitmenu.

2. Close all valves by right clicking each valve, then clickClose.

3. Open the regulator shut-off valve.
4. Open the gas cylinder valve briefly and allow the regulator to be charged with gas until the

high pressure gauge reads just over half the tank pressure, then quickly close the valve.

A. Gas tubing to instrument
B. Gas regulator shut-off valve
C. Low pressure gauge
D. High pressure gauge
E. Gas cylinder shut-off valve
F. Regulator connecter nut
G. Regulator control knob
H. Brass reducer fitting

5. Use the Pressure Control knob to set the output pressure (gas cylinder pressure gauge) to
15 psig.

6. Loosen the fitting at the instrument helium inlet until the low pressure side drops to approx-
imately 3 psig (0.02MPa), then tighten the fitting.
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7. Repeat steps 4, 5, and 6 three times.
8. Briefly open the gas cylinder valve, then use the Pressure Control knob to reset the regulator

output pressure to 15 psig.
9. After the pressure has stabilized (indicating there are no leaks), open the gas cylinder valve.

E Maintain High Purity Gases
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EMaintain High Purity Gases

EVACUATION METHOD

To use thismethod, the gas tankmust be within 10 feet of the instrument.

1. Do one of the following:

If... Then...
The regulator has not
been filled with gas and
the gas line is attached
to the instrument:

Close the gas cylinder valve.

Open the regulator shut-off valve.

The regulator is filled
with gas:

Close the gas cylinder valve.
Open the regulator shut-off valve.
Loosen the helium inlet fitting (or nut) on the instrument.
Allow all of the gas in the regulator to expel from the line (pressure
reading will be zero).
Retighten the helium inlet fitting (or nut).

2. Go toUnit > Enable manual control (if the instrument schematic is not displayed, go toUnit
> Show instrument schematic).

If multiple instruments are installed, ensure the correctUnitmenu is selected.

3. Close all valves, then open valves 6, 7, and 10.
4. Allow evacuation to continue for 20minutes. This pulls a vacuum on the helium line to the gas

cylinder. Themanifold pressure transducer should fall close to zero.

Allow evacuation for a full 20minutes. If evacuation time is too short, trapped air may
remain in the lines.

5. Close valves 6, 7, and 10.
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F SAMPLE DATA WORKSHEET FOR GAS ADSORPTION
Sample tube identification:

Sample Mass (g)
Before Degas After Degas After Analysis

1. Mass of empty sample tube set g

2. Mass of sample tube set plus sample g g g

3. Mass of sample (step 2minus step 1) g g g

Degas Information
Degas apparatus
Temperature (°C)
Time (hours)
Actual time started
Actual time finished

DegasNotes:

Copy and use this worksheet as needed



INDEX

A
about thismanual iv
adsorptive properties 4 - 2
advanced report options 8 - 1
Alpha-S method report 8 - 2
analysis

empty tube 6 - 20
perform 6 - 1
prepare for 6 - 3
referencematerial analysis 6 - 21

analysis conditions
defined 4 - 4
degas 4 - 4
parameter file 4 - 4

analyzer
components 1 - 1
configure 2 - 15
schematic 2 - 20
show status 2 - 22
software 2 - 1

B
BJH

plot options 8 - 10
report options 8 - 6
tabular report options 8 - 11

C
calibration 10 - 1

load from file 10 - 5
match transducers 10 - 2
sample servo valve 10 - 4
save to file 10 - 4

clean
dewar 11 - 14
filler rod 6 - 3
sample tubes 6 - 3

configuration
SmartPrep 5 - 1

Index

MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020 Index - 1



Index

unit 2 - 15
contact us iii
control chart report 7 - 7
convert files 2 - 22
corporate profile ii
cryogen requirements 1 - 6

D
dashboard

show 2 - 17
data, manually enter 3 - 7
degas

conditions 4 - 12
samples 6 - 7
Smart VacPrep 5 - 3
SmartPrep, start 5 - 3

degasser options 1 - 4
degassing

about 5 - 1
dewar

check 11 - 14
clean 11 - 14
fill and install 6 - 11
precautions 6 - 1, 6 - 1, 6 - 11

DFT
model references B - 16
models based on classical theories B - 13
models based on statistical thermodynamics B - 1
pore size report

options 8 - 12
regularization 8 - 13, 8 - 13

surface energy report options 8 - 14
DFTModels B - 1
diagnostics 9 - 1

clean and verify the gas line 11 - 8
leak test 11 - 11
show all readings 9 - 1
start test 9 - 1

Dollimore-Heal
plot options 8 - 18
report options 8 - 15
tabular report 8 - 19

Dubinin
pore volume report options 8 - 22
report options 8 - 20

Index - 2 MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020



tabular report options 8 - 23
transformed isotherm plot options 8 - 24

E
EFUP vii
elevator, lubricate drive assembly 11 - 15
empty tube

analysis 6 - 20
environmentally friendly use period vii
equipment options and upgrades 1 - 5
evaluate report results 7 - 12
export files 2 - 23
exported data example C - 1

F
f-Ratio method report 8 - 25
fields and buttons, common 2 - 3
files

convert 2 - 22
default locations 2 - 6
description 2 - 6
export 2 - 23
extensions 2 - 6
list 2 - 23
open a sample file 3 - 5
status 2 - 6

filler rod, clean 6 - 3
free-space correction D - 1
Freundlich report 8 - 27

G
gas

clean and verify the gas line 11 - 8
connect gas cylinder 11 - 6
delivery tubes 11 - 15
disconnect gas cylinder 11 - 5
guidelines for connecting 11 - 4
maintain high purity gases E - 1
metal gas lines E - 1
ports, specify 2 - 15
replacement cylinder 11 - 5

Index

MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020 Index - 3



Index

requirements 1 - 6
general safety v
graph

features and shortcuts 7 - 22
generate overlays 7 - 27

H
heat of adsorption report 7 - 2
Horvath-Kawazoe

plot options 8 - 32
report options 8 - 29
tabular report options 8 - 32

I
install

sample tube, physical adsorption 6 - 8
instrument exterior, clean 11 - 15
instrument, status 2 - 17
intended use vi
interactive reports 7 - 11
isotherm report option 8 - 33

K
krypton analysis, perform 6 - 13

L
leaks

perform test 11 - 11
libraries 2 - 12
list files 2 - 23
log

show instrument 2 - 19

M
maintain high purity gases E - 1
maintenance

clean and verify the gas line 11 - 8

Index - 4 MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020



clean instrument exterior 11 - 15
connect gas cylinder 11 - 6
disconnect gas cylinder 11 - 5
guidelines for connecting gases 11 - 4
replacement cylinder 11 - 5
vacuum pump 11 - 20

manual control
enable 11 - 10

manual, about this iv
match transducers, calibration 10 - 2
menu structure 2 - 2
methods, about 2 - 13
MicroActive reports 7 - 10
MP-Method

plot report options 8 - 39
report options 8 - 37
tabular report options 8 - 40

N
NLDFT advanced PSD report 8 - 41

O
option presentation 2 - 10
options report 8 - 44
overlays

generate 7 - 27
multiple graph 7 - 28
sample file 7 - 31

P
parameter files

adsorptive properties 4 - 2
analysis conditions 4 - 4
degas conditions 4 - 12
report options 4 - 15, 4 - 15
sample tube 4 - 17

plot options
BJH 8 - 10
Dollimore-Heal 8 - 18
Dubinin transformed isotherm 8 - 24
Horvath-Kawazoe 8 - 32

Index

MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020 Index - 5



Index

MP-Method 8 - 39
pore distribution data, import 7 - 34, 7 - 34
power 11 - 3
power analyzer on and off 11 - 16
power failure, recover from 11 - 19
pressure offset 10 - 3
preventivemaintenance 11 - 13
pump

oil-based vacuum pump 11 - 20
Pythonmodule A - 1

acquire basic information A - 9
acquire overlay sample data A - 13
acquire report results A - 11
advanced reports A - 1
get adsorptive data A - 22
get imported pore data A - 24
get report results A - 23
get sample information item A - 22
graphic report A - 18
MicModule Python calls A - 16

get overlay isotherm data A - 21
get primary isotherm data A - 20

overlay data A - 15
reports A - 6
scripts A - 4
summary report A - 17
tables A - 16

Q
QuickStart analysis 6 - 15

R
referencematerial analysis 6 - 21
references, DFTmodels B - 16
regression report 7 - 5
report

summary
physical adsorption 8 - 46

report examples
BET report 7 - 35
BET surface area plot 7 - 36
BJH adsorption, cumulative pore volume 7 - 37
BJH desorption cumulative pore volume 7 - 38

Index - 6 MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020



isotherm linear plot 7 - 39
isotherm log report 7 - 40
t-Plot 7 - 41

reports
about 7 - 1
advanced report options 8 - 1
advanced, Pythonmodule A - 1
Alpha-S method 8 - 2
BET surface area 8 - 4
BJH

adsorption/desorption 8 - 6
plot options 8 - 10
tabular report 8 - 11

Control Chart 7 - 7
DFT pore size 8 - 12
DFT surface energy 8 - 14
Dollimore-Heal

adsorption/desorption 8 - 15
plot options 8 - 18
tabular report 8 - 19

Dubinin 8 - 20
pore volume 8 - 22
tabular 8 - 23
transformed isotherm plot 8 - 24

evaluating report results 7 - 12
examples 7 - 35
f-Ratio method 8 - 25
features and shortcuts 7 - 18

graphs 7 - 22
reports 7 - 18

Freundlich 8 - 27
generate graph overlays 7 - 28
generate sample file overlays 7 - 31
heat of adsorption 7 - 2
Horvath-Kawazoe 8 - 29

plot options 8 - 32
tabular report options 8 - 32

interactive 7 - 11
isotherm 8 - 33
MicroActive 7 - 10
MP-Method 8 - 37

plot report options 8 - 39
tabular report options 8 - 40

NLDFT Advanced PSD 8 - 41
options 4 - 15, 4 - 15, 8 - 44
regression 7 - 5
sample audit trail 8 - 45

Index

MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020 Index - 7



Index

sample log 8 - 45
selected 8 - 1
SPC report options 7 - 4
start 7 - 1
t-Plot report options 8 - 48
Temkin 8 - 51
user-defined 8 - 1
validation report options 8 - 53

reports, Pythonmodule A - 6

S
sample

degas 6 - 7
mass, determine 6 - 5
transfer to analysis port 5 - 4

sample analysis
perform 6 - 17

sample audit trail report 8 - 45
sample data worksheet F - 1
sample file 3 - 2

about 3 - 1
create 6 - 5
open 3 - 5
overlays 7 - 31

sample log
report 8 - 45

sample servo
valve calibration 10 - 4

sample tube
clean and label 6 - 3
install, physical adsorption 6 - 8
parameter file 4 - 17
replaceO-ring 6 - 9
replace theO-ring 11 - 18

schematic
instrument 2 - 20

service test mode 11 - 20
shortcuts, application 2 - 8
show instrument log 2 - 19
show instrument schematic 2 - 20
SmartPrep 5 - 1

configuration 5 - 1
start degas 5 - 3
status 5 - 2, 5 - 2

Index - 8 MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020



software
about 2 - 1
for 21CFR11 2 - 25
updates 2 - 24

software uninstall 2 - 24, 2 - 29
SPC report 7 - 4
specifications 1 - 7
status

analyzer 2 - 22
instrument 2 - 17

summary report
physical adsorption 8 - 46

T
t-Plot

report options 8 - 48
tabular reports

BJH 8 - 11
Dollimore-Heal 8 - 19
Dubinin 8 - 23
Horvath-Kawazoe 8 - 32
MP-Method 8 - 40

Temkin report options 8 - 51
troubleshooting

andmaintenance
calibrate the system 11 - 1
elevator drive assembly, lubricate 11 - 15
leak test, perform 11 - 11
manual control, enable 11 - 10
power failure, recover from 11 - 19
preventivemaintenance 11 - 13
sample port frit 11 - 17
sample tubeO-ring 6 - 9, 11 - 18
service test mode 11 - 20

U
unit configuration, specify gas ports 2 - 15
unit selections 2 - 16
user-defined report options 8 - 1

Index

MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020 Index - 9



Index

V
vacuum pump

oil-based 11 - 20
validation, report options 8 - 53

W
warranty i
worksheet, sample data F - 1

Index - 10 MicroActive TriStar II PlusOperator Manual
303-42800-01 (Rev L )— Oct 2020




	Warranty
	Corporate Profile
	Contact Us
	About this Manual
	General Safety
	1 Analyzer Components for TriStar II Plus
	Degasser Options
	Equipment Options and Upgrades
	Gas Requirements
	Cryogen Requirements
	Specifications for the TriStar II Plus

	2 About the Software
	Menu Structure
	Common Fields and Buttons
	File Status, Description, Extension, and Location
	Keyboard Shortcuts
	Option Presentation
	Libraries
	Methods
	Configure the Analyzer
	Specify Gas Ports and Unit Configuration
	Unit Selections

	Instrument Status
	Show Dashboard
	Show Instrument Log
	Show Instrument Schematic
	Show Status

	Convert Files
	Export Files
	List Files
	Software Uninstall
	Software Updates
	Software in 21CFR11 Environments
	Option Presentation for 21CFR11 Environments
	Uninstall Software in 21CFR11 Environments


	3 Sample Files
	Create Sample Files
	Open a Sample File
	Manually Enter Data

	4 Parameter Files
	Adsorptive Properties
	Analysis Conditions
	Degas Conditions
	Report Options
	Sample Tube

	5 Degassing
	Degas on the SmartPrep
	Degas on the Smart VacPrep
	Transfer a Degassed Sample to an Analysis Port

	6 Perform an Analysis
	Dewar Precautions
	Prepare for Analysis
	Clean and Label Sample Tubes
	Create the Sample File
	Determine the Sample Mass
	Degas the Sample
	Sample Tube
	Fill and Install the Dewar

	Perform a Krypton Analysis
	Perform a QuickStart Analysis
	Perform a Sample Analysis
	Perform an Empty Tube Analysis
	Perform a Reference Material Analysis

	7 About Reports
	Start Reports
	Heat of Adsorption Report
	SPC Report
	Regression Report
	Control Chart Report
	MicroActive Reports
	Interactive Reports
	Evaluate Report Results
	Report Features and Shortcuts
	Graph Features and Shortcuts
	Graph and Sample Overlays
	Generate Pore Size Distribution Graph Overlays
	Overlay Multiple Sample Files
	Import ASCII Pore Distribution Data

	Report Examples
	BET Report
	BET Surface Area Plot
	BJH Adsorptive Cumulative Pore Volume
	BJH Desorption Cumulative Pore Volume
	Isotherm Linear Plot
	Isotherm Log Report
	t-Plot


	8 Selected Reports
	Advanced Report Options
	Alpha-S Method Report Options
	BET Surface Area Report Options
	BJH Adsorption/Desorption Report Options
	DFT Pore Size Report Options
	DFT Surface Energy Report Options
	Dollimore-Heal Adsorption/Desorption Report Options
	Dubinin Report Options
	f-Ratio Method Report Options
	Freundlich Report Options
	Horvath-Kawazoe Report Options
	Isotherm Report Options
	Langmuir Report Options
	MP-Method Report Options
	NLDFT Advanced PSD Report
	Options Report
	Sample Audit Trail Report
	Sample Log Report
	Summary Report
	t-Plot Report Options
	Temkin Report Options
	Validation Report Options

	9 Diagnostics
	Show All Readings
	Start Diagnostic Test

	10 Calibration
	Match Transducers
	Pressure Offset
	Servo Valve
	Save Calibration to File
	Load Calibration from File

	11 Troubleshooting and Maintenance
	Power
	Parts Replacement

	Guidelines for Connecting Gases
	Replace a Gas Cylinder
	Clean and Verify the Gas Line

	Enable Manual Control
	Perform a Leak Test
	Preventive Maintenance
	Check and Clean the Dewar
	Clean the Instrument
	Clean the Gas Delivery Tubes
	Lubricate the Elevator Drive Assembly
	Power Instrument On and Off
	Sample Port Frit Replacement
	Replace the Sample Tube O-ring

	Recover from a Power Failure
	Service Test Mode
	Oil-based Vacuum Pump

	A Advanced Reports - Python Module
	Advanced Report Options
	Scripts
	Python Reports
	Acquire Basic Information
	Acquire Report Results
	Acquire Overlay Sample Data for Gas Adsorption
	Enable the Use of Overlay Data
	MicModule Python Calls


	B DFT Models
	Models Based on Statistical Thermodynamics
	Models Based on Classical Theories
	DFT Model References

	C Exported Data Example
	D Free-Space Correction
	E Maintain High Purity Gases
	F Sample Data Worksheet for Gas Adsorption
	Index
	TriStar II Plus CE Declaration of Conformity

